Estimating Printing
with Morning Flight

. the Gold Edition






Estimating Printing with Morning Flight
... the Gold Edition

Morning Flight Gold is an innovative, easy to use estimating and order entry
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Morning Flight Gold

Welcome

Price of 1 1 B
141.00
e 700 68

141.00

170472018

Welcome to our print-it-yourself user guide for the Morning Flight V17.2 Gold Edition.
The guide is identical to the help system built into the program and focuses mainly on
the basics. For help with advanced topics, please consult our online help system at
www.morningflighthelp.com. The online site will always be more up-to-date and a
better place to come to when you're wondering what's new.

Morning Flight Gold is a print management system offering pushbutton simplicity and
lightning fast pricing without sacrificing flexibility. Inheriting the proven estimating
performance of the Silver Edition, the Gold adds Order Entry, Job Tickets, Job
Tracking, Invoicing, and a link to QuickBooks. All Morning Flight programs are
powered by the same pricing engine. Paid versions received a substantial power
boost in version 17.1 with the addition of wide format, multi-tiered click charges, and
support for RISO duplicators and Xante presses. V17.2, a free update from V17.1,
saw the addition of RISO inkjets.

Offset is built-in but can be toggled off. Like all Morning Flight editions, the Gold works
with inches and millimeters, USA and ISO paper sizes.

© 2018 Helmut Heindel
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.

Offset off

b M ame
T heres:

[ Enable Offzet
[v* ' alidate Data

How to verify that you have the latest version

Go to File > Update > My Wide Format Options, then click the Camera button. If you
see the "Double the price" check box, your program is up-to-date. You can also
perform this test from within a Wide Format quote or order.

. Setup Price S T
B || sooof 0o

“" per Order

When checked, the e sq.lt
option price will '

double for two-sided

products.

Vs prniad Soll sotes

[ Double the price __—T

How to get Answers

Help for all paid editions is by emalil, free of charge. In North America and most of
Europe you can also call us at 1-585-384-1023. We'll call back. If you're new to
Morning Flight, please look here first:

Getting Started
-,
Workspaces N

Morning*Flight:

© 2018 Helmut Heindel



12 Morning Flight Gold

2 Getting Started

2.1

System Requirements

CPU:

Memory:

Available Disk Space:
Operating System:

Installing Morning Flight Gold

Pentium Il or later

128 MB

60 MB

MS Windows XP, 2000, Vista, 7, 8, 10

How to download
Step 1

Morning Flight Shop

ﬂ' OFFSET AND DIGITAL  JUST DIGITAL FREE DOWNLOADS J SALE ITEMS PRINTFIRE SHOWROOM FAQ'S / UPGRADES / TERMS

THANKS FOR YOUR ORDER, ROGER!

Click HERE to Download the items you ordered
[Tl Facebook  []Twitter 3 Google+

1 just bought 'Free Pixelblitz Demo’ on Moming Flight Shop

For Digital anhy The Pixelblitz deme is identical to the paid Pixelblitz program but has a working limit of three customer records, It may be used fer an unlimited
E period of time. Data entered int...
SHARE THIS

© 2018 Helmut Heindel



Getting Started 13

Step 2

ﬁ' OFFSET AND DIGITAL JUST DIGITAL FREE DIOWNLOADS / SALE ITEMS PRINTFIRE SHOWROOM FACFS / UPGRADES / TERMS

Home » MyAccount > Order Status

MANAGE YOUR ACCOUNT MY ACCOUNT

View Messages (0)

View Order Status Order Status
Completed
The status of your recent orders is shown below, Click View Order’ to see complete details,

‘Your Address Book

Your Account Details Crder #1313 RECRDER | VIEW ORDER DETAILS

Your Recent items Order Dase: 11th May 2017

This order is marked as Completad
Your Order Contains:
o 1x Free Pixelitz LIE

A  OFFSET AND DIGITAL JUST DIGITAL FREE DOWNLOADS / SALE ITEMS PRINTHRE 5SHOWROOM FAQ'S f UPGRADES ¢ TERMS

Step 3

My Account » Completed 5 Order #131

MAGE YOUR ACCOUNT MY ACCOUNT

View Messages (0)

R Files for Free Pixelblitz Demo

Completed The files avallable for Free Pixelblitz Demo are listed below.

Your Address Book

Your Account Details

Your Recent ltems

Installing the Gold Edition

If you're currently using the Morning Flight FreeRide starter or a paid Morning Flight
program, you can preserve your quotes and shop data by installing the Gold Edition
into the same directory into which you've previously installed the FreeRide starter or
paid program (C:\Program Files\PrintFire\MorningFlight by default). However, before
you do that, please read the chapter on Updating and Upgrading.

If you elected to save rather than run the setup file, go to the directory into which you
saved the Gold Edition download. Look for an application called MFSetupG.exe.
Double-click it, then follow the instructions on the screen. An uninstall option is added
to the Control Panel, but no files are changed in your Windows System directory. All
Morning Flight programs use the same data files, so the transition will be seamless.
As always, be sure to back up your data files beforehand.

© 2018 Helmut Heindel
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Installing a Gold Demo

If you're currently using the Morning Flight FreeRide starter edition or a paid Morning
Flight program, we strongly advise against installing a demo into the same directory.
The default path for the demo is C:\Program Files\PrintFire\DemoV17. The default for
live programs is C:\Program Files\PrintFire\MorningFlight. Keeping the two
programs separate will allow you to evaluate the demo without endangering your live
setup.

If you elected to save rather than run the setup file, go to the directory into which you
saved the Gold Demo download. Look for an application called DFSetupG.exe.
Double-click it, then follow the instructions on the screen.

Launching the Program

Double-click the MFlight Gold shortcut on your computer's desktop. When Morning
Flight loads for the first time, it will take a few minutes to create the data files. Please
be patient. Subsequent program loads will take just seconds.

The Prelaunch Interview

The prelaunch interview defines your shop's profile. Here is where Morning Flight
collects the information it needs to configure itself to your company's capabilities. All
but one of the profile settings can easily be changed after the interview. It's just more
convenient to do it during prelaunch. The exception is your currency exchange rate.

hiaLr
o

Exchange Rate1: 1

If your shop is located outside of the United States, the setting you want to get right
during the interview is the rate of your currency exchange. It's the only prelaunch

© 2018 Helmut Heindel



Getting Started 15

setting that can't be reset in a few simple steps. To revert back to U.S. Dollar prices
you'll need to later adjust all paper prices and hourly rates.

Uninstalling

Use the "Add Or Remove Program™" utility in the Control Panel of MS Windows to
uninstall the program.

%\ kot

All Morning Flight editions use a common set of data files. Consequently,
uninstalling one of the editions will remove only the program itself from the
installation directory, not the generated data files. This also serves to protect
your data in case of an accidental uninstall. To remove all traces of Morning
Flight from your computer, delete the sub-directory "PrintFire\Morning Flight"
from your "Program Files" directory after you've uninstalled each edition.

Caution: Deletion of the sub-directory is irreversible once the Windows
Recycle Bin has been emptied.

2.2 Updating and Upgrading

In the fall of 2016 when we had the new Skypricer pretty much in the can - with five
click charges instead of one - we felt we had to offer tiered click charges in all other
paid editions as well. That single price point was no longer tenable. How long could it
take to code the update? Not long, maybe a month. So we announced it. The
response, predictably, was "Outstanding! So will it include wide format?" Well, why
not. | mean, we had the pricing engine apart anyway, and industry surveys told us that
half of all small print shops now offered wide format.

This is where the train went off the track. First and foremost, we should have kept
quiet about wide format and released V17.1 as soon as those versions had the tiered
click charges. Second, it would have been quicker to develop wide format as a
separate entity instead of trying to shoehorn it into the existing data structures. Less
stress, and definitely more revenue than the $50 to which we now limit all inline

© 2018 Helmut Heindel



Morning Flight Gold

updates. We even debated about that, seeing we've never charged for updates in our
13-year history.

In the end, it wasn't much of a debate. The new Morning Flight had taken a year and a
half to produce and had grown to nearly twice its original size and usefulness. | knew
none of that would amount to a hill of beans in the debate about whether to update.
Nor, in all honesty, should it. The real question is value. Is the update worth $507? | ask
myself that every time | order a $49.95 computer book from Amazon. Was it worth
burning the midnight oil to integrate wide format into the existing data structures?
Totally. It keeps everything together and is so much simpler.

Updating to Version 17.2

If you have already updated to Version 17.1 and now want to update to 17.2 (you
should, it's free and you get two more digital presses, among other things):

e Back up your Morning Flight data files (files with the extension TPS). The
location of those files will depend on your operating system and whether you
have disabled Windows UAC Virtualization.

e Install the update into your active Morning Flight directory (C:\Program
Files\PrintFire\MorningFlight by default).

If you're updating from any Morning Flight version older than V17.1 and have not yet
updated to V17.1, install the VV17.2 update as you would V17.1. In other words, follow
the steps below:

Updating to Version 17.1

Version 17.1 is more than an update, it's a new program. Some of the screens still
look and work the same, but there are countless new ones to support the added
capabilities now found in all paid editions. To name just a few: Wide format, five-tier
click charges, support for RISO and Xante presses, and market pricing. Except for
the tiered click charges (without which there would be no market pricing), updates are
still managed hands-off by the setup file. However, reverse-engineering five click
rates from just one is too much to ask of the robots. Getting it wrong could decimate
your sales if the new pricing is too high, or wipe out your profits if it's too low.

© 2018 Helmut Heindel



Getting Started 17

Converting that single click rate to five has been a huge challenge from day one. New
users are easy because there's nothing to convert. We're entering virgin territory.
Existing installations are more like a vegetable garden. Here we could easily be
trampling all over somebody's carefully cultivated pricing structure. This one kept me
up at night. 1 knew we couldn't make drastic changes regardless of the cautionary
"But First" link in the Read Me file. Nobody ever reads those things anyway until the
carnage is well underway.

Late in 2017 we found the solution, a fairly elegant one at that. New installations would
continue to emerge with market prices. But updates would extract the press factors
from the earlier version and import those values into the update. Nothing new about
that, it's common practice. What's unusual is that the single click rate from the earlier
version is being loaded into all five V17.1 tiers, keeping the update essentially a one-
tier program. That hardly looks like progress, more like a step back. And it would be if
we hadn't added our 'Aha’ ingredient - the ability to go online and look up the press
factors at www.printfire.com/priceguide.html that will give you market pricing.

You now have a choice: Stay with Cost-Plus; forget about market pricing altogether
and keep Morning Flight a one-tier program. That's likely to still hurt your sales (orders
you're already not getting because some of your quotes are overpriced), and lower
your profits (orders you are getting but at too low a price which most customers are
savvy enough to not be telling you).

Or, move ahead slow and measured, one step at a time. Where you feel comfortable,
gradually inch your press rates to what we publish on our website. That's the path |
would take if | still owned the Unitac print shop. One of the unseen benefits of version
17.1is the built-in market price guide for digital and wide format. We've spent a lot of
time and money to bring you that, and it would be a shame to not take advantage of it.

The Fast Track

e Take a picture or a screen capture, or write on a slip of paper your digital press
rates in the old version, the one you're using now. Hourly rates (front and back)
and click charges (1C and 4C) are the values you want to preserve. If you added
presses, save the rates for those presses, too.

e Take a picture or a screen capture, or write on a slip of paper your paper
markups as displayed in My Store.

© 2018 Helmut Heindel
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e Make sure you have printouts of estimates and job tickets for your most

common digital work, priced with the old version.

e Back up your Morning Flight data files (files with the extension TPS). The

location of those files will depend on your operating system and whether you
have disabled Windows UAC Virtualization.

e Install the V17.1 update into the folder from which you're running the old version

(C:\Program Files\PrintFire\MorningFlight by default). When the new version has
loaded, go to My Shop and double-click the 4C digital press. If all has gone well,
you should see something similar to the screen below. | say should because
with MS Windows and UAC and compatibility files you're never sure. Doesn't
matter. If the update does somehow install the new market price defaults but
you want your old single click charge back, enter it manually into all five tiers,
using the values you wrote down on that slip of paper.

I ame

inimum Sh

F ainuim S

Hourly R

Makeready

Speed

Price of 100

11 x 17, Color 1 Side

Eur argir —

RCTV N Calor
Click Charges
1 - 499
500 - 999
1.000 - 4,999
5000 - 9,999
10,000 »

75.00 M:Et=d iR E

150.00 gyl

1 - 4599
500 - 939
1.000 - 2.499
2500 - 4,333

5.000

(5]
=

Gl 5 Minutes
WE [y

NI IPH - Momal

L o
[4;]
=1

& ZzZ0O
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The Slow Road

e Save the setup.exe you downloaded from the Morning Flight Shop. We don't
limit how often you can install updates.

e For a week or two, install the new version into a folder that's different from the
folder holding your old version. You could even install it on a flash drive.

e Keep generating your estimates and orders on the old version, but at the same
time experiment with the pricing of V17.1 (hourly rates, click charges and paper
markups) until you have a set of numbers you can live with.

e When you're done experimenting, save those numbers on a slip of paper.

e Back up the data files of your old version, then install the V17.1 update into the
old version folder.

e Manually update the digital presses and paper markups of the just updated
program, using the numbers you saved on the slip of paper.
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20 Morning Flight Gold

Hourly Rate and Tiered Click Charge Defaults
January 2018

Price of 100
11 x 17, Color 1 Side

68.90

Fur Margin — i) 4—} u n

Marne Herox B

Click Charges

Finimurm 3 ] | Black 1 - 499
BO0 - 999
1.000 - 4,999
et 5,000 - 9,999
B 10,000 >

Back we pay

0.0600
0.0500
0.0400
0.0300
0.0200

- 439
500 - 993
1.000 - 2,499
2,500 - 4,999
5,000 =

] 10 Minutes
WiE Ey

Speed IPH - Marmal

_ 3
[}

0.4000
0.3400
0.2800
0.2200
0.1700
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Paper Markup Defaults
January 2018

See also  Backing up your Data

+ You did write down your old hourly press rates and click

charges, didn't you? Not to worry. You can reconstruct those
values from an old quote or time sheet. In the example below,
the hourly rate for digital black was $90.00 ($15.04 x 60

Lezs than 1 Carton

Full Cartan

3 Cartonz or more

[+ Use CommonSense Pricing

ik Z:0

Before you dive in

divided by 10 minutes), and the click charge was three cents

($30.96 divided by 1,000).

21
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22 Morning Flight Gold

in quote
view

| Product Digital, D1/0, B-1/2 x 11
e Digital Bladk on front
T-up on 8-1/2x 11
1,000 2,00t
Runtime (1-Color Xenox) 10 Minutes : B0 A
€,000 IPH on time B0
Impasition/RIP ShEEt
Makeready 3 Minutes 4.850 .
Run 15.04 20.0¢
Consumables 30%

Cligk Charges 30 .9 81.8€
Variable Data

2.3 Backing up your Data

Personal computers have become so reliable that it's easy to get complacent about
backing up your files. In reality, catastrophic data loss, either because your hard drive
crashed or you accidentally deleted something you hadn't intended to, is never a
guestion of if but when. And when it does happen, and it will, reconstructing the
information is

¢ child's play if you remembered to back it up,
¢ a mind-numbing chore even if you do have it on paper,
¢ a nightmare if it vanished into thin air.

With flash drives now selling for the price of three Big Macs and a bucket of KFC
chicken, please back up your Morning Flight data files. Religiously. We may be able to
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Getting Started 23

help with a corrupted file. Nobody can help you if your file is en route to another
galaxy.

How to back up

Let's start with how not to. Backing up to a drive on the same computer is like trying to
protect your good china from earthquakes by moving the cabinet into the next room.
Backing up to an external drive is a step in the right direction but also not far enough.
Your irreplaceable data is still in the same house, at risk from fires, floods,
meteorites.

A better solution is to keep one flash drive off-site, and another plugged into the
computer. Keep it one-button easy, or else you're not going to back up often enough.
Now and then, archive everything to DVD. When disaster strikes, even a month-old
backup is better than no backup at all.

What to back up under XP

Theoretically, the only thing you need to back up are your Morning Flight data files.
You can always reinstall the program by downloading a new setup file. But because
the application itself has such a small footprint (less than 16MB), the quickest and
safest way is to simply back up the entire "MorningFlight" folder.

File Edit “iew Favorites Tools Help

O Back - (g 'Tr 7 ) Search Falders Elv

fddress {2 C\Pragram FilesPrintfire

P

File and Folder Tasks 2 I|I MarningFlight

What to back up under Windows 7, 8, 10, and Vista

If you installed Morning Flight outside the "Program Files" folder or have disabled
Windows UAC Virtualization, the procedure is the same as the one for XP. However,
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if you installed Morning Flight into the recommended path inside the Program Files
folder (C:\Program Files\Printfire\MorningFlight by default) and you're running it with
UAC enabled, backing up the Morning Flight folder would be pointless. That's because
the files that need backing up aren't there. The operating system has taken it upon
itself to relocate them all to the Compatibility Files folder.

Some Background

There is a fair amount of confusion over UAC, which has gained notoriety for
annoying the user with constant permission prompts. That's something we'll learn to
live with. Security usually comes with a price tag. Look no further than the long check-
in lines at airports.

More insidious is a new UAC feature called Virtualization. The idea is to
accommodate applications that write to files in protected directories. "C:/Program
Files" is such a directory. This is so common that Microsoft felt it necessary to devise
a mechanism that redirects the write operation to a user-specific location. The
application thinks it's writing to the main Program Files directory, but in reality a file
gets written to a second Program Files directory in each user's Virtual Store.

Windows 7

So far, so good. In Windows 7, the Morning Flight data files become readily visible
when you open the Morning Flight folder, then single-click 'Compatibility files'.

@U?| » Computer » O5(C:) » Program Files » Printfire » MoringFlight

Organize = Include in library - Share with = Burn Compatibility files

¢ Favorites Single-click Bk
o L Marre . Date modified
B Pictures =) ACTFile. TPS 0/27/2009 6:53 AR
st =] B File. TPS 8/26/2009 5:47 PM
ilai =) COMFile, TPS 0/27/2009 £:53 AM
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Windows 8 and 10

Comes now Windows 8 and 10, where the Compatibility files link has apparently gone
the way of the Start button. The folder is still there, but Microsoft thought it best to hide
it from us. We're happy they didn't move it. The virtual store is in the same place in
Windows 8 and 10 as it is in Windows 7.

%\ Fote:

If UAC (User Access Control) is turned off, the data files will be in the same
folder as the Morning Flight .exe file (MFlightP.exe for the Passport Edition,
MFlightG.exe for the Gold, etc.)

To locate the Morning Flight data files in Windows 8 and 10, navigate to the
Compatibility Files folder as follows:

32 bits: C:\Users\User\AppData\Local\VirtualStore\Program
Files\Printfire\MorningFlight

64 bits: C:\Users\User\AppData\Local\VirtualStore\Program Files (x86)
\Printfire\MorningFlight

If you're unsure about how to get there, download 'Search Everything,' a free and
indispensable utility from Voidtools. Ask it to find "ACTFile. TPS" for you. The first time
you use the program, it will take a minute or two to index. Subsequent searches will
be much quicker.

File Edit Search Tools Help

ACTFile TPS
Name Path Size | Date Modified
ACTFiIe.TPS ChUsers\Hal\AppData\Lecal\VirtualStore\Program Files\Printfire\MorningFlight 2KB 12/29/2017 9:27 PM
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Open

Open Path

Explore Path

Copy Full Mame to Clipboard
Copy Path to Clipboard

7-Zip 3

MorningFlight
Double-click

' See more results

|C:EUsers‘uHalmppData\LanaIWirtual % | [ Shut down | » |

¢ Right-click ACTFile.TPS in Search Everything, then select 'Copy Path to
Clipboard'

¢ Paste the path into the Windows search box and press Enter
e The search results will show as 'MorningFlight' (the Compatibility Files folder)

e Double-click it to open the folder

Backing up - Step by Step

First, open the "Compatibility Files" folder and select all the files in that folder. Those
are the data files that need to be backed up at the end of each day. The files in the
Morning Flight folder are static program files that don't really need backing up, but you
may want to do so at least once. In an emergency, they can always be reinstalled
from the setup file.

ﬁ Fote:
To copy all the compatibility files to the Windows Clipboard, hold down the Shift

key and click on ACTFile.TPS. Then, without letting go of the Shift key, scroll
down and click on the last file in the folder. All the files should now be highlighted.
Release the Shift key and press Citrl-C.
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Address |5 GA\MF_Backup_1

»

o & W ¢ W

9 Make a rew Folder Maonday Tuesday Wednesday Thursday Friday

File and Folder Tasks

On both backup drives (the one you keep at home, and the one with your computer),
create a separate folder for each workday. Before you shut down, copy the entire
"MorningFlight" folder (for XP) or all the files in the "Compatibility Files" folder (for
Windows 7, 8, 10 and Vista, if Morning Flight is installed in the Program Files path)
into the folder of the day. Overwrite what's there from the previous week. The older a
backup gets, the less useful it is.

At the end of the week, swap drives. On Friday evening, take the office drive home.
On Monday morning, bring the home drive back to the office. Worst case scenario?
Your surviving backup could be five days old. Even if your house burned down over
the weekend and both drives went up in flames along with it, chances are, your
original files would still be intact on your desktop at the office.

2.4 Running on a Network

While we don't officially support Morning Flight for use on a network, we're finding that
most installations are run that way - either on a LAN or Microsoft Windows Server.
The program has proven very robust in a networking environment. We've had no
reports of broken files or problems with data integrity.

There are some caveats: No record locking or user accounts. Everyone will be
logged in as the administrator. As the number of users grows beyond a few, the lack
of record locking may become an issue. Without record locking, two or more users
could have a customer record open at the same time, and all could make changes.
Whoever updates the customer last gets the final change, overwriting any changes
made by the others.

The main caveat will be speed. Lack of network performance is likely to become an
issue when you have more than three or four clients. So before you buy, please
download a free demo. If the demo works for you, any paid version will too.
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Setting Morning Flight up in a networking environment is a simple process. All that
needs to be done are the following steps:

1. Install Morning Flight on a server or on a peer PC. It will default to C:\Program
Files\PrintFire\MorningFlight. Make sure the program runs properly on that
server.

2. Share the directory (folder) that Morning Flight is installed in.

3. Create a shortcut, on the client PC's desktop, to the executable. For instance, if
you install the Silver Edition on Server-7 the shortcut would look like:
"\Server-7\c$\Program Files\Printfire\MorningFlight\MFlightS.exe" (include the
guotes)

It would be preferable (but not necessary) to set up My World, My Shop, etc. on the
server before running Morning Flight on the clients. Also, run Morning Flight on each
client at least once to ensure that the administrator is not automatically logged in.

An alternate method is to share the MorningFlight folder and map a drive letter to it.
For instance, if you map C:\Program Files\PrintFire\MorningFlight to G, the shortcut
would be G:\MFPixel.exe for the Pixelblitz Edition, G:\MFlightG.exe for the Gold, G:
\MFlightS.exe for the Silver, and so on.

Morning Flight on a Flash Drive

Want to use Morning Flight on multiple computers and keep your data private at the
same time? Install the program on a flash drive and take it with you wherever you go.
Make sure the drive is large enough to hold several years worth of data files. Flash
drives have come way down in price, so start with at least eight gigabytes.
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The reason flash drives work is because all Morning Flight programs are entirely self-
contained. No dynamic link libraries (aka .dll Hell), no registry entries, no external
black boxes of any kind. Even the data files generated by the program encapsulate all
their dependent key and index files in a single .TPS file.

How to Install on a Flash Drive

Destination Folder

Click Mest toinztall to thiz folder, ar click Change to install into a different folder.

Pleaze enter the location where you would like to install the program. vou may bwpe a new
folder name or click the Chanage buttan ta find a new locatian.

Install Morning Flight Free Edition to:

G:\MorningFlight

e Install Morning Flight directly to a USB flash drive (not your C:\ drive).
¢ After the installation, create a shortcut to the application on your desktop.
e Remove the flash drive and plug it into the second computer.

e Create a shortcut on that computer's desktop as well.

Address || G:\MarningFlight

Marne Size  Type

File and Folder Tasks # F 12,567 KB Application
] Open 4 i,
Lrinsk 156 KB Application

Iim Renarne this file R | 25 _
i o % MFHel . as 1,989 KB Compiled HTML Help. .,
[gg Mave this file .MFIigI’ ®% Select Left Sideto Compare | vB  Ioon
D Copy Ehis File lﬂ_]MFLil:E ™ Select Left File for Compare 34 KE  Rich Text Formak
&8 Publish this file o the Yeb W Fre, @ Morton Internet Security  * | 37KB  Rich Text Format
(3] E-mail this file E’l Uninst |w Expression Media Irnport . 7KB  Text Document
% Delete this file || ACTF s d [ adobe Audition 3.0

=) conF
@ CTLFl ik [#] Compressed {zipped) Folder
=) cTvRl Copy p

#|cUpF  Paste
&) CLSFi

kel

Other Places

Mail Recipient
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2.5

Prelaunch Questions

Welcomel

Spain
Sweden
Switzerland

The Philippines
Turkey

Yenezuela
=i Other

During the prelaunch interview, you answered a series of questions that defined your
shop's profile. Here is what you were asked, and how you can now change your
answers:

What is your Country?

¢ Click the My World button (or click File > My World).

¢ Click the My Country button and select your country from the pick list. If your
country is missing from the list, click the Add button to define it.

What is your Exchange Rate?

This applies exclusively to international users of Morning Flight. It's the only prelaunch
setting that cannot be reset in a few simple steps.

Let's assume your country uses Euros, and the exchange rate when you installed
Morning Flight was 0.80 to 1.00 (0.80 Euros = 1.00 U.S. Dollar). To revert back to
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U.S. Dollar prices you'll need to multiply every price and hourly rate you find in My
Shop, and every paper price in My Store, by 1.25. Why 1.25? It's what you get when
you divide one Dollar by your local currency, in this case 1:00 divided by 0.80.

Do you have an ...

Imagesetter
Camera

¢ Click the My Shop button (or click File > My Shop).
¢ Click the Prepress button.

¢ Click the Film tab, then check Imagesetter if you have one, uncheck it if you
don't.

e Do the same for Camera.

Do you have a ...

2-Color Press
4-Color Press
Digital Press
B&W Copier
Color Copier

¢ Click the My Shop button (or click File > My Shop).

e Check or uncheck presses and copiers, as appropriate.

%\ P ote:

The One-Color offset press can't be unchecked. Morning Flight assumes that
virtually every offset shop either has such a press, or at least offers one-color
printing. "Digital Only" shops will happily ignore offset altogether.

When you uncheck the four-color offset press, you'll still be able to quote four-
color. Unchecking the press merely takes it off-line and assigns all four-color
runs to the two-color press, twice through. Unchecking a digital press or a
copier, on the other hand, will prevent you from quoting the type of work
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associated with it. For one thing, you can't produce color copies on a black
copier. And while there is often a good reason to run a one-color offset job on a
two-color press (one-color press too small, too much ink coverage), making
black copies on a color copier is almost always cost-prohibitive.

Describe your Offset Presses

¢ Click the My Shop button (or click File > My Shop).

¢ Click the Presses button and select the press you want to work on from the pick
list.

e Set the minimum and maximum sheet sizes.

e Check or uncheck the types of plates available for this press.

Who will administer Morning Flight?

¢ Click the My World button (or click File > My World).
¢ Click the My Preferences button.

¢ Click the My Name button and enter the name and initials of the Program
Administrator.

2.6 Log-in and User Accounts

At your discretion, Morning Flight can be password protected to keep a disgruntled
employee from altering your prices or sabotaging the system. Whoever installs the
program and enters his or her name during prelaunch will automatically become the
administrator.

The second time you load the program, you will be asked to sign in with your initials.
Since you haven't assigned yourself a password yet, leave the password field blank
and click OK to enter the program. Password use is optional.
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emember my Pazswaord

v
v

B
Keep me zsigned in

Z3

During subsequent sessions, the sign-in window will open with the two check boxes
grayed out. If your username is showing and you had the two boxes checked during
the previous session, just click OK. Otherwise, enter your username and tab to the

password field to enable both boxes.

Changing your User Account and Password

Not much to explain here. Standard computer fare, the kind of stuff we all do just to
manage our e-mail. In Morning Flight, password use is optional. If you're the only one
using the program and you're not concerned about security, you may want to keep
yourself signed in.

File BEEEN Cuoke Price  Wrike Estimate  Wiew  Prink  Win

Set User Accounts

- | XX
hange My Account b Pl
Change My Password e

Sign out HH

T Y ik ek L.H‘N‘V" il
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Setting up User Accounts

Uoer Uecovunds

| ritialz M ame Job Title Aooezs
i HH Herb Hendrick, President 1
ki FK.athleen ‘\Winfield Office Manager 2

L
_'I
E m

Not surprisingly, only the administrator is allowed to set up user accounts and grant
access rights. In the user profile below, Kathleen has access to all areas except My
Shop. She can quote prices, enter orders, and issue invoices. What she cannot do is
change hourly press rates. Those are the sole domain of someone with Access-1
credentials. In this case, Herb, the president.

Initialz

Job Title

Operator

K.athleen wWinfield

Fhf

Qffice Manager

[v by wfarld
[ My Shop d
[v by Stare v [revoices
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2.7 Your First Offset Quote

Time to jump in and get your feet wet. This topic describes how to quote a basic
stationery package, printed by offset in two colors, using out-of-the-box Morning Flight

prices.

Print Quote Window

ACME Automotive

Product Letterheads
8142011 E2)le]
Paper 24 b Classic Laid
8142 1 11, Avon Brilliart \White AN
Frinting
Ink, Calars
Prepress
Past
asipress
Kewword [
B
FrEE Z:0
Browse Customers [ |
(in black panel on top) -

Paste Ink Colors
(bottom row)

Import Quote for editing
(bottom row)

Set Quantities
(bottom row)

Making the Letterhead Quote

91.20

37.70

30.00

le

158.90 202.80 374.80

F11

E F9
il F10
S F12
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From the main menu, click the Quote button, then click the F2 button or
press F2.

e Double-click Letterheads.

Back in the print quote window, click the F3 button.

Place the highlight bar over 24 Ib. Classic Laid, Avon Brilliant White, then
click OK.

Back in the print quote window, click the F4 button.

Select Black plus Color, then click OK.

In the window that opens, enter PMS "109", then click OK.

LY
o 4
BN Back in the print quote window, click the Quantities button or press F12.

e Enter 500, 1,000, and 3,000, then click OK.

%\ bk

No refresh button! All prices are instantly updated as you enter new data or
make changes.

Saving the Quote

When you make a quote, Morning Flight doesn't ask who the customer is because all
you may want is a price. But to save a quote, you'll need a tag of some sort to help
you retrieve it. The customer's name will do, for now.

¢ While the print quote window is still open, click the Rolodex button in the black
panel on top.

¢ Provided you haven't entered any customers yet, the window that opens will
come up empty. Click the Add button, second from the left.
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| Contact

C aurkry m

LS54,

ACME Automotive

Campany ACME Automotive
Address

City

State/Zip Code

. i First click the Text button to allow upper case entry, then enter "ACME
Automotive" in the Company field and click OK.

¢ Click OK in the print quote window to save the quote.

%\ bt

To keep "John Smith" from being entered as "john smith" one day and as
"JOHN SMITH" the next, Morning Flight converts all customer names and
addresses to initial caps. If text formatting is ON, you can turn it off by clicking
the text button before you enter a name or address.

See also: Formatting Text

Making the Envelope Quote

Assuming that the ink colors for the envelope are the same as the colors we've used
for the letterhead, it's quicker and safer to copy them from the previous job than to re-
enter them from scratch.
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Prepresz

Postpress

e ]er]
K.epword [ @

FEE ZE0

i Y W

E While the print quote window is still open, click the Paste Ink Colors button
on the bottom row. Note how the run configuration changes from "Black ink on
front" to "Black + 1 Color on front."

e Swipe the cursor over the gray Ink Colors panel. When the cursor turns into a
camera, left-click to verify that the color we'll be using is PMS 109. Close the
window.

Still in the print quote window, click the F2 button.

First click Envelopes in the black panel on the right, then double-click
Envelopes, Size 10 in the browse box on the left.

Back in the print quote window, click the F3 button.

Double-click 24 Ib. Classic Laid, Avon Brilliant White.

Click OK to save the quote, then close the print quote window.

Congratulations! Let's view the Results.

Morning Flight - Passport Edition
File Quote Price BUEEN Print  Windsw  Help

BEl~—8 AYE O

e Bl ek o et o e e g

Cuskomers
Conkacks

Yendors

© 2018 Helmut Heindel



Getting Started 39

I} Cuztarmer Product Letterheads
N
1006-00005 | ACME Automative Envelope
EO006-00003 | ACME Automotive Sheet

K.emmord

NE [

e From the main menu, select View > Quotes.
¢ Place the highlight bar over ACME Automotive, Sheet.

e Swipe the cursor over the black panel on the right. When the cursor turns into a
Clock, left-click. See how much paper is needed for the job, and how long it
should take to print it. Close the print preview window.

opens, swipe the cursor over the white Product panel on the left. When the cursor

Back in the view quotes window, click the Camera button. In the window that

icon turns into a camera, left-click. Note the ease with which Morning Flight lets
you drill down for an itemized list of run prices. Getting a detailed view of Paper
costs is just as simple.

ACHME Automotive

Letterheads o
81/2 211 ol

24 |b Classzic Laid
3-1/2 11, Avan Briliant W hite
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Finally, click the Print button for a Print Preview of the price sheet.

Price Sheet

Sy .

oy
%
100G-00003 g
Customer ACME Automotive '.‘_
i
4
500 1,000 2,000 !
Product Letterheads ?
2142 2 11 1
Bladck+ 1 Colar on front X
24 |b Classic Laid
Foron Brilliant White 122.90 172.80 24480 j
Ink FMS 109 Chrome “rellow 30.00 20.00 30.00 }
TOTAL PRICE $158.90 $202.20 $374.20 2
".
-

,E
L

S B b e e
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3 Preflight

3.1 Workspaces

This topic shows you how the program is structured. Grouped into three distinct
workspaces, the Morning Flight desktop will be familiar to anyone who has ever
worked in a print shop.

Morning Flight Gold

File Log-in  Quake Price  ‘Write Estimate  Enter Order  Inwvoice  Yiew Print  Window  Help

L2l E@a37 EET O

| Caontral | | Estimating | | Crderdesk |

e The Control workspace is where you do your preflight. Here you enter costs
and set parameters that will frame the quote and determine pricing.

e The Estimating workspace, no surprise there, is where you create quotes and
manage estimates.

e The Orderdesk workspace is where you enter and track orders. Here you can
also access the Flight Engineer, a plug-in that provides inventory control and
some useful utilities.

The Control Workspace
¥
= In My World you'll find a number of settings that you have already entered

during prelaunch. Not asked during prelaunch was the name of your company, along
with your personal preferences and the quantities you quote on most often.

.glf In My Shop you enter your shop's profile and equipment data. It's also the
place where you optimize run prices for your local market.
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- In My Store you keep track of your customers and maintain your products and
paper. While the costs and hourly rates you set in My Shop generally control your run
prices, costs and markups set in My Store will determine how much you charge for

paper.

The Estimating Workspace

The New Print Quote button, the button you're likely to use more than any
other.

L |
ﬂ}/ The My Way Quote button, for creating print quotes under manual control.
.
The Booklet Quote button, used only for quoting booklets.

l@
( The Estimate Writer button for consolidating quotes into written estimates.

The Orderdesk Workspace

E The New Order button, for entering new print orders.

E The Order Tracker button, for keeping track of orders already in the system.

&

-1 The Flight Engineer button. With the Engineer you can manage the inventory
of paper you keep on hand. You'll also find stand-alone versions of three pricing
engine components that can help you with special projects, quotes you just have to
massage by hand and work out on paper. What makes these tools unique is that
each can be converted from U.S.A. to ISO paper sizes and from inches to
millimeters, independent of the settings you're using for the main program.
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Cut Grain Mixed
G-out, 11 .

" e j
i Grain Long
fi G

154 inches
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3.2 My World

Enabling Morning Flight to work abroad was never an afterthought - never a maybe,
someday kind of thing. Global usefulness was embedded into its framework from the
beginning. And it shows. It's why all Morning Flight products speak more than one
language, and why even the Free Edition comes with a do-it-yourself translator.

But being able to understand and make yourself understood is only the most basic
requirement. The program could be fluent in French and still be useless in France if it
didn't know millimeters and ISO sizes and how to count Euros.

My World is that rarely visited cubicle in Morning Flight where you set the stage and
define your environment.
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Address Format

Tri-State Litha |he. ' Fabert Smith

ABC Publizhing Co.
B0 State Street
Suite 28

Chicago. IL BOED2

Patricia Quinn

PRI

My Country

¢ To change your country, click the My Country button, then select from the list of
available countries.

e If your country isn't listed, see International > Adding a Country on how to add
your country.
My Company
e To enter your company's name, address, and contact information, press the My
Company button.
My Preferences

e To change how you want the program to interact with you, press the My
Preferences button and set your personal options.
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e To configure the program to work in either offset+digital mode or digital mode
only, click Enable Offset.

¢ To enter your name, title, and how your customers can get in touch with you,
press the My Name button.

¢ My Quantities are the three quantities that will come up by default when you
open the print quote window. Enter as the lowest quantity the quantity you find
yourself quoting most often.

%\ kot

If your customers usually ask for a single quantity, keep the next two quantities
within a sensible range - a quantity you might persuade them to order when they
realize how much money they could be saving. But don't push itt Somebody who
is looking to buy 1,000 letterheads is unlikely to step up to 5,000.

by Uzer Accaunt

¥ UEE

My Options

I Enable Offzet

v %alidate [1ata
Offset off [v Formnat Text

by Quantities
e v Play Sound

1.000

_ v Show Buttanhelp
1,500 v Preview Printing
2,000 v Azl Ok Delete
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3.3 My Shop

[ think it was Winston Churchill who once admonished a member of Parliament to
"get up, say what you have to say, and when you come to a sentence with a
grammatical ending, sit down." Because much of the audience reading this topic will
have ink running through their veins, | will gladly follow his advice:

My Shop is the control center in Morning Flight. It's where you set up presses and
shop rates and packaging. And how much you charge for washups and pay for ink.

Sorry, Winston, I'll work on the grammar.

My Presses
Or-Line

1-Color [Iffzet

FII:I:E:tFI[EEE:E: 2-Calar Offzet

- I 4-Color Offzet
1-Calar Drigital
B ookbindin: 4-Calor Diigital
S | 1-Calar Copier
4-Color Copier

Packaging

Presses

¢ To set hourly press rates, click charges, and sheet sizes, highlight the press,
then click the Update button.
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e To take a press off-line, click the Presses button, highlight the press, then click
the Delete button.

%\ FJote:

The one-color offset press can't be unchecked. Morning Flight assumes that
virtually every offset shop either has such a press, or at least offers one-color
printing.

When you uncheck the four-color offset press, you'll still be able to quote four-
color. Unchecking the press merely takes it off-line and assigns all four-color
runs to the two-color press, twice through.

Unchecking a digital press or copier, on the other hand, will prevent you from
guoting the type of work associated with that machine (color copies don't look
very colorful coming off a black copier).

3.4 My Store

Mention "Print Store" to printers and they'll tell you that printing is a service, not a
product. And they work in a print shop, not a print store. That response, while
predictable, is mildly ironic when you consider that the first mass-produced "product"
on the planet was the Gutenberg Bible.

Historical footnotes aside, printing really is, for the most part, a service business.
Books can legitimately be called products, but few printers publish books. They sell
letterheads and catalog sheets and other made-to-order items. And a carton of flyers
for ACME Construction is of no use whatsoever to ACME Builders, a point not lost on
shop-lifters. Not many print jobs sneak out the door after midnight.

Since we already have My Shop, we'll call this My Store in Morning Flight. Not the
brick and mortar kind, but a store in name only. My Store is where you keep track of
your customers and manage your products, your paper, your inks.
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Paper Markups

In-Stock  Bug-t Blank

Lezs than 1 Carton 45% 45%
Full Cartan 40 40
3 Cartong or more 3 35

by Substrates

11

My Customers

e To add or update a customer, click the My Customers button.

ﬁ Fote:

When you need to add several customers all at once, go to File > Add
Customers. There you'll find a bulk entry window that will make the process
much quicker.

My Products

¢ To change a product or create a new one, click the My Products button.

ﬁ Fote:

When you add a new product, place the highlight bar over a product with
properties similar to the one you're creating, before you click the Add button.
That way the new product will inherit what's under the highlight bar.
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Paper Markups

e Paper markups are divided into quantity bracket rows and category columns. If
you're estimating for an in-plant shop and want to eliminate markups altogether,
click on the umbrella, then enter zero in all nine markup fields.

¢ What happens when you check CommonSense Pricing, the little box at the
bottom of the My Store window? The program will jump quantity brackets
whenever it makes sense to do so.

Say a customer orders 4,500 letterheads. You're charging $18.00 per 1,000
sheets in the less than 5,000 sheet bracket, and $15.00 per 1,000 if the
customer orders 5,000 sheets or more. With the box unchecked, the paper bill
comes to $81.00 for 4,500 sheets. Had the customer ordered 5,000 letterheads,
the bill would have been just $75.00. Turn on CommonSense Pricing, and
Morning Flight will charge $75.00 instead of $81.00. The order quantity, of
course, will still read 4,500.

3.5 Beforeyoudivein

Oh, really!

Some estimating systems claim to know your market's sweet spot, the exact point at
which your prices are low enough to keep and attract customers, yet still high enough
to earn you a profit. Their manufacturers suggest you use these miracle systems
straight out of the box, abandon the prices your customers have gotten used to, and
step boldly into a more lucrative unknown. What works in Brooklyn, they say, will work
in every state and hamlet in the country.

There's a bridge in Brooklyn you may want to keep an eye on, because what you'll be
stepping into is not where, under the rosiest of circumstances, | would want to take
bold steps.
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If you're just starting out

If your new shop is located in the United States, there's no reason not to start with
out-of-the-box Morning Flight prices. They've been developed under real world
conditions, have proven competitive as well as profitable, and are generally in line with
the national average.

If you're already established

Here the rules change. Once you've built up a customer base and your business is
well established, relying on someone else's pricing formula can just as easily break
your company as make it. You've carved out a niche, mapped out your own playing
field. That means your existing customers expect their next bill to be in the same
ballpark. If you lower your prices you'll lower your profits, and it may or may not get
you more business from your established base. Raise prices significantly all at once
and you'll strain customer loyalties and jeopardize sales.

The only safe way to install a new estimating system in a running business is to first
synchronize the prices generated by the software with the prices you're charging
now, then make incremental fine adjustments, one at a time, until you're satisfied
you've reached the best sales/profit ratio your market can give you.

What if you raised the prices of only those products that are noticeably out of step
with the national average? No reason not to, especially if they're marginal items and
not part of your bread and butter. But here, too, avoid sticker shock. Give your
customers a chance to get acclimated.

3.6 Price Levels

Say Ollie ...*

... why don't we offer different price levels in Morning Flight, like those found in the
Crouser Guides?

Fair question. The short answer would be that | disagree with it on strategic grounds.
That would be true, but the reasons go much deeper than that.
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However, let's start with why it isn't good pricing strategy. One of the quickest ways to
lose a customer is to price 1,000 of that customer's letterheads at $50 last month
(level three), at $40 today (level two), and at $60 next month (level four). If a
temporary slowdown forces a price reduction (or a sudden influx of orders lets you
raise your prices to make up for those reductions), there is an easy way to do that in
Morning Flight: Adjust hourly press rates.

The problem with price levels is that they're too broad, too much of a shotgun-type
remedy. On some jobs, switching from level three to level two may merely lower your
profits. On others, it will mean you're selling below cost. Adjusting hourly press rates
is just as broad and no better that way. That's why Morning Flight offers a more
targeted approach. Here, price adjustments are linked to individual customers.

More reasons against

¢ Ease of Use. Morning Flight is designed to let office staff handle the low end
guotes, freeing the shop's owner to tend to the heavy lifting. Price levels would
put that at risk. Rolling the dice by picking a level at random is probably not the
sort of thing you'd want to entrust to cousin Mel. Customer-by-Customer
adjustments, on the other hand, can be preset to good effect by the
owner/manager.

¢ The Internet. Somewhere down the road, you'll have a web site that offers your
customers unattended, 24/7 pricing. When that happens, price levels - and most
price adjustments - will become untenable and go flying out the window.

+ For the benefit of readers unfamiliar with the
antics of Laurel and Hardy, Stan, the skinny one,
would always open his seemingly clever but

inevitably disastrous proposals to Oliver with
"Say Ollie, why don't we ..."
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Address | Cortact Temns

ACME Bulders

Credit Limit

Monme

| Increase Prices
v Charge Tax

Step by Step

1. i Click the My Store button, then click My Customers.

2. Double-click the customer to open the customer entry window, then click

Terms.

3. Enter either the courtesy Discount you want to extend to this customer, or the
aggravation Surcharge you've finally decided to collect for the constant high-
maintenance VIP treatment.

4. Click OK.
%\Nﬂtﬁ:

On quote sheets, discounts and surcharges are factored into the cost of the
product. By contrast, price sheets and time sheets always reflect the actual
prices calculated by Morning Flight. Quote sheets may look the same as price
sheets, but if the customer is subject to a price adjustment, prices on the two

sheets will be different.
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3.7 Press-based Pricing

Here is an e-mail we received from a printer in Connecticut, reflecting real-world
conditions in a shop that wasn't built yesterday. It brightened our day to read those
heady comments:

"First et me take the opportunity to say how great | think your product is, job
well done. | look forward to being able to purchase the complete program for
your surprisingly inexpensively stated price of $285 US. Will it be possible to
add additiond presses? For example, my shop has three single color presses:

e asmdl format Multi
e amid-size17.5x225
e alarger 23 x 29

| dso have acylinder letterpress used for not only designer-friendly letterpress
work but a so some simple die-cutting."

Thank you, David. If there is a configuration that will throw a gale-force headwind into
Morning Flight's flight plan, this has to be it: Four presses, all single-color, with
separate run prices calculated for each. We can safely assume those run prices are
all based on Budgeted Hourly Rates. Printing is what printing is - one of the last
remaining industries where BHR's still dominate.

Before we tailor the program for David's presses, let's look at what we're up against.
When a company installs a new estimating system, the natural tendency is to try to
configure that system to the way estimating was done before - to simply automate the
manual process. Quick Copy shops generally lean more toward price-book
estimating (Counter Price Lists, Crouser Guides, prices governed by what the market
will bear), while traditional printers favor press-based, cost-plus methods (Budgeted
Hourly Rates, where prices are based on the press used for the job). Morning Flight
can accommodate both but is a more "instant" fit for Quick Copy estimators.
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Making it work in Connecticut

Let's assume David is comfortable with press-based, cost-plus estimating and just

wants to do it quicker, easier, and without paper and pencil. He's using three offset

presses, the exact number even the Free Edition includes straight out of the box. We

can simply edit those without adding presses, so lets start with that.

1. _ngf From the main menu, click the My Shop button.

2. Inthe press selection panel, double-click Ryobi 2-Color Offset.

3. Press the Colors button and reduce the press configuration from two print
heads to one, then match minimum and maximum sheet sizes to David's 17.5

X 22.5" mid-size.

4. Close the press update window.

5. Do the same for the GTO 4-Color Offset, but with the maximum sheet size set

to 23 x 29",

"y S

My Presses
On-Line ¢ ~F

1-Color

Dffzet

1-Caolor
1-Calor
1-Caolor
4-Color
1-Calar
4-Color

B ookhbinding

Packaging

Cffzet
Dffzet
Drigital
Drigital
Copier
Copier
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Selecting the right Press for the Job

Matching Morning Flight's built-in presses to the Connecticut shop's profile is only half
the solution. What David still needs is the ability to override Morning Flight's automatic
press selection and hand-pick any press when making quotes or entering orders.
Fortunately, that ability comes as standard equipment in all paid versions, from the
Passport Edition on up.

Offset | Comy | Digital

Wwe charge
[printed 1 Side]

.\"’"f\hm

One final point: Morning Flight is product-centric at heart. Before you convert to purely
press-based estimating, spend some time evaluating the program's standard pricing
model. It could easily be the better choice for most of your printing. Don't forget, you
can always select one pricing method over the other at runtime.

The Case against Press-based Estimating

Leaving aside the merits of market-based versus cost-plus estimating, here is what
I'm absolutely convinced of: When people go to buy grass seed, it's not the seed
they care about. What they care about is their grass.

Printers love to show off their new acquisitions ... and buyers couldn't be more
indifferent. Need proof? See if you can remember the last time you took your car in for
service, then asked which machine they performed the tune-up on. Never happens! In
today's "hurry-up” world, your customers have neither the time nor the curiosity to be
impressed by that fancy new inkenspritzer you ran their letterheads on. They'll look
right past it. What matters to them are the results delivered to their office. And they'll
get vocal when a $100 letterhead you ran last month on a Multi suddenly costs $150
coming off the Heidelberg because the Multi was out of commission. Once you agree
with that, the product-centric ways of Morning Flight will look like a very good fit.

Looking to the future, here is something else we need to consider. Some day soon,
your customers will expect to find prices on your website 24/7, and when that day
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arrives, the press you ultimately run the job on is no longer a factor. That will leave the
product, not the press, as the price maker. Estimates coming off the internet will by
nature revolve around the product, and Morning Flight is just ahead of the curve.

Custom, case-by-case pricing will always have a place in large printing firms. No one
with any sense would use a price list, or even a pushbutton computer estimating
program like Morning Flight, to quote a million+ run. But in smaller shops, consistent
pricing is the key to keeping customers (and shop owners) happy, and that's where
Morning Flight's product-based pricing strategy excels.

What about the Letterpress ...

Ah, yes, the letterpress. We still need to find a corner for that "cylinder letterpress
used for designer-friendly letterpress work." In the Silver, Pixelblitz, and Gold Editions
(as well as the new Skypricer), letterpress can be quoted as merchandise. The die-
cutting part, of course, can be treated as postpress.

3.8 Adding more Presses

Morning Flight already has three built-in offset presses, one each for 1-color, 2-color,
and 4-color. With that in mind, do you really need more presses? It depends. If you
think it's Ok to sell 500 flyers you printed for ACME Electric at the same price as 500
same-spec flyers you printed for the Garden Factory, then no, you don't need more
presses. Not for estimating. For production, maybe, but not for estimating.

On the other hand, if all of the following conditions are true:
¢ You actually have more than three presses,
¢ You price each job based on the press you'll run it on,
¢ You use a different hourly rate for every press you have,

then yes, you will need more presses in your estimating program, one for each press
sitting on your shop floor. You'll also need one of the paid editions of Morning Flight.
Any edition will do, even the $85.00 Passport. Having a press in the program for each
press in the shop is the nature of the game for Cost-Plus estimating with Budgeted
Hourly Rates (BHRS).
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The mechanics of adding a new press are simple enough. Just click a few buttons
and match the specs. And, once you've figured out the Budgeted Hourly Rate, so is

integrating the new press into your estimating. The only real chore is calculating that
BHR.

The Pushing a Button Part

Here is how to add a new offset press in Morning Flight:

77ty Phasses

HMame Colors Tvpe Litho-4
Offzet

2 builti 1 Offzet Haurly B ate:
v Ryahi @ - Offzet
v GT0O @ 4 Offzet
v Litho-4 i [ffzet A
s Litho- 477 Offset 10/ 472010
: L R N e

1. .glf From the main menu, click the My Shop button.

2. Click the Presses button, then highlight the fourth press (Litho-4).

3. . Click the Check button to activate it.

4, With the press still highlighted, double-click Litho-4, then enter the press
specs and hourly rate.

Setting up a Cost Center

Once you've added the press, the first thing you'll need to do is set up a separate cost
center for it.

%\Mutﬁ:

Because Budgeted Hourly Rates include a profit percentage (as opposed to
Budgeted Hourly Costs which do not), it's tempting to think of the new press as
a profit center. It isn't. Peter Drucker originally coined that term around 1945 but
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quickly recanted, calling it "one of the biggest mistakes I've made." He now
says there are only cost centers within a business, and “the only profit center is
a customer whose check hasn't bounced.” Tongue-in-cheek but close enough
to the truth nonetheless.

Within that cost center you'll have to calculate four different elements:
1. Total annual equipment costs.
2. Total direct and indirect labor costs.
3. Allocated overhead costs.
4. A markup percentage for profit.

If you're unfamiliar with BHRs and how to develop them, find an early edition of
"Printing Estimating” by Philip K. Ruggles. Current editions are pricey, but older
versions are still available at Amazon and other booksellers at a fraction of the cover
price. The chapter on calculating BHRs hasn't gotten shorter over the years. It still
spans 50-plus pages!

The new Press in Practice

Let's say the new press is a 25 x 38" 1-color Komori and you've kept the three built-in
presses as your primaries. Three things are now immediately available to you without
further action on your part:

1. You can enter a 25 x 38" press sheet, previously blocked because you didn't
have a press big enough. The program will automatically select the Komori
since it's the only press able to accommodate 25 x 38".

2. You can override the built-in 2-color (or any other press designated as your
primary 2-color) and assign a 2-color job to the Komori, twice through. Maybe
your primary 2-color can't handle the ink coverage.

3. If your 1-color work is mostly x-up on large sheets, you can make the Komori
your primary 1-color.
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Hame

11 =17

10 Wwe charge
[printed 1 Side]

b &k eready

What's a Primary?

A primary press is what the program selects by default when you create a quote or
enter an order. In that sense, a primary press behaves much like a primary product.
You can designate any offset press as your primary for 1-color, 2-color, or 4-color.
Or, designate a single press as your primary for all three.

Say you add a new press and make that press your primary for 1-color, replacing the
built-in Multi. Morning Flight will now select the new press instead of the Multi for all 1-
color work. You can still hand-pick the Multi, but your new press will come up as the
default.
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3.9

Things you can't do

Just a couple. First, you can't add a new press, then deactivate a built-in press with
the same number of print heads. The three built-in presses always take precedence.
That shouldn't be a problem. Customize the built-in press before trying to define a
new one. Second, you can't deactivate a press you've designated as a primary. Easy
solution: First undesignate the old press, then take it off line.

| probably shouldn't have to answer the next question, but somebody is bound to ask.
How do you undesignate a 2-color primary? By making another press your 2-color
primary.

The Virtual Press

In Morning Flight's magical kingdom of make-believe, all offset printers are given three
presses: a one-color, a two-color, and a four-color. Three presses exactly. No more,
no less.

Quick show of hands, how many small offset shops fit that mold and have that range
of equipment? A one-color press with a T-head, usually. A two-color press drafted
into service for the occasional four-color run, maybe. In the real world, few small
shops can afford a million-dollar Heidelberg.

So what is a virtual press, and why do you need one? In a nutshell, a virtual press is
an imaginary clone of a real press you have in your shop. The two share physical
characteristics, but on the virtual press you use a different hourly rate. And often,
different plates as well. That's the main reason for having it. Same press, different
type of work, different pricing.

Case in Point

Say you operate a single, solitary press in your shop, a two-color Ryobi. Your full-time
employee prints one-color and two-color work during the day. Now and then, a more
qualified (and higher-salaried) moonlighter comes in after hours to run four-color
process. Again, same Ryobi, different hourly rate, different pricing.
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Of course, if do you have the three presses Morning Flight wants you to have, then
virtual presses never enter the picture. All of your presses will be real. On the flip side,
if you're a broker and outsource all your work, all three of your presses will be virtual.
This isn't rocket science. Just a business model, a logical way to help you structure
your pricing.

How to set up a Virtual Press

Using the example above, let's assume you accepted the defaults and had Morning
Flight set up a one-color Multi, a two-color Ryobi, and a four-color GTO during the
prelaunch interview. You don't actually own a GTO, the interview was weeks ago, and
today you decide to set up a four-color virtual version of your "real" two-color Ryobi in
place of the nonexistent, phantom GTO.

Letterheads
1.000 241 00 E

Hame Fipobi-4 0 [ =T

| Ryabi-4CY |
Hourly R ate
'8 s 71416

inimum Sheetsize

b aimim Sheetzize

Standard Plate v 1 Metal

2-Colar M akerzady 15 Minutes [ 2 Phatal
i aximurn Speed 10,000 W= v 3cip
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Step by Step
Ladi= Click the My Shop button, then the Presses button. Double-click Ryobi 2-

Color Offset. Write down the sheet sizes, plate prices, makeready, and maximum
speed you see in the press update window. Close the window.

¢ Back in the press selection window, double-click GTO 4-Color Offset.
e Change the Name to Ryobi-4CV.

¢ Press the Color button and select "2-Color" to reduce the press configuration
from four print heads to two.

¢ Change sheet sizes, plate prices, and maximum speed to what you wrote down
in step 1. Uncheck any plates that can't be used for four-color process.

e Cut the Makeready you used for the four-head GTO in half. You're now setting
up two print heads at a time instead of four. The program will automatically
compensate, depending on whether you're printing a 2-color job once through, or
a 4-color job through twice.

¢ Adjust the Hourly Rate until the prices displayed in the black panel are what you
want to charge for 4-color process. When you're done, click OK.

%\ ke

Run prices shown in the black panel are different for the three base presses
predefined by the program than they are for the rest. The base 2-color press
always displays 2-color prices, and the base 4-color press always 4-color
process, regardless of whether the press is real or virtual, or whether a 4-color
job has to be run through twice because the press has only two print heads.
That's to make it easier to match up your run prices to what you want to charge
your customers.
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In contrast, run prices displayed for presses you define yourself do reflect the
number of print heads. If you configured the press with a single print head, the
prices in the black panel will be for one color. Use the color of register mark as

your guide.

Letterheads _P_
az10 I

1.000

Back in the press selection window, and with the Ryobi-4CV still highlighted,
click the green number 1 button. Make sure the Ryobi-4CV is your primary press

for four-color offset.

kdy Prirnary 1-Color Dffzeat
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4 Getting Around

4.1 Buttons and Navigation

When traveling in a foreign country, knowing where to go and how to get there will
enrich your experience. Running into "Keine Ausfahrt" and eating mystery food
because you can't read what's on the menu will make you wish you stayed home.
Still, with luck, you'll wake up one morning and every road looks familiar and it
suddenly hits you, "I'm getting good at this."

That's how it is with new software. Bouncing from roadblock to roadblock? They didn't
mention that in the brochure. Only marginally less frustrating is to sit idle in traffic,
waiting to have even basic tasks explained to you by a computer-savvy ten-year-old.

Herewith, "How to get Around" in Morning Flight. Highway markers and street signs.
Because getting there should be fun, too.

Mame City

ACME Supplies Chicago
Precizion Automotive [ Detroik

Quotes C T 11

Last Quote

L T T ]

s Ju =
& AL
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Selection Window Buttons

The Delete button deletes the highlighted record.

-
The Add button adds a new record, the Update button changes it.

7

B Click the Find button to search for a record.

T
Click the Zoom button to view the highlighted record in detail.

¢ Double-clicking a highlighted record does the same as clicking the Update
button - it opens an update window to make changes.

¢ Pressing the Ins key works the same as clicking the Add button - it opens an

entry window for additions.

¢ Pressing the Del key does the same as clicking the Delete button. It will either
instantly delete the record without warning if Ask OK Delete is turned off in My

Preferences, or ask you for confirmation.

0Ok to delete? L

-n‘-

3

Precision Automotive g

4396 Ventura Blvd. |

Detroit i

i

2

] J i

o Y R e S L U P R _..,..,;;

%\ ko ote:

Play it safe by keeping 'Ask OK Delete' confirmation ON. You can still instantly

delete a record by holding down the Ctrl key while pressing Del.
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v Format Tegt
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1.000 v Show Buttonhelp

v Prexies Printing

1500 v Ask Ok Delete
> 000

Entry Window Buttons

u The Reset button cancels any changes you may have made in this window,
and restores all text and data to what they were when you opened the window.

The Sort button sorts quantities or prices. The button is there just to make you
feel better. Morning Flight will automatically sort as soon as you accept the window.

% Clicking the OK button (or pressing the Enter key) accepts updates or new
entries, then closes the window.

m Clicking the Cancel button (or pressing the Esc key) discards updates or new
entries, then closes the window.

i . When the Text button shows the picture on the left, it means Text
Formatting is off. Clicking the button will turn formatting back on. At the same time,
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all text in the open window will be formatted with initial caps. When the button shows
the picture on the right, it means text formatting is on. To make a free-form entry
(exactly the way you type it in), click the right button to turn off formatting before you
make that entry.

ikl M When the Data button shows "Goofy," it means Data Validation is off.
Clicking the button will change the picture to an umbrella and turn validation back on.
At the same time, Morning Flight will check (and change, if necessary) all numerical
data in the open window to make sure they're within reasonable limits. When the data
button shows the umbrella and you want to make a numerical entry either above or
below the normal limits, click the right button to turn validation off before you make
that entry.

%\ bk

Text formatting and data validation states are persistent. Each window initially
inherits its states from 'My Preferences’, but then preserves its own formatting
and validation settings. When you accept a window with data validation off, it will
stay off (for that window only) until you turn it back on. For the record, when a
window opens with "Goofy" on the data button, there's a good chance somebody
made an entry that may not make sense in the real world!

Other Buttons you'll run into:

The Save button saves paper to the Buy-it paper file.

13
A . . .
== The Rolodex button generally opens a selection window to retrieve a customer

or contact. When used with paper, it retrieves a paper item from the Buy-it paper file.

Used with paper, the button locks in the same cost for all quantity brackets.
That's when the vendor charges you the same price no matter how much paper

you're ordering.
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When used with products, the Number 1 button lets you designate any product as
your primary, the one you quote on most often. The quote window will open with your
primary product preselected.

% Used with paper, the Lock button locks in auto-pricing where you enter paper

costs in the 1-carton bracket only and leave it to the program figure out the rest.

When used with postpress, a glowing red key shows locked quantities in the quote
you're working on. For example, a customer asks for a quote on 1,000 newsletters
but wants only 800 folded and the rest supplied flat. Click the same button again to
unlock.

288" The Manual Pricing button expands the quick and easy 1-carton entry to let
you enter paper costs in all three quantity brackets.

“ The Color button opens an entry window for paper colors.

é The Cutter button allows you to select the most efficient paper size to cut
from, and to see how much waste is associated with each grain.

b akeready

b edium

You probably wouldn't call this a button, more like the volume
control on a radio. Settings range from very high to very low, in five increments. Left-
click to move the slider up, right-click to move it down.

4.2 Browsing and Updating

The better we understand how browsing works, the quicker we can perform updates.
Not much new to learn here, but knowing the shortcuts can make a big difference.
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I arne Size

w' Blank Paper 1 w17 -
v Carbonless Sheets, D1/ 812211

w' Dligital with trir, 074 g3 w1112
w' Digital with trim, D741 11142 17142
w Dligital with trirm, D444 g3 11142
v Dligital with trirn_ D444 11142 w 17-1/2

{0 Dngital, D0 AR

< Dugital, 010 8142 %11 Zup

< Digital, D11 8142411

® [igital, D11 8142 %11 2up

v Digital, 014 M=17

© Digital, D40 8142411

v Digital, D440 8142 %11 2up -

161 DRE
“Holo

e To sort the browse box

Click on the headings.

Category

fopies

Hide Formal
A

e To locate the first product that begins with a "D"

ame o Size
r‘“
i Data Sheets 3152w 11 ™
D ata Sheets a-1/2 011 2-up
Fram the Desk of B1/2w81/2 | 2Zup
Letterheads 312811
Letterheads, Monarch 14 w10142
i Rl g Al o e g

69

Make sure the highlight bar is in the browse box and not in the black panel, then

press the letter D.

e To page through the browse box

Press the PgUp and PgDn keys.
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Click the Delete button to delete the highlighted record. Keyboard: Press Del.
To suppress the "Ask OK to Delete" window from popping up, hold down the Ctrl key
and press Del.

L
3

MY Click the Add button to add a new record. Keyboard: Press Ins.

Click the Update button to edit the highlighted record. Keyboard: Hold down
the Ctrl key and press Enter.

When used with products, the Number 1 button lets you designate any product
as your primary, the one you quote on most often. The quote window will open with
your primary product preselected.

Used with paper, the button locks in the same cost for all quantity brackets. In other
words, when the vendor charges you the same price no matter how much paper
you're ordering.

[l
Click the Find button to search for a record. Keyboard: Press F4.

S
Click the Zoom button to view the highlighted record in detail. Keyboard:
Press F5.
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The Icons

A check mark tells you it's a program-
generated standard product, currently active
and available for quotes.
Ared bullet shows a standard product that
you've deactivated with the delete button

v Bulletin [mprints and thereby blocked from being used in

B Bulleting guotes.

& Bulleting

: EUS!HESS Eﬂfmﬂ An empty circle signifies a program-

v Puaness Lo generated mandatory product that can't be

Buziness Memos deactivated.

< Catalog Sheets . . .

v Catalog Shests A number 1 icon identities your current

v Data Sheets primary product, the product your quote
window will default to when it opens.
No icon means it's a self-made product, one
you generated yourself. You can delete
those as quickly and as easily as you made
them.

%\ FJote:

Standard products are products created by the program. They can't be deleted, but
their status can be changed from active to inactive, and back again, by clicking the
delete button. Mandatory products, needless to say, can neither be deleted nor
deactivated. Products of your own making are the least persistent. When you delete
a product you created yourself, it's not deactivated - it's deleted from the file.

4.3 Viewing and Printing

Eay
Viewing in Morning Flight is straightforward and standard computer fare. Click
"View" on the main menu, then double-click the item you want to view. Or, highlight it
and click the camera button at the bottom of the browse window.
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Morning Flight - Passport Edition
Windew  Help

File Quoke Price BUEES Prink

-
i Cuskomers
; ; Cantacks k ; ; i :
Wendors

LT R U R N l‘w#w#"‘r'

Because viewing and printing often go hand in hand, you'll find a print button right next
to the buttons for searching and zooming on many of Morning Flight's browse

windows.
E mpire Builders B ook,
ACME Supplies terchandise §
The Pretzel Shop Bookpage %

That's convenient for printing a single document, such as a price sheet or an
estimate. Doesn't work when you need a list of things, like a printout of all your
customers. In that case, click "Print" on the main menu, select the list, then set the
appropriate range filters.

Mermos
List af , . . Cuskomers
et Conkacks
=l
- Yendors

My Pron ducts

L My Inks
iR P ARG e e 8

© 2018 Helmut Heindel



Getting Around

Phinms Laisz

by Products

73

Brother MFC-J4410Dw

[ &l Topes

Sheetz
Cardz/Labelz
Envelopes
Carbonleszs
Copies

v [Digital

v i Merchandise

Huantity

Catalog Sheets, D454, 3-102 = 11

Categany: Crigital Cowerage: 25%
Fackaging: Shrinkarap hd abe ready: hedium
Run: Mormal
b=z keready IFH Guantity Frice
4-C Front, 4-C Back 10 Minutes 2,000 1,000 32180
File Conwersion Hourly Rate
45,00
Frizing: FerHaour
Standard: 20 Minutes
Minimum Hours:
M aximum Hours:
Color Posters Cluantity Frice
M-2847, 12 %18 1 to 24 aA0
Pricing: FarFiece a0 to 99 Z.00
Fackaging: Carton 100 to 295 2.50
250 to 425 2.00
500 to 9QC 1.50
1,000 = 1.00
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%\ ko ote:

Where applicable, prices in the list of products are based on the quantity you
entered in the quantity box.

Lluantity

Copiez
»' Digital
v Merchandize

What if nothing prints?

Go to Print > Setup on the main menu and make sure you've selected your active

printer.

Viewing up close

Zooming in, drilling down - whatever label may be in vogue today, displaying

information in layers helps minimize the clutter on your monitor. Here are examples of
how to get detailed views in Morning Flight.

FRrcestreeZs

D Cuztomer Product
1309-00714C The Pretzel Shop Bookpage
0303-0012C The Pretzel Shop Bookpage
1303-00026 The Pretzel Shop Bonk,
1303-0007 k4 Precigion Automative | Merchandize
0303-000711 The Pretzel Shop Sheet
909-00010 ACME Supplies Sheet

{0H03-00009 ACME Supplies Digital
903-00003 ACME Supplies Sheet
0303-00007F E mpire Builders Sheet
1303-0004C Empire Builderz Bookpage
0303-00018 E mpire Builders B ook
0303-000071 E mpire Builders Sheet

(Juantity

500
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Mini-Zoom

In the quote view window above you get a mini-zoom version of the quote without ever
having to leave the window. The product description, paper name, ink colors, and all
three quantities and prices are always in full view in the black panel on the right. The
display updates as you browse. If you do need to see more, click the Camera button
to open the full zoom window.

Full Zoom

ACME Supplies 1.000 1.500 2.000

Product Catalog Sheets
8142171 [Zup) 219 60

Paper 60 Ib Commodity Offset
11 =17, wWhite 33.90

Frinting

Ink. Colors

Prepress

Postpress

b

E m 353.50 389.45 430.40

Femword [

Picture-in-Picture Zoom

Paper 60 Ib Commodity Offzet oy
11 %17, white =3

Whenever you see the cursor turn into a Camera, as it does here in the paper
panel of the full zoom window, click to drill down for a closer look. Once there,
click the up arrow to view all three quantities.

© 2018 Helmut Heindel



76

Morning Flight Gold

1.000

100

Cutting

b arkup

".,-'-.-'I =} F' 5] _|r| r [n] 5 ) |:| |:| |:|
Full Cartaot

3 Cartans 15,

The Magic Wand

Watch data transform. When you pass the cursor over the "Run" area, the readout
changes from press speed to time to print. Click to lock it in.

Hewsletters 17,
1 %17 2,000 105.20

4 500 IPH

AutoSelect

Rz
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4.4  Exploring Cursors

The cursor tells you where on the screen your mouse is. Its shape often holds the key
to what might be hidden in the next room. If you can't find the door, chances are, that
room will stay hidden until you discover it by accident. Morning Flight may be a joy to
use, but it's still a tool. Here is a no-time-for-games set of clues.

We'll begin with the obvious: Whenever you see the
camera, click to zoom. It's good to get an instant price.
It's even better when you can instantly drill down and
find out what that price consists of.

Similar to what the camera cursor does, but here you're
presented with a time sheet, a visual report of how long
the job should take to print.

The up-and-down cursor moves the slider. Left-clicking
moves it up a notch, a right-click moves it down.

The hand cursor usually signals a roll-over, a shortcut
to the next logical choice. Here, the next click will take
you to 80 Ib Coated, from there to 60 Ib Offset, from
there back again to 70 Ib Text.

As Benny Hill was fond of proclaiming: "Another
privileged glimpse of the bleedin' obvious." If you click
here while the trash can is showing, xpedx Stores will
no longer be the vendor for this item.

The sound cursor provides no nutritional value
whatsoever! Just ear-candy to break up the monotony.
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Our favorite! When you hover the wand over an area of
the screen, the wand temporarily changes the display
of the value under it. In this case, from impressions per
hour to total minutes, from press speed to how long it
takes to print. Click, and the change becomes
permanent. Click again, and you're back to the original
display setting.

4.5 Formatting Text

Junk mail often comes in triplicate: One addressed to "John Smith," another to "john
smith," and a third to "JOHN SMITH," all residing at 35 Elm Street. That's caused by
lack of consistency in how information is loaded into the database, made worse when
more than one person has access.

The Solution

With text formatting ON, Morning Flight will always enter text with initial caps. No
matter how you key in John Smith, in all lower case, initial caps, or all caps, John will
always be added to the customer file as "John Smith." That solves the problem until
you come to "ABC Construction," in which case you need to turn text formatting OFF
so you can enter "ABC" in all caps. Here is how:

E If the Text button looks like this, do nothing. Text formatting is already OFF,
and whatever you enter will be entered as is.

H If the button looks like this, click it before you enter text.

e If you inadvertently entered John Smith as "JOHN SMITH," click the text button
and Morning Flight will reformat the entry to initial caps.

¢ You can turn text formatting OFF altogether, in My File > My World > My
Preferences. Keep in mind that when you do, you're flying solo.

%\Nﬂtﬁ:
Text formatting and data validation states are persistent. Each window initially
inherits its states from My Preferences, but then preserves its own formatting
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and validation settings. When you accept a window with text formatting OFF, it
will stay off (for that window only) until you turn it back on.

4.6 Validating Data

If computer applications could be made fool-proof, there'd be fewer shelves with
books for "Dummies." But they can be made fail-safe. Well-thought-out programs can
incorporate a mechanism found mostly in machinery that guarantees that if the
contraption should blow up, it will blow the other way.

In Morning Flight, that mechanism is called Data Validation. Its purpose is to keep
small errors small and not let them turn into catastrophes. Whenever you enter
numerical data, Morning Flight imposes minimum and maximum "validated" values.
With validation ON, the program can safely be used by office staff with limited
estimating experience. Cousin Mel can handle the low-end stuff, freeing the shop
owner or manager to focus on big-dollar projects.

With validation OFF, the sky still isn't the limit, but the range extends well beyond the
reasonable.
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Meet "Goofy"

There are times when validation has to be turned off to keep flying. For entering a
PMS ink color that didn't exist when you downloaded the program, for instance. In that
case, clicking on Goofy is the only fix. As for leaving validation off altogether? Stick
with the umbrella. If | were to look for a co-pilot, Goofy wouldn't be my first choice!

If the Data Validation button looks like this and you need to enter a number
that's outside the normal range, click the button before you enter the number.

ikl If you see Goofy, data validation is already OFF. There's a chance
somebody made an entry that probably doesn't make sense in the real world.
Click the button, and Morning Flight will validate all numerical entries in the window.

¢ You can turn data validation OFF altogether, in My File > My World > My
Preferences. Remember that when you do, you're flying with Goofy.

%\ P ote:

Data validation and text formatting states are persistent. Each window initially
inherits its states from My Preferences, but then preserves its own validation
and formatting settings. When you accept a window with data validation OFF, it
will stay off (for that window only) until you turn it back on.

4.7 Entering Sheet Sizes

Entering sheet sizes into a computer, easy as it is in millimeters, can get tiring in
inches. Especially if you grew up with millimeters. We did our best to keep the
process simple. If you can find the size you're looking for in the black panel, double-
click it. That will select it and close the window.
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The Inch Version

PR
L nnananmnns

81

There are three ways you can enter the 22-1/2 inch width. First, make sure the little

button says "W" (for width). Otherwise, click it. Then either:
e Enter "22.5" or "22-1/2"
e Enter "22", then click on the 1/2-inch mark.

e Enter "22", then move the red slider to the 1/2-inch mark.

The Metric Version

2 e 4 mm
ltenbtinbtnbtadnin
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5 Making Quotes

5.1 Quoting Offset

This topic assumes you've completed "Your First Quote." If you haven't, not a
problem, but buckle your seatbelt. This ride will be quicker.

Product

ACME Automotive

Letterheads

8142211 A

Paper

24 |b Classic Laid

8-1/2 1 11, Awon Brilliant White (el

Frinting

Ik, Calors

Prepress

Postpress

Fewword [

FEE Z0

Making the Letterhead Quote

91.20

37.70

30.00

le

158.90 202.80 374.80

From the main menu, click the Quote Printing button.

e Click the F2 button, then double-click Letterheads.

¢ In the print quote window, click the F3 button, then double-click 24 Ib. Classic
Laid, Avon Brilliant White.

¢ Click the F4 button, then select Black plus Color and click OK.

e Enter PMS 109 and click OK.

|
. In the print quote window, click the Quantities button or press F12.
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e Enter the quantities and click OK.

Saving the Quote

|
o k= In the print quote window, click the Rolodex button (the one on top, inside

the black panel).

L
3

o KB i you've completed "Your First Quote," you will have at least one customer

to double-click on. Pick anyone. If you haven't, the window will come up empty.
Click the Add button, then enter any name in the Company field and click OK.

¢ Click OK in the print quote window to save the quote.
Making the Envelope Quote

o Eﬂ While the print quote window is still open, click the Paste Ink Colors
button.

e Click the F2 button.

¢ Click Envelopes in the black panel on the right, then double-click Envelopes,
Size 10.

e Click the F3 button, then double-click 24 Ib. Classic Laid, Avon Brilliant White.

¢ Click OK to save the quote, then close the print quote window.

5.2  Quoting Digital

This topic describes how to quote a standard digital product. For the sake of variety,
we'll assume the bulk of your work is digital. You'll want the quote window to open
with a digital product, not offset, so our first step will be to designate a digital product
as your primary product.
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%PM

M arne Size
Category

v Digital with tim, D7/ | 83/ % 11-1/2 - Ofizat Sheels
v Digital with tir, 0141 | 11-1/2 % 17142 Ofset Cardsd abel
v Digital with tir, D424 | 11-1/2 2 17142 A
O Digital, 0/0 81/2 %11 Ofset Carbonless
© Digital, 01/0 81/2% 11 2up Lopres
O Digital, D11 8142411
v Digital, D1/1 81/2% 11 2up Wide Formal
v Digital, D1/1 11217 -
O Digital, D14/0 £1/2 4 11 z'j';’ ohandise
(0 Digital, D0 =R FERSA aun
 Digital, D4/ 81/
v Digital, D4/1 81/2x 11 2up -

.- JL s, =
U

Preparing for Digital

o = From the main menu, click the My Store button.
¢ Click the My Products button.

¢ Click Digital in the black panel on the right, then place the highlight bar over
Digital, D4/0.

e Click the Number 1 button, then close the window.

¢ Close My Store.
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Product Digital, D411

8172 1 11, printed 2 Sides [Fz]je ] 401.00

Faper 60 Ib Commodity Offzet

11117, white A 2320

Frepress

Fostpress

18.00

44220 647.55 853.70

From the main menu, click the Quote Printing button.
¢ Click the F2 button, then double-click Digital, D4/1.

¢ Back in the print quote window, click the F3 button.
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5.3

|

‘weight Mame Calor Size
B0 b | Commodity Offset W' hite 14201
B0 1b | Cammodity Offset W hite: 11 =17
G0 |6 | Commodite Offset ' hike 23w df
gl b | Coated Book, W hite a1/ w11
801b | Coated Book, ' hiiter 1 =17

Z 8

Category
Hiriting

enverd ahal

¢ Click Book/Text in the black panel on the right, then double-click 80 Ib Coated

Book, White, 8-1/2x11.

e Click the F7 button, then select Letterfold. Click OK.

d
o ﬁ Click the Quantities button or press F12.

¢ Enter the quantities and click OK.

¢ In the black panel on top, click the Rolodex button, then select a customer.

¢ Click OK in the print quote window to save the quote.

Quoting RISO

This topic describes how to quote a standard RISO product. If most of your printing is

produced on RISO duplicators, you'll want the quote window to open with a RISO

product preselected. Our first step will be to designate one of the four RISO items in
the selection box as our primary product.
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@PM

M arne: Size

v Digital, D441 312411

v Digital, D441 a1/2611 2-up
< Digital, D444 31/2x11

v Digital, D4./4 312411 2-up
v Digital, D4./4 11 =17

© Envelopes, Size 10,014 417823142

© Envelopes, Size 10,044 41/8x 9142

v Envelopes, Size 9, 0D1/0 3-7/8=8-7/8

v Envelopes, Size 9, D40 3-7/8 % 8-7/8

v Rizo Envelopes, Size 10[ 41780 3-1/2

» Rizo Envelopes, Size 10( 4-1/8 1 9-1/2
(M Rizo Sheetz, H1/0 217201l

v Rizo Sheetz, B1/0 312411

i AL

Preparing for RISO

= From the main menu, click the My Store button.

¢ Click the My Products button.

Category

Lapies

HWide Formal
Al

87

¢ Click Digital in the black category panel on the right, then place the highlight bar
over Riso Sheets, R1/0.

¢ Click the green Number 1 button, then close the window.

e Close My Store.
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Product

Riso Sheets, B1/0

B1/2 w11, printed 1 Side E

Paper

60 Ib Commodity Offset

B1/2 1 11, White lealle]

Prepress

Poztpress

Keypword |

BE Z0

Making the Quote

e Click the F2 button, then double-click Riso Sheets, R1/0

¢ Back in the print quote window, click the F3 button.

32.00

12.75

13.00

5775

From the main menu, click the Quote Printing button.

91.85 188.40
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| |

W' eight Hame Calar Size Category
Bl b [ Eommadity Oifzel ifite ERFEER Hiritng
B0 b | Commadity Offzet White: 11817
B0 b | Commodity Offset White 23%35 frr ety 2
80 1b | Coated Bock White 8142511 Coved abe/
30 b | Coated Bool: Wihite 11 w17

z:[1

¢ Click Book/Text in the black category panel on the right, then double-click 60 Ib
Commodity Offset, White, 8-1/2x11.

e Click the F7 button, then select Letterfold. Click OK.

d
ﬁ Click the Quantities button or press F12.

e Enter the quantities and click OK.

¢ In the black panel on top, click the Rolodex button, then select a customer.

¢ Click OK in the print quote window to save the quote.
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5.4 Quoting Copies

This topic describes how to quote a standard copy product.

Product

Copies, C1A1

8172 1 11, printed 2 Sides E

Paper

60 Ib Commodity Offzet

11 %17, white el

Prepress

Fostpress

K. ewword [

e Click the F2 button.

100.00

21.10

7.00

128.10 190.65 253.20

From the main menu, click the Quote Printing button.

¢ In the product selection window, first click Copies in the black category panel,

then double-click Copies, C1/1, 8-1/2x11.
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@PM

I ame Size Category
Copies with tim, C1/1 3344w 11142 Heat Sheals
Copies with trim, C1.1 11142 w1712 Hwal ardes? 3
Copies with trim, C4./4 230w 11142 i}ﬁqﬁjéﬁiﬁ}gﬁﬁi‘ej
Copies with trim, C4./4 11142 w1712 i FES
Copies. C1/0 81/2 % 11 Offzat Carbonfess
Copies, C1/0, RIP 3142w 11

i Copes, G147 R FeERl Digrial

Copies, C1/1, RIF 3152011
Copiez, C4/0 3152011
Copies, C4/0, RIF 3152011 -
Copies, C4/4 8142 2 11 Letterheads
Copies, C4/4, RIP 3142 %11 Second Sheets

Z0

e Click the F3 button, then double-click 20 Ib. Copy Bond, White.
¢ Click the F7 button, then check Drill. Click OK.

¢ Click the Quantity button, or press F12.

Copies, C1/1
= 1 1,000,000

| 1ooo]l  1so0f( 2000

tultiple Qriginals
RIF from
Cuztarnes
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e Check Multiple Originals, then enter "20". Click OK.
¢ Click the Rolodex button in the black panel on top, then select a customer.

¢ Click OK in the print quote window to save the quote.

5.5 Quoting Wide Format

This topic describes how to quote a standard wide format product.

File Quote Price  Write Estimate- -Manage Skyprintstore  View Print Window  Help

QFEA 6.2 AN 0

¢ At the main menu, select Quote Price > Quote Wide Format, or click the quick
access button circled above.
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Froduct B anher

Aake New £

Product

e Click the Product button.

I ame

Price of 1

Making Quotes 93

110.00

Last o make

W Fil= Frep

{2 Banner

2 Z0

7B54

Category

Hoard
FPrsicr
Magrelic
flecal

Fextie
Hiram
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e Make sure Banner is highlighted the black category panel, then double-click
Banner in the white selection box.

Price of 2

Make New

st o make

Quantities

e Change quantities to 1, 2 and 3.

¢ Click the File Prep checkbox and either edit or keep the default value of $20.00.
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Price of 2
Aake New ¢

fast o make

. ACME Supplies

stomer Discount

¢ Click the Customer button to add a new customer or select an existing one.

¢ Click Ok to save the quote.

%\ Fote:

Throughout the program, whenever the cursor changes to a magic wand it
temporarily changes the type of value displayed in the area over which it's
hovering. In the image below, "Price for 3" now shows "Price each"”, and "Cost to
make" has changed to "Our Markup”. Without moving the cursor, click once to
make that the default. Re-enter the hover area and click again to restore the
original setting.
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UWirke fM Price each

Make New £

e Markun

5.6 Quoting Merchandise

This topic describes how to quote merchandise.

Hyland Air Service

Product Prezentation Folders
B-4355, 9% 12 i
Fackaging Ho Charge
Priced: Per 1,000
Description
Keyword I

N % m 590.00 885.00 1.180.00
i 2,

Making the Quote

e From the main menu, select Quote Price > Quote Merchandise.

e Click the F2 button, then double-click the merchandise item to select it.

© 2018 Helmut Heindel



Making Quotes 97

MHurnber Mame Huantity Price
File Pretight 1] 45100
w-4387 Full Color Postoards 5,000 299.00
B-4355 Prezentation Folders 1.000 1.180.00

i z:[1

Priced per Piece or per 1,000

d
ﬁ Click the Quantity button or press F12 and enter the quantity.
¢ Click the Rolodex button in the black panel on top, then select a customer.

¢ Click OK to save the quote.

Priced per Lot

When priced per lot, the item is available in fixed quantity lots only. The quantity
button will be grayed out. If more than one quantity is available from the vendor,
use the up/down arrows to select the quantity range you would like to quote on.

549.00

L S TS A S QT Y LS CRE SIS S SN S S, SO RN
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Priced per Hour

When priced per hour, the black bar now contains an entry box for hours and
minutes. You can either accept the default (the "standard hours" defined when the
merchandise item was created), or change it to any value within the min/max
range.

2250

= et AT e s e T e T e R e e e e S B i e,

%R ke

When you create or update a merchandise item priced by the hour (a service
item, really), you're setting minimum and maximum time values for that item.
The min/max range is the range between those two values. If Morning Flight
won't let you change the hours and minutes, it's because minimums and
maximums have been pushed so close together that there's no wiggle room.
With both set to 30 minutes, standard hours has to be 30 minutes, too.

Hame File Preflight

Bate per Haur

Standard Hours af 30
Minirun Haurs oy a0
bl amirnuim Hours 0f 30
W T avahble

© 2018 Helmut Heindel



Making Quotes 99

5.7 Quoting Custom Offset

This topic describes how to quote a custom offset product.

Product Mote Sheets
31/2 %8172 [3up) =Arn 53.20
Faper 20 Ib Copy Bond
8172 0 11, White [Fa]le ] 785
Printing
- -
Poztpress -
Fi
Keyword [

N % m 61.05 ¥7.90 128.40
i 2,

Step by Step

From the main menu, click the Quote button.

¢ Click the F2 button, then double-click Note Sheets, 3-1/2x8-1/2, 3-up.
%\Mutﬁ:
When you define a custom product, first select a standard product that has
properties similar to the one you're defining. That way the custom product will
inherit the standard product's properties. It's usually easier to modify an existing
product than to define a new one from scratch.

e Click the button to the right of the F2 button, or hold down the Ctrl-Key and
press F2.

e Enter "Coupons” in the Name field.
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DOffzet | Copy | Digital |

We charge
[printed 1 Side]

Prepress 32.00

Ink 060

v : M ak eready 16.83

2 Minutes Run 367
Flate Cutting 2.00
CTP Packaging 0.&0

1.000 u Price

RE Z=N

¢ Click the Size button and change the product size to 3x8".

¢ Click the Properties button. Move the Spoilage slider to High. Click OK.

10
1,000 61.70 A *‘}

Filrn ad)
Maone 10 bir

| .I : 0 Mirs = o~
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¢ Back in the custom product window, press the Bleed button.
¢ Click the 1/8" radio button, then clear the Left and Right fields. Click OK.

¢ Click the Press Sheet button and change the press sheet size to 11x17".

Top

Battam
Lett
Bight

PRI

Zooming in

Fraduct Coupons —
[ 34 8 bleed [E-up] rz]le ]

In the print quote window, click the white Product panel to open a product zoom
window where you can view the results of Morning Flight's behind-the-scenes
calculations. The red indent on the Ctrl-F2 button tells us this is a custom
product.
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Mote Sheets

Ind [Bup]

Filrn U riiks:
20 Minutes

5.8 Quoting Custom Digital

15.00
17.00
0,60

15

9.00
0.E0

1oo0 A

b edivim

This topic describes how to quote a custom digital product.

Froduct Digital. D441

81/2 2 11, printed 2 Sides =re

Paper 20 Ih Copy Bond

81/2 4 11, White lealle

Prepress

Postpress

Kepwmard [

EEE Z0

237.10

21.45

Le

258.55 494 75 1.165.20
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Step by Step

From the main menu, click the Quote button.

¢ Click the F2 button.

e Click Digital in the black panel on the right, then double-click Digital, D4/1, 8-
1/2x11.

e Click the button to the right of the F2 button, or hold down the Ctrl-Key and
press F2.

¢ Enter "Bestbuy Mailers" in the Name field.

Hame Bestbuy Mailers 444

g81/2=11 -'-r-

Copy Drigital

We charge
[printed 2 Sides)

Fiun 12419
Conzsumnables

Click Charges 16336
Wariable D ata 41.05

Finizhing
Packaging 0.e0

Bleed Price 32920

¢ Click the small button in the black panel (pointed to by the arrow) to change the

run configuration from 4/1 to 4/4, from four-color on the front, black on the back,
to four-color front and back.
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o Left-click the Variable Data slider until it shows 100%. At that setting, every
sheet will be personalized.

¢ Click the rightmost radio-button underneath Coverage to shift into high-range,
then right-click the Coverage slider until it shows 40%. The three radio buttons
act like a low-medium-high transmission, tripling the available range of
percentages to fifteen.

¢ Click the Properties button. Move the Makeready slider to High. Click OK.

%\ b ke

If the job were to be printed on heavyweight paper on a low volume press, you
would need to slowthe runtime to match the manufacturer's recommendations.
High production presses will generally run at full speed regardless of weight. In
that case, the runtime slider should be left at its lowest setting.

Digital
1.000

Spoilage  Makeready  Runtime
2% 15 Minutes 1:00
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Zooming in

Product [ Bestbuy Mailers, D474

§1/2 %11, 2 Sides EE

In the print quote window, click the white Product panel to open a product zoom
window. The red indent on the Ctrl-F2 button tells us this is a custom product.
The D in D4/4 says it's digital.

1oo0 M

15 Minutes
1:00 Hour

Makeready
100% 2 H igh

Shrinkwrap
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5.9 Quoting Custom Copies

This topic describes how to quote a custom copy product.

Product Copies, C1/1, RIP
81/2 % 11, prirted 2 Sides A Bl
Faper 20 1b Copy Bond
812 11, White [ lle] 1255

Frepieszs
Postpress
Feyward [

92.95 159.45 316.60

From the main menu, click the Quote button.

e Click the F2 button.

¢ Click Copies in the black panel on the right, then double-click Copies, C1/1,
RIP, 8-1/2x11.

e Click the button to the right of the F2 button, or hold down the Ctrl-Key and
press F2.

e Enter "Progress Report" in the Nam e field.
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Corstom Fhodeec?™

Dffset Capy | Digal |

Per Copy
0.077 [printed 1 Side]

We charge
Copying 33.00
RIF 13.20
Originals

Finizhing
FPackaging

Price

¢ Click the small button in the black panel (pointed to by the arrow) to change the
run configuration from 1/1 to 1/0, from black on front, black on back, to black on
front only.

e Click the Prices button.
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Packaging

Mo Charge

CommonS e

Firirniann
RIF
Origitials

%\ P ote:

& Pricing

Progress Report

]

per 8-1/2 % 11

[30% coverage, 1 zide]

1

- 49
.99

0.075

0.070

0.0E5

0.0e0

0.055

7.5 cents

¥ centz

6.5 cents
B cents
5.5 cents

b cents

Prices entered in the pricing window are baseline prices, prices you would
charge for an 8-1/2x11 or A4 copy, one side, with 30% coverage. When you're
guoting, Morning Flight will recalculate those prices to account for size,
coverage, and run configuration (front only versus front and back).

o Make sure RIP is checked, then enter 15 for RIP. Check Originals and enter 12.

%\ b ote:

When a quote includes multiple originals, the quantity you would quote on is the
total quantity, not the quantity per original. In the example above, the 600 run
represents 50 copies each of 12 originals. That's true throughout Morning Flight,
regardless of whether you're quoting offset, digital, or copies. The quantity
you're quoting on is always the number of finished sheets, envelopes, or
carbonless sets. Take pads, for instance. A quote for 1,000 note sheets finished
into 50-sheet pads would give the customer 20 pads.

¢ Click the Packaging button and select Letterbox. Click OK.
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[ Shrinkwrap
[ Carton
[ Ma Charge

Zooming in

Praduct [ Progress Report. C1/0. RIP

81/2 % 11,1 Side @E

In the print quote window, click the white Product panel to open a product zoom
window. The red indent on the Ctrl-F2 button tells us this is a custom product.
The C in C1/0 says they're copies.

%\Mutﬁz

The zoom window for copies shows baseline prices, prices you would charge for
an 8-1/2x11 or A4 copy, one side, with 30% coverage (excluding paper).
Baseline prices are entered either in My Store for a standard copy product, or
above, in the prices window, for custom copies.
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EOO E

Report, C1/0, RIP
1. printed 1 Side

aze price per o

1 ta 49
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5.10 Quoting Custom Wide Format

This topic describes how to quote a custom wide format product.

Wide %M Price of 1 1 B

Make New 4 44 30
Last o make g1 55 [

Quantities

—

Dption 3 : ; e S :

= h anne Size
Lustomer
0 Yard Sign 1824 Haanrer

Hoard

Magretic
flecal
Fextile

HWigg

Making the Quote

e Begin by creating a standard quote for a yard sign, but don't save it. If you
inadvertently click the Ok button, retrieve the quote for editing.
(see Editing a Quote)
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Froduct Yal’d Slgn
1 1.54

REIE

Price of 1

41.80

Lost o make

Setup

Cluantities

F

Price

888

[

MinirnLim

Grommets

&.00

per Setaf 4

irard Sign Stake

2.l

per Plece

¢ Change the three quantities to 1, 5 and 10.

e Check Option 1 and select Yard Sign Stake from the predefined Custom Sky

Options list.
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Price of 1

Make New 4 4430
Losl o make JI1E5

Froduct Yal’d Slgn

(15
Custom Wide
Format

Price of 1

44 30
o5t fo make — J1E5

Product Mame

“ard Sign

Prit fior quartity deduct

Setup Price Minirmurm Price W Discount

20.00 25.00

¢ Click the Custom Wide Format button.
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Wie Foumaz

Fraduct Hare

“rard Sign

f
L,

Setup Price timimum Price

15.00 25.00

1N
39.30

{ast o make — ZH 08

for quantity deduct

5]  s0%
| mox

0 clpi

T et e

R A R

¢ Reduce the Setup Price to $15.00 and make other changes, such as product

Size or substrate, to match the customer's request.

¢ To raise or lower the price, adjust the markup and/or discount.

¢ Once you're satisfied, click Ok to close the window, then click Ok again to save

the quote.

% ote:

One item can't be adjusted here: The Price per sq.ft. That item is a property of
the substrate, not the product. Chances are, more than one product will use that

same substrate. Changing the price here would alter the price of every other

product using it.
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Price of 1

fast o make

. Empire Builders

5.11 Quoting Custom Paper

This topic describes how to quote custom paper for offset, digital, and copies. The
paper specified by the customer is 70 |Ib. Regency Text, a color paper priced per 100
Ibs. by the vendor. You don't carry Regency Text in stock, and there is insufficient
demand for it to justify adding it to your Buy-it file.

From the main menu, click the Quote button.

¢ Click the F2 button, select Digital, then double-click Digital, D1/1, 8-1/2x11, 2-
up.

¢ Click the button to the right of the F3 button, or hold down the Ctrl-Key and
press F3.
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o]

Herox

L

Product Digital, D141

8172 %11 [Z-up) [Fz]e ]

Paper 60 Ib Commodity Offset

11 %17, white [Fz]le]

FRegency Test

per 100 Ibs

Carton Content

[~ Mo partial reams

We pay per 100 Ibs
23x35

Lezz than 100 bz 3200
100 bz 228.00
R00 Ibs or more 191.23

Auto-Frice Lock
B, i -y [ [
BE@ - 50 Z0

¢ Enter "Regency Text" in the Name field.

¢ Click the small button in the black panel (the one pointed to by the arrow) to
change per 1,000 to per 100 Ibs. Or, click on "We pay per ..." in the light gray
panel.
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& Click the Auto-Price button, then enter a cost of $228.00 in the 100 Ibs bracket.

%\ bk

These are costs, not prices you charge you customers. With AutoPrice Lock
ON, costs in the other brackets automatically adjust as you enter your cost in
the one-carton bracket. Obviously, Morning Flight has no way of knowing what's
in your vendor's price book, so don't expect those estimated bracket costs to
be actual. They may be close enough for quoting 500 letterheads but not for
10,000 catalog sheets. We'll enter actual costs in step 9.

¢ Click the Sheet Size button. Double-click 23x35 Long.
¢ Click the Weight/Type button, then select Text and enter 70 Ib. Click OK.

¢ Click the Color button. Enter "Wheatstone", then click the gray color bar in the
palette if the ball isn't pointing to it already. Click OK.

P lobse

Regency Text

I:. I:I | I:I r

e Click the Grain button. Select Full Size Short and Cut Size Short. Click OK.
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Full Size

Cut Size

B Z=0

e Click the Cutting button. Select Cut By Vendor and Cost per 100 Ibs. Enter
$14.00 for cutting 80 square inches or larger, $17.00 for cutting from 79 to 40
square inches. Click OK.

a0 zq.in. »
9 - 40 zq.in.

Smaller

Minimum Charge

Rk Z=0

1"'

|

8 - :
ﬁﬁ" Click the Manual Pricing button. Enter $350.00 in the Colors, less than
100 Ibs. bracket. Click OK to close the custom paper window.
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Spoilage

h ediurn

Grair
Long, 4-out, 7%

Cutting

By Yendor

%\ b ke

Carton Content

[ Mo partial reams

We pay per 100 Ibs
2330

Less than 1001k | B> 350,00
10045 228.00
5[}5 Ibs or mare: 191.29

karweal Entry

BER A0 Zz1

Morning Flight lets you enter paper costs in any conceivable configuration your
vendor might be using in his price book. In the window below, left-clicking within
the red circle will increase the number of cartons, right-clicking will lower it.
Clicking anywhere else in the area pointed to by the arrowwill change the
bracket configuration. Be sure to match up your configuration with how the
paper is sold by your vendor. Entering a cost for 100 Ibs. when your
configuration is set for 1,000 sheets will get you a bad quote in a hurry.

Wwe pay per 1.000 zheets
11 =17

Lesz than 1 Cartan Ja0.00
350,00
350,00
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Zooming in

Paper [ 70 Ib Begency Text

-"r.'-
23w 35, Wheatzstone E

In the print quote window, click the white Paper panel to open a paper zoom

window, where you can view the results of Morning Flight's behind-the-scenes
calculations. The red indent on the Ctrl-F3 button tells us this is custom paper.

70 Ib Regency Text. 119M

A heatstone

E; Fu:lilagEf
k edivrm

Tupe

Text

5.12 Quoting Booklets

In every profession, some chores just naturally gravitate toward the bottom of the in-
pile. They're the projects we approach with the same enthusiasm as filling out income
tax forms or cleaning out the garage. In printing, that award goes to estimating the

© 2018 Helmut Heindel



Making Quotes 121

cost of booklets. I've never met a shop owner who was eager to sit down, reach for a
calculator, and work up a booklet quote.

Thanks to Morning Flight's booklet module, that's now history. We've managed to
squeeze the entire process into three simple steps:

1. Specify the size of the booklet.
2. Select the type of binding, including trim.
3. Gather up the cover and contents.

Pricing the cover and contents is basically the same as pricing letterheads and
postcards. Except here, the sheet size has to precisely fit the size, type, and trim of
the booklet. That part has become a walk in the park, because the booklet module will
tailor the sheet size for you.

Does that mean pricing a booklet will now be the first project you'll want to tackle
when you walk into the office on a Monday morning? Probably not. But neither will it
be the last.

Hyland Air Service

Praduct Firzt Flight Booklet, 26 Pages

Binding Spiral-bound
M i 217.90

Front Cover
Back Cover

Contents

Feynword [

2.246.05 3.772.30 8.420.60
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Setting the Size and Type

_—
' From the main menu, click the Booklet Quote button.

e Click the F2 button, then enter the Name.

Firzt Flight Booklet
1.000 E . _.

Composition
Revizgions
Scans
Froofs

by Prepress

Postpress

Packaging

Price

Z0

¢ Click the Book Size button and select 8-1/2x11 (or A4).

%R rote:

To change the booklet's format from portrait to landscape, enter the long
dimension first, or just click on the size. The yellow bullet tells us it's landscape.

BEoolk
LR

F'rgprn:m
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¢ Click the Prepress Button.

%

Fgroan i
M S

LCompozition | iy Prepress |

File Prep Composgition

Scans

¥ Proofs
K B

| 5]

|| Price

Rk Z

e Check Composition, then enter 2 hours and 30 minutes. Composition and

My Prepress

other prepress charges entered here are for the entire booklet.

¢ Enter black/white and color scans as shown. The quick way is Jet-Entry: 521 in
the B/W Scans box, and 001 for Color Scans.

e Check Proofs and enter $48.00, then click OK.
¢ Click OK to accept the product window.

¢ Back in the quote window, click F3 and select Spiralbound. Click OK.

" Saddiestitched S
" Perfectbound o M6 148 14 12
" Comerstapled

ﬂ ||I|||I|||I|||I||
[ GEC-bound
@piralbuund i+ Ma ki
YWirebound
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Entering the Covers

Booklet covers fall into two categories: Folded covers for staddlestitched and perfect
bound booklets, and flat covers for everything else. Regardless of type, the size of the
cover is tied to the size of the booklet, so that's not something the program will let you
change. What you can do, with folded covers, is print them 2-up by enlarging the
press sheet. That will affect the price and press run, though not the page count. It's
unlikely you'd want to wrap any booklet into more than one set of covers.

Flat covers, the type used for spiral, wire, and GBC bound booklets, are different.
Here, when you make the press sheet big enough for a 2-up run, the program
assumes you're going to cut the front and back covers out of the same press sheet.
Consequently, the entry box for the back cover goes away, along with any back cover
specs you may have entered.

¢ In the quote window, click F4.
e Check Front Cover, then enter any configuration suitable for a booklet cover.

e Check Back Cover, and enter the configuration for that.

Assembling the Contents

Each booklet can have up to three different containers for book pages. Let's assume
most of the pages are printed in black ink. Those pages will all go into our first
container. Color pages go into the second. And a reply card, an insert, gets dropped
into the third. Just so you know, the sequence doesn't really matter.

e Check Contents 1, then enter the configuration for inside pages printed in black
ink.

e Check Contents 2, and enter the configuration for inside pages printed in color.
Let's make the press sheet size twice the size of the product so the signature
will print 2-up.

e Click OK to close the window.

e Back in the quote window, you'll find entry boxes for each container. Enter 10 in
the first box for Contents, 2 in the second. Those numbers tell the program how
many signatures we're putting into each container. More specifically, how many
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1-up, 2-up, or 4-up signatures with the same ink colors, and on the same paper,
we need to print.

Contents

Adding an Insert

What's an insert, and how do we enter it? Inserts are reply cards, carbonless forms,
things that don't meet the criteria for a standard book page. You can designate any
container as an insert by checking the white bullet box. Two things happen when you
do that. First, you're now free to pick any size. Second, you're locking in the page
contribution: Four pages for saddlestitched and perfect bound inserts, two pages for
spiral, wire, and GBC. That's different from signatures. There, when you double the
size of the press sheet, you double the page contribution.

Let's assume you're quoting 1,000 saddlestitched booklets, 8-1/2x11. If "Contents 2"
contained 11x17 signatures, those signatures would each contribute four pages.
Increase the signature size to 17x22, and the page contribution for Contents 2
becomes eight (shown as 8P below). Morning Flight will maintain the press-run count
for those signatures at 1,000. Had they been entered as a 2-up insert, the program
would have reduced the press-run count to 500. At 2-up, that would still have given us
1,000 inserts.

v 4P-01 A B0 |b Commadity Dffzet, white
v 8P.0424: B0 Ib Commodity Offzet, White

[v  4P-1215 Inzert, B5 Ib Uncoated Cover, 'White

¢ In the quote window, click F4.

¢ First check a box next to a white bullet, then click the adjacent button.
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¢ Enter the configuration for the insert. A large postcard will do.

¢ Click OK to accept the book contents window.

Tosumup ...

No matter how many up you run them, covers and inserts will always maintain the
same page count: Four pages for saddlestitched and perfect bound booklets, two
pages for everything else. Yet regardless of how the booklet is bound, signatures that
are run more than 1-up will contribute more pages, effectively raising the page count
for the entire booklet.

Oh, Phooey!
ErantCoies - 2P-D44M3 B5 Ib Uncoat 5
Back Caover - 2P-01/1> 65 Ib Uncoat -5

Contents 2P B0 b Common -5

B0 Ib Common

What do you get when you change the binding of your booklet after you've assembled
the contents? That depends. If you're converting a wirebound booklet to spiralbinding
or GBC, the original contents stay the same. The only thing that changes is the cost
for putting it together. But go from a wirebound to a saddlestitched booklet, and you'll
find yourself with a bucketful of ominous red bullets. Here is where Morning Flight's
automation pays off in a big way.

Say you've quoted a wirebound 8-1/2x11 booklet and the customer now asks you to
requote the same booklet, perfectbound.

e Open the wirebound quote for editing (see Changing a Quote).
¢ Click F3. Select Perfectbound, with 1/8" trim on 3 sides. Click OK.

¢ Back in the quote window, click F4.
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81/2 %171, 148" trim 3

v [14/1 4P - B5 |b Uncoated Cover, ‘white

Contents 1 v  [11/1 4P - B0 Ib Commadity Dffzet, White
Contents 2 v D4/4 8F - G0 Ib Commodity Offset, White
Contents 3 [v 1/1 4P Insert - BS Ib Uncoated Cover, White

o Z0

More red flags, but here's the good news. Morning Flight has already removed the
back cover. For perfect binding, we need a one-piece wraparound. It has also tagged
all invalid content (the buttons glowing in red). To make the process completely
painless, the program has gone one step further: All offending pages have been pre-
converted in the background, ready for you to accept as is, or modify as you see fit.

When you click the "Cover" button, you'll note that the size has increased from 8-
1/2x11 to 11-1/4x17-5/8, to include trim and spine. What's more, the 8-1/2x11 cut-
size paper was replaced with a 23x35 sheet. All that's left for you to do is click OK.

Did I mention Morning Flight takes care of the heavy lifting? | should have mentioned
that.

© 2018 Helmut Heindel



128 Morning Flight Gold

Hyland Air Service

Froduct Cover 5

11174 4 17.5/8 Lz ]e ] 227 60

Faper 65 Ib Uncoated Cover

73 x 35, White s ]le ] 125.00

Bla n::_l=:. inh:. an front

(n]g]

Printing

gL Bl

e

5.13 Quoting Custom Booklets

This topic describes how to quote a custom booklet. Booklets are never exactly alike,
and in that sense, all can be called custom. In this chapter, the custom aspect relates
to the type of binding, a type you had to create yourself because you couldn't
shoehorn it into one of the pre-defined categories. Perfect examples: Adhesive tape
binding and padding of non-standard carbonless sets (covered in detail under Quoting
Custom Carbonless).

Colate | Saddesttch | Perfecthind Staple GBC/Coil/wire by Bind

Custom Binding Setup perBook  Minimum
Size Limits

v Custom Binding | 10o0] ooo]

Price includes [ Caollating

W Custom Padding | smf oo

Price includes [+ Collating
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Enabling Custom Binding

i

¢ In My Shop, click the Bookbinding button.

From the main menu, click the My Shop button.

¢ Click the My Bind tab.

e Check Custom Binding and enter the binding price per book. Setup and
minimum cost are optional.

e Check Custom Padding and enter the padding price per set. If that price
includes collating, don't forget to check the Collating box.

Quoting Custom Binding

From the main menu, click the Booklet Quote button.

¢ Click the F3 button, then select either Custom-bound, Custom-padded or
Unbound.

%\ bt

Trimming is available for saddlestitched and perfect bound booklets only.

Custom-bound

312017, Mo trim

(" Saddlestitched T —
" Perfectbound g '|3' VB 15 14 12
" Comerstapled Ao
" GEC-bound
" Spiralbound & Ma i
[ wirebound
Lizkom-bound

Custom-padded
" Unbound
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Unbound Booklets? How does that work?

Just when we thought we had included everything that could possibly be managed
within the confines of a booklet, along comes one more variant: Unbound booklets.
I'm serious! Read on.

Say you need to quote an assortment of items that may or may not be printed on the
same type of paper, some produced by offset, some digitally, with shared ink colors.
Just your average bottom-of-the-pile estimating project. With Morning Flight, it couldn't
be simpler. Pretend it's a booklet, unbound, and let the booklet module consolidate
everything: Paper, ink, setup charges. If you need to slide in the odd piece that
wouldn't normally qualify as a bookpage, include it as an insert.

The pricing model is the same as the one used for spiral/wire/GBC, minus collating
and binding. Just don't tell your customers it's a booklet!

Empire Builders

Product Upton Square Project, 10 pages
Binding Unbound
Mo trim

Front Cover
Back Covver

Contents &8 2FP-141: B0 Ib Commadil -*—P—

Kepword [

= B 1.312.90 1.553.90 1.790.50
~l B 4,

Ink and setup charges are minor players in the copy and digital arena, but for offset,
consolidation is kind of a big thing. Then there's the paper, regardless of the type of
printing. Take a look at the example. Five different data sheets, 4,000 copies each.
The booklet module automatically consolidates that into 20,000 sheets priced at the
four-carton level, not five times 4,000 sheets at the price you would pay for a broken
carton.

No question, when you look at the price difference, it is a big thing!

© 2018 Helmut Heindel



Making Quotes 131

4,000 u

Upton Square Project, 10 pages 1312 90
% 11, Unbound —

Design
Run

Proofs

10.00
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5.14 Quoting Carbonless

Just as e-mail has cut down on fax transmissions, forms software has taken a big
bite out of carbonless. Why preprint a form when the computer can generate the form
while it's entering its contents. Still, fewer carbonless forms being used is far from no
carbonless forms being used, so Morning Flight lets you quote both precollated and
(in the Express, Silver, Gold, and Pixelblitz editions) custom-collated sets.

@PM

M amne Size
v’ Carbonless Forms B2 w8142 | 2-part
v Carbonless Forms 51208142 | 3-part
v Carbonless Forms B1/208142 | d-part
v Carbonless Forms B1/2081/42 | B-part
v Carbonless Forms B1/2081/42 | B-part
w' Carbonless Forms 312011 2-part
v Carbonlessz Forms 2142011 J-part
v’ Carbonless Forms 2142611 4-part
v Carbonless Forms 312011 B-part
v Carbonless Forms 312011 B-part

i CNE

Precollated Sets

e Click the F2 button.

¢ In the black panel, click Carbonless.

¢ Double-click Carbonless Forms, 8-1/2x11, 3-part.

From the main menu, click the Quote button.

Category

{Hiset Sheels
Ofizat Cardsd afel
{Hizat FEmvelopes

foamies

Lreaital
Hide Format
Al
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Product 3-P Carbonless Forms
81 ."lz " 11, E'Dalt Em 1334['
Faper Carbonless Set
81/2 w11, White/Yellow/Fink Lralle ] 248,80

Printing Black ink an front
e A,

L e T L SN T

=

%\Mutﬁ:

Morning Flight has automatically selected in-stock carbonless paper to match.
To change the color sequence (for this quote only), continue with the steps
below. If you normally buy precollated sets in a different color sequence, go to
My Store > My in-Stock Paper and change the sequence there.

¢ Click the button to the right of the F3 button, or hold down the Ctrl-Key and
press F3.

e Click the Colors button.

¢ Click the third radio button, then click Blue in the list on the left. That will change
the bottom sheet in the carbonless set from pink to blue.

White " ellov/Elue

1 White
L2 Mellow
Blue

Bl
Green “
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%\Mutﬁ:

When you're changing the color sequence, you're switching from in-stock paper
to custom paper and that will almost certainly change the price. What's more,
the paper may not come precollated in the color sequence your customer has
asked for.

5.15 Quoting Custom Carbonless

They're not booklets, technically, but custom carbonless forms fit the booklet mold
like a glove. See for yourself. We have a front cover (coated on the back), a back
cover (coated on the front), and one or more inside sheets (coated front and back). All
glued together on one side. Call that what you will. From where I'm sitting, | see a
booklet masquerading as a business form.

Colate | Saddestich | Perfectbind | Staple GEC/Coilwire My Bind

Custom Binding Setup per Book  Minimum
Size Limitz

¥ Custom Binding | 1000 oz

Price includes [ Caollating

W Custom Padding | soof oosof

Price includes [v Collating

Enabling Custom Padding

..@l* From the main menu, click the My Shop button.

¢ In My Shop, click the Bookbinding button.
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¢ Click the My Bind tab, then check Custom Padding and enter the padding

price per set. If that price includes collating, don't forget to check the Collating

box.

Quoting Custom Padding

' From the main menu, click the Booklet Quote button.
e Click the F2 button, then enter the Nam e of the form.

e Click the Book Size button and enter the size.

[rvoice Forms
1,000 n -

Composgition
Revizions
Scans
Froofs

My Prepress

Fostpress

Fackaging

Price

z:0

¢ In the booklet quote window, click the F3 button, then select Custom-padded.

" wirebound
" Custom-baund

" Unbound
LY e gl f
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Assembling the Contents

¢ In the booklet quote window, click the F4 button.

e Check Front Cover, then click the button to the right of it and enter the top sheet
(CB).

e Check Back Cover, and enter the bottom sheet (CF).

e Check Contents, then enter the sheets that make up the rest of the set (CFB).

Front Cove 2P-01 40> 20 |b Carbonless Sheets, CB “Wwhite

Back Cove 2P-0140x 20 |b Carbonless Sheets, CF Pinlk

2F-01 /0> 20 |b Carbonless Sheets, CFE Canar

Contents 3

%\ bk

If you follow the arrow, what do you see? ... No insert boxes! That's because all
custom-padded covers and contents are considered inserts. In Morning Flight
booklet parlance, what makes inserts different is that a 5-1/2x8-1/2 business
form printed on an 8-1/2x11 press sheet will be treated as the same form two-
up, not two separate forms coming out of the same sheet. In a carbonless set,
you rarely find two or more sheets of the same color and coating. That makes it
pointless to run different CFB parts on the same press sheet.
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Adding a Backer

Depending on the thickness of the backer, select either a sheet or a card/label
product if you're printing it by offset, a copy or digital product if not. Why the distinction
for offset? The offset sheet category will only accept writing and text paper, the card
category only cover/index/bristol. Copy and digital products are less discriminating.

You can use any paper that's appropriate for the product. Doesn't matter whether that
paper has a carbonless coating or not. Custom-padded sets are considered booklets,
so pretty much anything goes.

Hame Size Offzet Sheets
Book Cover AR Copis
Mailers 81/2 111 il
M ailers 1241 2-up

5.16 Quoting x-Up

When Morning Flight calculates a 5-1/2x8-1/2" business form 2-up, it assumes you'll
be using a single original. In other words, the same form imaged twice on the same
plate to double the yield. The press doesn't care whether the two images are different
- makeready and run costs will be the same either way. Ditto for postpress. It's
prepress where costs may differ, depending on how the film is generated.

Imagesetter

Film either outsourced or produced on an in-house imagesetter is commonly done full
size. That makes the number of originals irrelevant. It doesn't matter whether you run

the same form 2-up, or two different forms side by side. Morning Flight will charge for

a full 9x12" film unit in either case.
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Filrr Ll it 14.00
Stippinig F.a0
9.00
0.35
Fun
Eazy

Shrinkwrap .60

1

Camera

Here, things get murky. Most shops still using a camera will either cut the film in half
before shooting an undersized original, or shoot two small jobs together and cut the
film apart when it's dry. To price that 5-1/2x8-1/2" business form, the program will cut
the 9x12" film in half and assume you'll step-and-repeat the image to get 2-up on the
plate.
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Filrr Ll it
Stippinig

Fun
Eazy

Shirinkwrap

%\ FJote:

Morning Flight calculates how many press sheets can be cut from the paper size,
and how many product sheets fit on the press sheet. It does so independent of grain.
If grain matters, it can be specified for both sheets. What if you want to override
(reduce) the number of "ups" for the product? Say you want to print eight 3 x 4" two-
sided cards on a 9 x 12 press sheet, work and turn. The program says 9-up which
leaves out work and turn. The solution? Leave the paper size at 9 x 12 but reduce the
press sheet to 8 x 12.

5.17 Quoting Work and Turn

Work and turn is a way to reduce plate and setup costs for two-sided, x-up printing.
The technique is for offset only - copies and digital have no use for it. Even with offset,
work and turn can't be preset ahead of time, as part of the product. You need to work
up a quote or job order before you can flip the switch. The reason is simple. Not until
you've entered the run configuration does the program know whether the job is two-
sided.
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Seeing that W/T is missing from standard offset products, you'll have to start your
guote with a custom version. Highlight the base product that will serve as a template.
Then either click the custom product button pointed to by the arrow, or press Ctrl-F2
instead of F2. But first (there's always a but first), make sure you've selected two-
sided printing (F4).

Praduct

Bulletins
8142 %17 [2-up] E] 124 6D

FPaper

60 Ib Commodity Offset

11% 17, White ez ]le ] 24.35

Printing

“r-iwm Tl - g,

In the custom product window, select a press sheet large enough for two-up. If the
base product allows for work and turn, the program will at that point automatically
switch to W/T. If the base product does not (letterheads, to name one, because of
watermark issues), the custom version of it would still allow W/T, but the program
won't automatically switch to it. In that case, toggle W/T by either left-clicking where
the hand is showing, or by clicking the properties button and then checking the W/T

box.
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Bulleting

Costom Phrodtuc?™

Difzet | Copy | Digital |

Fuilti : Wwe charge
[printed 2 Sidesz)

Prepress
Ik,

M akeready
Run
Cutting
Packaging

Price

OE Z0

%\ Fote:

Just so you know, there's no price difference between a standard product and its
custom sibling until the custom version has actually been customized. As long as the
properties of the two stay the same, so do their prices.
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5.18 Adding Ink Colors

This topic describes how to change the run configuration and add ink colors for offset.
With digital and copies, the choice of black versus color is built into the product.

ACME Automotive

Prioduct Ie_ﬁt,-'l;::hﬁlads E
ik g# a"l2h r:qll'laf .t'-‘s«:ft;r:_ Eiill:lliant “white E
Frinting Black + 1 Color on front
Ink. Colors [
Frepress
Postpress
Fewword [

RS Z0

Step by Step

From the main menu, click the Quote button.

91.20

37.70

30.00

158.90

¢ Click the F4 button, then select Black plus Color.

(A

202.80 374.80
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" Black Only
i+ EBlack plus Calar

£ Colar Only
I AC Process
" Ma Printing

[ Cloze Register
=

PRI

¢ To make the run configuration on the back identical to the front, click the button
in the black panel (the one pointed to by the arrow). Although front and back
configurations will now be the same, the ink colors for the two sides can still be
different.

If the button is missing, it means the product prohibits printing on both sides.
Letterheads are a good example. The work-around is to make a new letterhead
product named "Letterheads-2S," then, under properties, allow 2-sided printing.

. To change the entry screen from front to back, click the Front/Back button
in the black panel, or click the radio button where it says Front/Back.

e To increase or decrease the number of ink colors, click the up and down
arrows.
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¢ What happens when you click OK will depend on whether you're making a new
guote and have yet to select ink colors, or have selected them but now want to
change them. If no colors have been selected, the ink entry window will appear
automatically. If you're editing, it probably won't, but you can make it appear by
clicking the F5 button in the quote window. | say probably, because the window
will appear automatically even during editing if you've changed the run
configuration and now there are too few ink colors.

Chrarme 't ellow

e To enter a color, enter the PMS number (or HKS or FCS number depending on

the color system you have in place), or click one of the silver buttons to pick the
color from an ink selection window.

e To delete a color, place the cursor in the entry field for that color, then click the
Trash Can.

¢ To change the Color System for individual colors from PMS to HKS or FCS,
click where the hand is showing.
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%\ P ote:

The Min number tells you how many colors you need. The Max number
represents how many colors you can have. In this example, the quote could be for
either black + one color, or just a one-color run, printed both sides.

5.19 Adding Prepress

This topic describes how to add prepress charges to offset, digital, and copy quotes

and orders.
/fc? - Ny .
Tepreds L 7
Compositian | .Eruofs . |

Howrs:Minutes

Campasition Composition || 2 || 15 | Composition

Carp Factar

Heawy

a=h" Budt o B0t
T anE 1 " 1 || |
EI:III:I[ ans " || |

Step by Step

¢ In the print quote window, click the F6 button.

e Check Composition, then set the Comp Factor to heavy with the slider. Left-
clicking moves the slider up, right-clicking moves it down.

e Enter 30 in the Minutes field to override the default of 15.
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e Enter one 3x5" and one 5x7" black and white scan. The quick way to do that is
to enter "110" in the Jet-Entry field (1 x 3x5, 1 x 5x7, and 0 x 8x10).

¢ Click the Proofs tab, then click Colorcopy. If colorcopy proofs are unavailable,
it means the job is printed in black ink.

Compaogitian Proofz

M ake Proofs " Lasercopy Campaositian 135.00

f+ Colorcopy

 atchprint

%\ Fiote:

Colorcopy and matchprint proofs are available only if checked in My Shop, and
then only for color printing. For black, lasercopies are the only option. Proofs are
not available for copies, where they're rarely called for.

Zooming in

Prepress

Postpress

To double-check your entries, click the Prepress row in the gray panel when the
cursor turns into a camera.
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5.20 Adding Prepress to Booklets

This topic describes how to add prepress to booklets. Prepress charges are for the
whole booklet, not for individual pages.

First Flight Biooklet
1.000 N .. =

Composzitian
Revizgions
Scans
Froofs

by Prepress

Postpress

Packaging

Price

z:0

N
From the main menu, click the Booklet Quote button.

¢ Click the F2 button, then click the Prepress Button.
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pw f:-“* g
A, ]

LComposition | by Prepress |

Carmn oy Composition Compogition

Scans

¥ Proofs
i B

| 5]

|| || Price

Rk Z

My Prepress

e Enter combined prepress charges for the entire booklet. Prepress is unavailable
on individual bookpage entry forms.

%\ kot

Composition can be entered in either hours and minutes, or in the amount you
want to charge. In the first method, Morning flight will calculate the price. In the
second, the time. Scans are entered the usual way, but for booklets you can
enter a combined total different from what the program has calculated. When
you do, Morning Flight alerts you with a yellow bullet. Clicking the bullet will undo
special pricing.
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5.21 Adding Custom Prepress

This topic describes how to add custom prepress charges to offset, digital, and copy

quotes.
7> o
w =
A T
Composition | Proafs My Prepress

My Prep 1 '_. 2 | File Conversion Composgition 135.00

tdy Prep 3
Scans
Proafs
by Prepress

Price

Rk Z0

Step by Step

From the main menu, click the Quote Printing button.

e Click the F6 button.

¢ Click the My Prepress tab, then check My Prep 1.
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W;z PW

Mame Setup Price kinirLim

{ File Copvversion Rl

z:[1

¢ Double-click the custom prepress item you would like to add to your quote.

e Back in the prepress entry window, enter 2 in the quantity box pointed to by the
arrow.

e Click OK.

%\ Fiote:

If the My Prepress window comes up empty, you can add a custom
prepress item on the spot by clicking the add button. Any custom prepress item
you create for this quote will be available for future quotes and orders as well.

5.22 Adding Postpress

This topic describes how to add postpress charges to offset, digital, and copy quotes
and orders.

© 2018 Helmut Heindel



Making Quotes 151

ST,
Postpecs
| Laminate/MNumber/Fad Stamp

Cut/Dill Fold | Perf/Score

Wuanity Cutting
[ Jlofous Folding
I

. Seanng
500 7 Single

FPadding
f* Letterfold My Past

" Crozsfold Cther

Price

R ZN

Step by Step

From the main menu, click the Quote button.
¢ Click the Quantities button or press F12.

e Enter 1,000, 2,500, and 5,000, then click OK.

o Left-click the first of the three quantity columns. That will make 1,000 the quantity
for which prices are displayed in the postpress entry window.

1I]5

ETIRE S S e e

e Click the F7 button.
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r& Select Fold, then change the fold quantity to 500. You'll see the key turn red.
That tells us that we have a Locked Quantity. The customer wants only 500
sheets folded, the rest delivered flat.

¢ Click the Perf/Score tab, then select Straight. If scoring is unavailable, it means
we're printing on too thin a paper, less than cover-weight.

LCut/Trill/Fald Pert/Score | Laminate/Mumber/FPad | Stamp

Cluartity Cutting

Perfarate 1.000 @t[aight Folding

" Right-angle Perfing
Scoring

Fadding
My Post
Other

Price

¢ Click the Laminate/Number/Pad tab, then check Pad. We'll stay with the
default of 20 pads, 50 sheets per pad, set for the 1,000 quantity.

LCut/Drill/Fold | Perf/Score Laminate/Mumber/Pad | Stamp

Buantity Cutting
L [ ] Folding
Mumber [ ] Peifing
Pad per Pad gz;::ll?ngg

My Pogt
Other

Price

R rote:

Because we added padding, we can no longer have folding, that's now gone
from the price display. Morning Flight knows you can't pad and fold at the same
time. The program's automation, for the most part, does its work quietly and

behind the scenes. This is one of the fewtimes where it operates out in the
open.
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e Click the Stamp tab. Select Foilstamp and new 4x5" Die, then click OK.

Cut/Drill/Fold || Pert/Score | Laminate/Number/Pad Stamp

(uantity Tt
utting
Stamp 1,000 ®0ilstamp Folding
" Embosz Perfing
Scoring

Padding
Size  2u3" ty Post

Other

Price

%\ ko ote:

If the checkbox for a new die is unavailable, it means the job is being reprinted
without changes.

Zooming in

Prepresz

Postpress

In the quote window, click the Postpress row in the gray panel to double-check

your entries. If an icon is shown in red, the quantity for that operation is locked.
Here, only part of the run is being folded.

5.23 Adding Postpress to Booklets

This topic describes how to add postpress to booklets. Postpress for booklets differs
from prepress in that you can charge for postpress on two levels:

¢ For the booklet as a whole. Drilling and round cornering a saddlestitched

booklet, for instance. Book-level postpress is limited to user-defined My
Postpress'items.
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1,000 N

Compozition
Revizsions
Scans
Proofs

by Prepress

Postpress

Packaging

Cartor Price

Mz

¢ For individual bookpages. Foil-stamping the cover would be one example. You
add page-level postpress as you define each bookpage (click F7).

Fostpresz
F.eymaord
S il PV L

Step by Step

N
From the main menu, click the Booklet Quote button.
¢ Click the F2 button

¢ In the book window that opens, click the Postpress Button.
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[Juantity
a00 B ooklet 1-Hole Drilling

e Check My Post 1.

M amne Setup Price kinirum
i Booklet 1-Hole Dinlling 5,00 0,00
B ooklet Found Comerning 10.00 B5.00

P BBt N it b

e Select an item you have created earlier, or make a new one.
e Enter 500 in the quantity box.
%\Nﬂtﬁ:

Whenever you enter a partial quantity, the key button will light up. Clicking the
button will restore the full quantity.
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5.24 Adding Custom Postpress

This topic describes how to add custom postpress charges to offset, digital, and copy

quotes.
i
A
Cut/Drill/Fold Perf/Score | Laminate/MNumber/Fad Stamp My Pastpress

Cutti
My Past 1 per Set Folding

Shrinkwirap in Sets Perfing

- Scoring

My Post 2 Padding
ky Pozt

Py Post 3 Other

Price

Step by Step

e In the print quote window, click the F7 button.
¢ Click the My Postpress tab, then check My Post 1.

¢ Double-click the custom postpress item you want to add to your quote.

¢ Click OK.
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’/’7757 Pm&ﬁ«zw

M ame Setup Price kdinimm

! Shrnkwran in 5etz (1.0

z:[1

%\ F ke

BB it the postpress selection window comes up empty, you can add a custom
postpress item on the spot by clicking the add button. Any custom postpress item

you create here will be available for future quotes and orders as well.

5.25 Adding a Note or Keyword

This topic describes how to add a note or a keyword to offset, digital, and copy
guotes. Notes and keywords are both printed on price sheets, but only the keyword is
printed on quote sheets. Keywords make it easier for your customer to identify a
guote, and for you to find it. Much easier, in fact, if you've submitted scores of quotes
to the same customer.

A time-saver best discovered beforehand.

© 2018 Helmut Heindel



158 Morning Flight Gold

Digital, D441

Garden Tools

Cuztomer plans o supply all photos in
digital form. *hen we discuzsed the
quiote with andy, he agreed that there
would be an extra charge if we need to
maripulate the files or zcan the photos.

Mz

From the main menu, click the Quote button.

e Click the F8 button.

e Enter a Keyword and/or Notes, then click OK.
%\Nﬂtﬁ:

Notes are for internal use only. If you want to include a note to the customer, AND
you're not giving the customer a courtesy discount (or making up for gratuitous
aggravation with a surcharge), there's no reason why you can't send out a price
sheet. The only difference between quote sheets and price sheets is that quote
sheets reflect discounts and surcharges.
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Custarner

Price Sheet

1209-00006

ALCME Supplies
55 Main Street
Chicage, IL 43735

Fhone: 555-3723
1,000

1,500

Gamen Tools

2,000

FProduct

Digital, D4/

8102 11

Crigital 4+Calor an front
Crigital 1-Colaran back
G0 Ib Commodity Offset
rhite

TOTAL PRICE fzEs5.2C0

F414.70

$544 BC

Motes: Customer plans to supply all photos in digital form. When we discussed the quote
with Andy, he agreed that there would be an extra charge if we need to manipulate the

files orzcan the photos.

5.26 Changing a Quote

vt e peamen s gettete e L asenin g g e s

This topic describes how to find and edit a quote. If you know its ID nhumber, you can
import and edit the quote right from within the print quote window. Select Quote Price
> Quote Printing, then click the Rolodex button at the bottom of the quote window.

That probably won't happen often. You normally have to search for the quote before
you can edit it. In that case, select Quote Price > Edit Quote to open the price sheet
selection window.
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Morning Flight - Passport Edition

uote Price

Wiew  Print  Window  Help

¥ Quote Printing |
E Quate Printing with Jet-Entry r E M @ n

Edit Qunote
Brawse Quotes [

RS TSI SRR S S U S pue

Prcestreels

1D Custorner Praduct Progrezs Report
1106-00006 | Empire Builders Card/Label
1106-00005 | ACME Supplies Copy
T106-00003 | Precizion Automotive Drigital
1106-00002 | ACME Supplies Sheet
1106000071 | ACME Supplies Sheet

(luantiby

[ate

.t L =
M

600 E

The Update button does what you would expect it to do, it opens the Edit Print

Quote window.

The Paperclip button is unique to this window. It copies the highlighted price

sheet to the Windows clipboard. When you open the New Print Quote window and
there is a price sheet in the clipboard, an identical button there will let you paste in a
copy. Not for editing, but as a template from which to make another quote.

]
To search for a quote for a specific customer, place the highlight bar over that

customer in the price sheet selection window, then click the Find button.
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Wrong customer? Click the Rolodex button in the upper right corner of the quote
search window.

Too many quotes to look through for the same customer? Click on a specific
Product Category to narrow the search to that category.

ﬁ

Date Product Kewword ACME Supplies
I,
i
1116/2006 | Copy Ealallug Sheets
11/15/2006 | Sheet Garden Tools 81425 M
11152008 | Sheet B0 Ib Commaodity Offset
F e r

1.000 353.50

3 |

'ﬁ i Ma .a _f

. . 1

E

1 e (" Starts with: f
1 \“k * Cortains

— i

4

i

=

R R PR e SR R L

7 z:[1

The quote search window comes with its own Find button, one that let's you search
for a Keyword. If you write more than a few quotes a week for the same customer,
keywords are a powerful search tool. To add a keyword or a comment to a quote,
press the F8 button in the quote window.

W rote:

Neither the paperclip button nor the Rolodex button are available when we
change a quote. The paperclip button pastes a copy of another quote from the
Windows clipboard, but that's for making new quotes only. The Rolodex button
would import a quote for editing. Except, we're already editing!
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Prepresz

Postpress

Kepmword [ Garden Tools @

5.27 Viewing Quotes

When is a price sheet not a price sheet? When the title says it's a quote sheet. The
two may look the same, but there the similarity ends.

Price sheets are designed for internal use, quote sheets can be mailed or faxed to the
customer. Price sheets (and time sheets) always show the actual prices calculated
by Morning Flight. Quote sheets reflect discounts or surcharges that some
customers may have earned themselves along the way. Finally, price sheets can

come with internal notes, quote sheets always exclude them. So, yes, there are
significant differences.

Morning Flight - Passport Edition
Windesl  Help

2 s
DRI AYE O

Conkacks

File Cuote Price

Vendors

L T R R R G Yl e g S
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FRrcestreeZs

D Cuztomer Product
1309-00714C The Pretzel Shop Bookpage
0303-0012C The Pretzel Shop Bookpage
1303-00026 The Pretzel Shop Bonk,
1303-0007 k4 Precigion Automative | Merchandize
0303-000711 The Pretzel Shop Sheet
909-00010 ACME Supplies Sheet

{0H03-00009 ACME Supplies Digital
903-00003 ACME Supplies Sheet
0303-00007F E mpire Builders Sheet
1303-0004C Empire Builderz Bookpage
0303-00018 E mpire Builders B ook
0303-000071 E mpire Builders Sheet

(Juantity

500

163

In the quote view window above you get a mini-zoom version of the quote without ever

having to leave the window. The product description, paper name, ink colors, and all

three guantities and prices are always in full view in the black panel. The display

updates as you browse. For an even closer look,

¢ Click the Camera button to open a full zoom window for the highlighted quote.

e Make sure Preview Printing is ON in My World > My Preferences. Click the

Print button to see what the printed Price Sheet would look like, then close the

preview window without actually printing the sheet.

e Swipe the cursor over the black panel. When it turns into a clock, click to see a

preview of a printed Time Sheet.
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Product

ACME Supplies 1.000 1.500 2.000

Catalog Sheets
8172017 [2up. WiT) 319.60

Faper

60 Ib Commodity Offset
11 %17, White 33.90

Printing

Ink, Colors

Frepiezs

Postpreszs

[

Fewwmord [ Garden Tools

Zooming in

E m 353.50 389.45 430.40

Paper [ 60 Ib Commodity Offzet g2~

(]

11 %17, White

Whenever you see the cursor turn into a Camera, as it does here in the paper
panel of the full zoom window, click to drill down for a closer look. Once there,
click the up arrow to view all three quantities.
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Full C

3 Cartons

60 Ib Commodity OFffzet
11 =17, White

1.000

100

F

Print Preview

165

1o00 M

b edium
Type

Custarner

Price Sheet

1209-00005

ACME Supplies
55 Main Street
Chicago, IL 43735

Fhone: 555-3728
1,000

Gamer Jools

1,500 2,000

Product

Digital, D41

B-102 = 11

Cigital +Colar on front
Crigital 1-Colar on back
G0 Ib Commuodity Offset
hite

TOTAL PRICE $285.2C

$414.70 $544 60

Motes: Customer plans to supply all photos in digital form. When we discussed the quote
with Andy, he agreed that there would be an extra charge if we nead to manipulate the

files arscan the photos.

- S g, \-M"""’\x-—ﬂ“ﬂ-‘.ﬁv“-n"“- Y

© 2018 Helmut Heindel




166 Morning Flight Gold

Catalog Sheets

1A

Cluantity
1 000 n

d
den Tools

Time Sheets, by
their very nature,
are for internal use
only. For a print
preview, swipe the
cursor over the
black panel. Click
when it turns into a
clock.

5.28 Printing Quotes

Ly oo 'FLU-E._ PSR ST \.mls“cu-?dﬁ*-m

4
. L
Time Sheet 4
0903-00008 J
Custorner ACME Supplies "
55 Main Street *
Chizage, IL 43725 "
»
¥
4
[
Product Catalog Sheets, 8-102 x 11 .
Calar an frant '
Bladk ink on badk
Z-upoon T = A7 WWT 1,000 150[#
Funtime (4Colar GTO) 17 Minutes 26 Minute: t'__
3,500 IPH 3,800 IPF W
Film Units
Imposition 15 Minutes 11.2E 11.2£
Flates CTF S5.0C s5.0C
Ink 2.480 330 4
hl akieready 56 Minute: 163,32 163,32

25

| recall a memorable episode of the television series M.A.S.H., where Hawkeye and
B.J. were instructed by radio how to defuse a bomb. Step four, I think, is when they
were told to cut the red wire. After a tense 30 seconds, step five began with "but first

..."" Luckily, the bomb turned out to be harmless, filled only with propaganda flyers.

Viewing quotes and printing them go hand in hand. If you're unclear about price
sheets, time sheets, and quote sheets - what they are and how they're meant to be
used - the previous topic of Viewing Quotes would be a really good "but first" place

to go visit.
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Morning Flight Gold

File Log-in Quoke Price  ‘Wrike Estimate  Enter Order  Inwoice  View Nl

= , n oy N Price Sheek
GrEE @327 BE -

Job Sheet
Job Ticket

Window  Help

-—-.p-‘ *"-“"4‘*“ -.-—. H—o—-—b’-r"“ “-‘_“WQ _‘-L,...__""

Crotestrecs

1D Cuztomer Product

i (20700004 Empire Builders Sheet
Q207-00003 ACME Supplies Copy
0207-00002 |és Precizsion Automnaotive Card/Label
0207-00007 |#s ACME Supplies Diigital
0107-00001 | &5 ACME Supplies Ervelope

[luantity

1.000 u

=19
e \ i

The quote print window opens with the most recently entered quotes pre-selected.
These could be price sheets, time sheets, or quote sheets, depending on which type
you selected in the pull-down menu. A printer icon in front of the customer's name
shows the quote was printed at least once before.

¢ Click the Camera button for a print preview of the highlighted quote.
¢ Click a quote to include it in the to-be-printed list. Click again to exclude it.

¢ Click the Print button to print the checked quotes all at once.

%\ FJote:

Because clicking an item will select or de-select it, use the up and down keys to
highlight a quote before you use the camera button to previewit.
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Morning Flight Gold

ﬁ
;D- {2

1D Cuztomer

Product

v [207-00004 Empire Builders Sheet

v’ 0207-00003 ACKME Supplies Copy
0207-00002 | Precision Autormative Card/Label
0207-00001 | s ACME Supplies Digital
DO07-00001 |és ACME Supplies Ervelope

2 Pricesheets

far
Wariouzs Customers

e L ol g i

2

tlu....._ R P AT R
=

b B s el i

Cuantity

1.000 E
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Custarner

Price Sheet

1209-00005

ACME Supplies
55 Main Street
Chicago, IL 43735

Fhone: 555-3728
1,000

1,500

Gamer Jools

2,000

Product

Digital, D41

B-102 = 11

Cigital +Colar on front
Crigital 1-Colar on back
G0 Ib Commuodity Offset
hite

5.29

We need ID numbers to separate quotes, so why not get extra mileage out of the

TOTAL PRICE $285.2C

F414.70

$544 BC

Motes: Customer plans to supply all photos in digital form. When we discussed the quote
with Andy, he agreed that there would be an extra charge if we nead to manipulate the

files arscan the photos.

Identifying Quotes

" . N TSRS \M_w,__‘_--tx__"..r\x*'_ﬂ_"‘nﬁﬁ"’_*_‘" J#xﬁ_\_’_“

digits ... have them tell us something instead of just acting sequential. The number
1106-00003 in the window below says this was the third quote issued in November of
2006 (11/06). Number 0107-00001 would be the first quote written in January of 2007.

Couldn't be more simple.
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Morning Flight Gold

Porcestreels

I} Cuztamer Product
1106-00006 | Empire Builders Card/Label 20 |b Copy Bond
1106-00005 | ACME Supplies Copy
1108-00003 | Precizsion Automotive Digital
1106-00002 | ACME Supplies Sheet
1106-00001 | ACME Supplies Shest

Cuantity

B00 E

Date

11410

[ ERE O

Merchandise and Booklets

What do the letters M, B, and C stand for? Merchandise, booklets, and booklet
contents. In the example below, 0909-0002B is a booklet for the Pretzel Shop. 0909-
0012C and 0909-0014C are its cover and contents.

10 Custamer Product

.
E090%00140 | N The Pretzel Shop Bookpane
The Pretzel Shop Bookpage
The Pretzel Shop Book

Precizion Automative | Merchandize

o a2 Pretzel Shopgs, loheet | sgvmmse, 4
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6 Making Estimates

6.1 Creating the Estimate

Most computer programs have within them one process so perfectly suited for near
total automation that most any developer will instantly recognize it for what it is: A
silver-platter "wow" maker. In Morning Flight, that process is robotic estimate writing,
easily the most celebrated component of the Silver, Gold, and Pixelblitz editions.

With it, submitting an estimate has become a truly miniscule effort. Not effort, even. |
mean seriously, how much work is it to drop quotes into a shopping cart, then step
back and watch the Estimate Manager consolidate ink and wash-up costs and deliver
a written estimate in the customer's own language, ready to be faxed or e-mailed?

The Sitting-up-in-Bed Part

Let's assume you've worked up some quotes for Empire Builders, for whatever
Morning Flight lets you quote on - offset, digital, copies, booklets, merchandise, wide
format.

Custarnes
« Empire Builders

& 1 Empire Builders £.9/8/2009 | AD-09/03-1007
i ACHE Sup
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Morning Flight Gold

Eﬂ From the main menu, click the Estimator button.

L,
In the black panel, click the Rolodex button, then select the customer.

%\ Fiote:

If the customer is included in the quick-list on the left side of the window, use
that instead. Or, start typing the customer's name into the Jet-Entry box just
above the quick-list. Keep typing until you've narrowed it down to the one you're
looking for.

L
b

(]

Click the Add button.

Customer

| Huotes | Bemarks Options Hiztamy

Er. Tom Bradley
M, Empire Builders

Inquiry Date | 511472003 |EE
Estimate Date | 5/15/2003 I

Beference | June Mailing |

A it & . il i A it

¢ In the window that opens, enter the Inquiry Date and Reference.

¢ Click the Quotes tab. Left-click the quotes you want to include in the estimate.
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Cotinale

Customer Quotes Femarks Options Histary

E dit

Er. Tom Bradley
M,* Empire Builders List Price Met

v’ 050900007 | Mewsleters
w' [503-00008 | Envelopes
0509-00009 | Offzet Copies

If you're not happy with the sequence in which the quotes are listed in the estimate, click
the sort button. Select the quote, then click the up or down button to reposition it.

Sort Price Sheets

f0R09-00007 | Mewsletters

0R05-00008 | Ervelopes

¢ Click the Options tab. Configure the estimate by checking the appropriate
boxes.
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Optionz

Customer | Huotes Bemark.s Hiztary

Er. Tom Bradley
M|~ Erpire Builders

[ Show Ink 5 avings
[ Show Merchandise Hours
[ Show full Descrption

[ Show Deli

mdiiinten s aam  apst . Sl M e A st

[ Print on Letterhead

¢ Click OK to save the estimate.

Camera button.

Back in the estimate manager window, highlight the estimate, then click the

Empire Builders

g 3aanng | An-N03.03-1 001 1 Ikem
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The Results

Tom Bradlew SAF2009
Empire Buiders

108 Dlain Jtreet

Ayvracuse, MY 18334

Wour Inguiry June Dlailing, 5714/2009
Oy Daotation HH-0509-0003

Dear Tom:
Thanlk you for your inguiry. "We are pleased to offer as followrs:

0509-00007  MNewsletters 1,200 2.000 3.000
8-12x11 $297 50 341 85 $474.90
Black +1 Colot on front. Ink Colors: PRIS 300, Paper: 60 b Cougar Text,
White. Findshing: Folded.

0509-0000%  Emvelopes, Size 10 2,000 2,500 5,000
4-1/8x9-1/2 $207.20 $227.05 $332.80

Black +1 Color on front. Ink Colors: IS 300, Paper: 24 Ih Wowve, White.

Char estimate includes total ink charges of $40.00. Crdering all items together would save
$20.00. Estitmated delivery time after receipt of order: 5 daws. These prices do not inchade
sales taw and are walid for 30 days. We appreciate wour interest and hope we cat he of
setvice.

6.2 Spelling out Conditions

Conditions, for lack of a better word, are payment terms, estimated delivery, how long
prices are valid - pretty much anything you need to tell the customer beyond the bare
product description and prices. Some conditions are boiler-plate (Morning Flight's
"memo clips"), others you write free-form to fit the estimate. In this chapter, we'll look
at both.
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Empire Builders

.92 842009 | AD-09/09-1007

& 1 Empire B
{i g,
I'_- X = it i s oI, .""“m

Kﬂ From the main menu, click the Estimator button.

If you're creating a new estimate, click the Add button. To change
conditions in an existing estimate, highlight the estimate you want to edit, then click

the Update button.

¢ In the window that opens, click the Remarks tab.

Cotirnale

Cuztomer | Qluotes

Blemarks Options Histary

H=r.
EJE Dear Tom:

Thank, pou for your inguiny. e are pleazed to offer az follows:

IThese prices do nat include sales tax and are valid for 30 days.
Thank, wau far paur inkerest, e loak fanward ta being of service.

Free-Form

Every estimate has an opening message (the first box) and closing remarks (the
second box). The text in the two boxes is automatically imported from defaults in the
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memo clips library. Any changes you make here will not affect the original text in the
library. For instance, to extend the validity of the above estimate from 30 days to 60,
simply double-click "30", type in 60, and click OK. The estimate will say 60, but the
library clip will remain at 30.

Boiler Plate

You can choose to either replace the entire text in each box with another memo clip,
or insert a memo clip into text that's already there. To replace the text, click the button
to the left of the box. In the window that opens, highlight the memo clip and click OK.
The clip you highlighted will replace the text that's in the box.

H=r.
E‘E Dear Tom:

Thank, pou for your inguiry, e are pleazed to offer az follows:

These prices do naot include sales tax and are walid for 30 davs.
"W'e appreciate pour interest and hope we can be of zervice.

To insert a memo clip into text that's already there,

Click the button to the left of the box. In the window that opens, highlight the
text you want to insert, then click the Paper Clip button.

© 2018 Helmut Heindel



178 Morning Flight Gold

Language Mezsage

Z EST | English E stimated delivery time after receipt of arde
Z EST | English In answer to your reguest, we are pleazed
Z EST | English Ordering all iterns together would zave
Z EST | English Our estimate includes total ink. charges of

EST [ Englizh.- Please call or e-mail ys with any questions.:
2 EST | Englizh Thank you for pour inguiry. We are pleazec
Z EST | Englizh These pricesz do not include zales tax and .
2 EST | Englizh These pricesz do not include zales tax and .

il

¢ Back in the estimate window, position the cursor where you want to insert the
text, then press Ctrl-V to paste it from the Windows clipboard.

Thank, pau far pour inguing. We are pleazed o offer as folloves:

i T d are valid for 30 days.
C: Pleaze call or e-mail uz with any questions_F hank, vou for your
In - i EIVICE.

B pptn oS s, . oo i i sfpnionn,

6.3 Adjusting Prices

Whether you're asked to price printing or an airline ticket to Honolulu, the hunt for the
perfect quote always hinges on two numbers: The price at which the seller begins to
make a profit, and the price at which the buyer begins to see value, the customer's
tipping point. Doing business successfully is directly related to how accurately you
can balance the two.

Now, wouldn't it be wonderful if consumers all saw value at the same number? They
don't, of course, or the passenger sitting next to you on that flight to Hawaii would be

© 2018 Helmut Heindel



Making Estimates 179

paying the same fare you do. Airlines have long been at the leading edge of pricing by
value. Ticket costs for each flight are recalculated every 15 minutes, based on how
far ahead of departure the ticket price is quoted, the number of seats still available,
and a myriad other factors. Any seat on any given flight can cost four times as much
as the seat next to it. The flying public knows it and has learned to accept it.

Given that variable pricing works for the airlines, should you now rush out and adopt
their business model? Bad idea, the name Morning Flight notwithstanding. A
Heidelberg or Xerox DocuTech is no Boeing 737. Jumbo-sized price disparities won't
fly with a box of envelopes or letterheads.

So the scale is wrong. That's not to say variable pricing has no place in printing. At a
minimum, it should keep you from leaving money on the table. Think about it. How
smart is it to always quote everyone the same price, regardless of much hand-
holding you have to do, of "Fast Freddie" needing every job yesterday, and "Ms.
Persnickety" throwing a tantrum whenever the ink colors on her monthly flyer don't
perfectly match her faded swatch book? On the flip side, can you afford to not
sharpen your pencil when you've been staring at idle presses all month, a printer's
equivalent of empty seats?

Morning Flight lets you implement variable pricing at two levels. The first is an always-
applied price adjustment (a discount or surcharge) for a specific customer, the
second a one-time adjustment applied to a single estimate. In this chapter, we'll look
at both.

At the Customer Level

- Click the My Store button, then click My Customers.

Click the Update button.

¢ Click the Terms tab and check one of the boxes to reduce or increase prices,
then enter a percentage.
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Morning Flight Gold

Address | Cortact Temns

The Pretzel Shop

Credit Limit

Monme

[+ Reduce Prices

[ Increase Prices

[v Charge Tax

At the Estimate Level

% From the main menu, click the Estimator button.

E Highlight the estimate you want to edit, then click the Update button.

e
o=l

the Pricing button.

-9
na!:‘:"' In the window that opens, click the Quotes tab. Highlight the quote, then click
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Cotinale

Customer HQuotes Bemarlk.z Optians

Er. Joe Baker
MW" The Pretzel Shop List Price Met

w' [803-00008 | Mewsletters
v [1303-00003 | Ervelopes

%\ ko ote:

If you check the list and net prices above, you'll note that the Pretzel Shop's
customary 3% discount has already been applied to every item in the estimate.
You don't have to do anything to simply maintain that discount. However,
should you change your mind and click the blue Pricing button, that 3% will
merely come up as the default, ready for you to adjust up or down.

Making the Price Adjustment

There are two ways you can adjust the final price: Enter a percentage and let the
program come up with the new prices. Or, enter a price and have Morning Flight work
out the percentage. Either way, the same percentage is linked to all three quantities.

There's a reason for that. With a uniform percentage, when you change any of the
three quantities, the program can recalculate the price you normally charge for the
new quantity, factor in the percentage, then re-apply the price adjustment -
automatically. Keeps you from forgetting to raise a fixed, lower than customary price
after increasing the quantity.
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Morning Flight Gold

Envelopes
Charge

28200 274.50
154.80 150.20

130.20 126,30

Beduce Prices
Increase Prices

3+4=77

Are discounts cumulative? In other words, do they get stacked on top of each other?
The answer is no. In the end, there is only one discount or surcharge. Here is how it
works.

When you enter a quote for a customer who normally gets a discount (or has nickel-
and-dimed his way to a surcharge), that discount becomes a permanent part of the
guote. Take the envelopes for the Pretzel Shop. The list price for 1,500 is $130.20,
the discounted price $126.30. If tomorrow you change the Pretzel Shop's terms and
remove the 3% discount, the quote remains at the discounted price of $126.30. It has
to, or else your claim that "prices are valid for 30 days" becomes worthless dribble.

But say the Pretzel Shop calls and raises the quantity to 3,000 after you've removed
the discount for their account? You'll need to edit the quote, at which point Morning
Flight saves it with the new, 0.00% discount terms. As you can see from the empty
slot pointed to by the arrow, the revisions automatically filter down into the estimate -
it no longer shows a net price. Because the quote for the 1,000 newsletters hasn't
been edited, there the net price stays.
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B Joe Baker

" The Pretzel Shop Lizt Price I et
v 0B03-00008 | Mewsletters 1,000 21770 211,20 ¢
»' 0803-00003 | Envelopes 3,000 19965

Now that we've learned how price adjustments work in quotes, let's find out how they
play out at the estimate level. When you create a new estimate and click the blue
pricing button, what you'll see is the discount/surcharge percentage retrieved from the
customer's account. That's what comes up as the default. You can now either
change that percentage, or eliminate it entirely. In essence, you're overwriting the
imported customer discount or surcharge that's already there. Naturally, existing
estimates will display whatever percentage you entered when you created the
estimate.

There you have it. No multiple discounts, no multiple surcharges. Just one
percentage, manipulated at two different stages in the program. Other key points to
remember:

1. The price adjustment you make at the estimate level is for a single item only,
not for the entire estimate. That leaves you free to micro-manage, to pick and
choose.

2. The adjustment in no way alters the discount/surcharge terms set for the
customer's account. In other words, the rates don't flow back. They only apply
to this single estimate.

3. Quote edits do flow forward into the estimate - instantly! You don't have to edit
an estimate to bring it in sync with a captured quote (any quote linked to the
estimate).
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Joe Baker BIA352009
The Pretzel Shop

108 Belvidere Ave

Crainsville, AR 43958

Vour Incuiry 2/23/2009
Car Cmotation HH-0Z09-0002

Deat Joe:

Thank ywou for your inguiry. We are pleased to offer as follows:

0209-0000%  MNewsletters 1,000 2.000 5,000
8-1.2x11 $211.20 $272.10 $417 20
Black + 1 Colot on front, Black ink on back, Ink Colors: PLIE 109, Paper: 60
It Cotmodity Offset, White.

0209-00002  Ewmvelopes, Size 10 3,000 4,000 5,000
4.1/8x9-1/2 $190.55 $249.40 $223.00

Black ink on front. Paper: 24 Th Wowe, White.

These prices do fot include sales tax and are walid for 30 davs. We appreciate vour interest
atud hiope we can be of service.

\ PTG TV Y VR WY WP WA P ewL e

Pl P i et Al ol et g A, P e, o 0

Where's my Discount?

"If 'm giving my customer a discount, why doesn't Morning Flight show it on the
estimate?" Understandably, we're all in favor of hiding surcharges. Telling the
customer "Because you're difficult and obnoxious, we're now going to charge you
10% extra" would under any conceivable circumstance be received poorly. But why
not itemize discounts and make the customer feel good? There are two problems
with that:

1. Itinhibits pricing flexibility. The freedom to change "ticket prices" from one day
to the next is at the core of value-added pricing. But charging $126.30 for 1,500
envelopes today, and $128.90 tomorrow is one thing. Showing a 3% discount
today, and a measly 1% discount tomorrow, while less damaging than showing
a surcharge, ranks a close second. At the very least, you'd have some
explaining to do.

2. It sets a cast-in-cement precedent. Once you tell customers they're getting a
discount, try backing out and charge full list again! The auto industry learned
that lesson the hard way.
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For the few cases where you do want to spell out the discount, it's easy to add a
comment under Remarks when you configure the estimate.

6.4 e-Mail

This topic describes how to e-mail an estimate to your customer. More accurately, to

ing an Estimate

a customer contact. For e-mailing, that's an important distinction. While generic mail

boxes such as "info" or "sales" do exist, there's usually a live contact person behind
them. An estimate sent to a purely generic address will likely reach the intended
recipient late, if ever.

The same holds true for e-mailing acknowledgments, for which the step-by-step
instructions are similar.

Step by Step

e From the main menu, select Write Estimate > Write/Edit Estimate.

Morning Flight Gold

File Log-in  Quoke Price

Inwsice View  Prink

[N t
_ﬁ'f - Browse Estimates }

My Estimate Preferences

“MMM\’_“-‘L‘-J il

Window  Help
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LCustarner

x

Empire Builders

6/18/2003 | HH-06/03-0007
5M15/2003 | HH-05/03-0003

|13
il Click the Rolodex button and select the customer.

¢ Highlight the estimate you want to e-mail. If the estimate was written to a contact
who has an e-mail address, the e-mail button will light up. If it doesn't, it's either
because no estimate has been selected yet (no highlight bar in the browse box),
or the browse box is empty.

. Click the e-Mail button. This will copy the estimate to the Windows clipboard
and bring up your e-mail program with the contact's e-mail address filled in.

¢ Place the cursor in the message area of your e-mail program and press Ctrl-V
to paste the estimate. You may want to add a reference in the "Subject" line and
make any changes or additional comments before you click the send button.
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I.f-_,;\\ = © » % |5 Untitled - Message (HTML) - =X
kg
——/ Message Insert Options Format Text Adobe PDF L7
fa [ A& A [GA @ - v ¥ y
2 ||| B LB |i= = ||EEEE g
Paste e MNames Follow | | Spelling
b = = = 4
72 A === - 27 || up- =
Clipboard M= Basic Text Include Cptions ™= || Proofing
To.. tom. bradley @empire. com
__ 0
-
Send
Subject: Estimate for Printing July Mewsletter
. Cal
Your Inguiry: 6/18,/2009 -

Dear Tom:

Our Quotation: HH-06/09-0002

Thank you for your inquiry. We are pleased to offer as follows:

Mewsletters
8-1/2x11

1,200 ..... 5155.50

2,000

Black + 1 Color on front. Ink Colors: PMS 185. Paper: 60 Ib Commodity Offset, White.

..... 5191.85 5,000..... $294.90

Changing the Language

These prices do not include sales tax and are valid for 30 days. We appreciate your
interest and hope we can be of service.

Our offices are located on the shores of Lake Ontario, in Rochester, New York, a few

hours drive from one of the largest bilingual markets in the world - the province of

Quebec, Canada. Technically, our neighbors to the North shouldn't even be
considered bilingual. Store window signs displayed in English attract more than just
the ire of the citizenry: It can get the shop owner fined! Not merely a slap on the wrist,
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either ... up to $1,500 Canadian. Compliance is enforced by the Quebec language
police, the Office québécois de la langue francaise.

With that as a backdrop, is it any wonder that Morning Flight speaks both English and
French? For our just-across-the-lake Canadian friends, absolutely, but why stop
there. The program also speaks German, Spanish, ltalian, and Portuguese. English
and German are the only two languages that have so far been implemented fully, but
estimates are translated by the program in all five.

So what does this bilingual talent do for estimates? Say you're a printer in Toronto,
Canada, and you have customers in both English-speaking Toronto and
predominantly French-speaking Montreal. You create the estimate in your native
language, select the customer, then sit back and watch Morning Flight compose the
estimate in English for International Publishing, Ltd. in Toronto, and in French for
Editions ABC Ltée. in Montreal.

Translating Estimates, Step One

- From the main menu, click the My Store button, then click My Customers.

Click the Add button, then enter the name and address of the customer in
Toronto.
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Countrys

_ e International Publizhing, Ltd.
Canada [Enaglizh]

Compary International Publizhing, Ltd.

Addrezs 187 Adelaide St

Taranta

OM

189

¢ Click the Country button, then select Canada (English). Save the customer.

¢ Do the same for the customer in Montreal, but select Canada (French).
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Conny

Canada [French]

Argenting
Ausztralia
Auztria
Belgium [Flemizh)
Belgium [French]
Brazil
. 3 . Canada [Enaglish]
Lie Motre e, i Canada [Frenchl
MONTREAL PO 7 Chile
Denrnark,
Finland

Z:M

Step Two

There is no step two - we're done. Morning Flight automatically writes all estimates in
the language embedded in the customer's country profile. And, yes, you can define
new countries and add them to the list. You can even install a new language.
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Tane MacAllister 25-08-2009
Editions ABC Ltée.

10% nae Notre Dame, b, 10

MOWTREAL PO H3A IT7

Votre demande 25-02-2009
Mos dewis HH-08/09-0009

Cher Idadate hacallister,

Merci pout wotre demande de renseignements. Nous somumes heureur de wous offtir ce gl

sut:
0E02-00016

0209-00017

Ces prix n'incluent pas les taxes de ventes et sont valides pour une période de 30 jours. Hous

Bulletins d'information 450 500 550
8-1/2x11 §EETS $92.70 $95.70
Encre noit devant. Papier: 80 Ib papier couché, blane.

Brochures de vente 1,000 2.000 5.000
8-1/2x11 $E0E0 $130.05 $227.10

Encre noit devant. Papier: 20 Ib papier pour la copie, blane.

apprécions votre intéret et espérons que cela répondra 4 vos besoins.

Mous wous prions d'agréer, Madame, 'expression de nos sentiments distingués.

6.6 Making old Quotes new again

*
Thank pou for your inguiry. e are pIeasW&r az follows:

These prices do not include zales tax and are walid for 30 days.
W2 appreciate your interest and hope we zan be of service.

AR e N & B

L YW W WA YR 1‘ i Ny

b e B MW"»’ l‘rm#/
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The other, the part you set in Estimate Preferences, is how long those old quotes
should be available for inclusion in new estimates. The default is 30 days. You could
extend that, but a better solution is to always open old quotes for editing and then
save the update. Morning Flight will automatically reprice the quote and validate its
entry ticket for another 30 days.

Morning Flight - Silver. Edition

File Log-in Quobte Price RUGGEASEERN Yiew  Print  SWindow  Help

- F— Write Edit Estimate
_'@ i | Browse Eskimates E m E B

My Estimate Preferences

\rikefEdit Mema
L AT IR e e o e r o

7’{??

E stimate Options

[ Print on Letterhead

v Show Ink 5avings

[ Show Merchandize Hours
[v Show full Description

[ Show Delivery
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7 Entering Orders

7.1  Entering an Order

The left side of the order entry window is identical to the left side of the quote window,
so entering orders will feel like like familiar territory. Rather than rehash what you
already know, let's focus on what's different.

8 From the main menu, click the Order button.

ACME Supplies

Product Letterheads

8142511 =Are

Faper 24 Ib Claszic Laid

8142 1 11, Avon Brilliant wWhite E

CME Supplies

o Y
T . R ) " 2 Empire Builders

Frinting Black + 1 Calar o frant ~ e el

Itk Calars - " 4 Precision Automotive
5 Koslowski Plumbing Supplies
Freprezs ; l
)
Poztpress gy d
Feymord [
195.30 195.30 felof iaf
Page One

ﬂ The most noticeable difference is that we're now dealing with a single
guantity. Nobody will ever order all three quantities of a letterhead we quoted.

¢ The second difference is that there is more than one page to the blue panel.
Four, actually. The left half of the window doesn't change, just the entries on the
right. Click the second radio button to get to page two, or press the PgDn key.
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|

a_;’ R« /
4__ m,?.f

195.30 19530 {(f 0 - "

= o A e sk widl T il

Pages Two and Three

Nothing on these two pages calls out for an explanation. One quick comment about
the Due Date on page two: If the order was promised for delivery on a specific date,
now would be a good time to enter that date to make sure it gets picked up by the
Order Tracker. Couldn't we do that later? Sure, but later is usually when the customer
walks through the door to pick up the job.

Complills &

® Friday. 12:00 PH i | October 2010
101542010 4

wW T F 5§

" Approzimate " Morning 1 2
+" Moon 3 4 5 B 7 8 19

" Endof Day 10 11 12 13 14[15 15
171813 20 21 22 23
24 25 26 27 28 29 30
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Page Four

Here is where you can tell the
program how much to charge for
each item. If your prices are
different from those calculated by
the program, the total will display in
red.

That's a change from how price
adjustments are handled in quotes.
Quote prices are firm at the quote
stage, but can be adjusted in the
estimate. With orders, the price is
adjusted on page four of the order
entry window, then carried over into
the invoice.

Repeating an Order

195

105.00

55.00

30.00

e e

195.30 130.00

i ' il s gt A R i il

Managing orders with software prevents transcription errors. It's one of the biggest
benefits of using an MIS. Computers aren't overly bright, but they do one thing

exceedingly well, and that's copy things. There's no chance even the most basic

machine would ever read a PMS 185 ink color from a previous order and write it down

as PMS 186.

Combine that with the one-button ease of repeating orders, and you realize anew, this

is where an MIS earns its keep!
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Morning Flight Gold
File Log-in  Quote Price  rite Estimate NEpl=@eis=8 Invoice Wiew Print  Window Help
Enter Print Order H
Enker Prink Qrder My Way i n
Enter Book Order r :
Enter Merchandise Crder
Repeat Crder
Make Order From Quoke
P e AR el A el . AN
ACME Supplies
Product Letterheads
81/2x 11 A o]
10/10/2010
Paper 24 Ib Classic Laid
8-1/2 » 11, Avon Brilliant E
Frinting Black + 1 Calar on front
Ink. Calors & 7
3456 7 89
Prepress [0 11 12 13 14 15 18
Pastpress 1718 19 20 21 22 23 a;,
24 25 25 27 28 29 30 ’
Feywiord [ kf
195.30 g eee
O Z0 .
Repeating an order comes down to clicking Enter Order > Repeat Order on the
main menu, selecting the order you want to repeat, then filling in the new due date
and PO number. Not much else I can tell you. If you check the red circle, you'll note
that the price adjustment in the original order has been carried over into the reorder.
7.3 Making Orders from Quotes

Converting a quote into an order is just as quick and easy and bullet-proof as
repeating an order. Though there is that one extra click: Selecting the quantity ordered
from the three that were quoted!
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Morning Flight Pixelblitz

File Log-in  Quote Price  ‘Write Eskimate Nag=f@elGET® Invoice View  Prink wWindow  Help

Enter Prink Crder

Enter Prink Qrder My Way H} n
Enter Book Crder ® ;
Enter Merchandise Order

Repeat Order

r From Quoke

i # ‘_.‘,.--_ I' T T Wy Hﬁrdﬁ-.‘ '.""‘ O bt ‘r‘

Precizion Automotive

Product Digital
8-1/2x 11 [2-up)

1010-00002
Faper 60 Ih [Zumr_nudil_l,l Dffzet
11 %17, White 1041142010
Printi Digital 1- {
M 0ol 1 Color on back 1000 2500 5000

Ik, Colars

Prepress

Postpress

Fewward [

219.00 219.00 Ok
z:

Page three is for information only. It tells you when and in what quantities the job was
guoted. Note the almost total absence of buttons. Converting a quote means just that.
You're accepting the order without deviations from the way it was quoted, at face
value.

What if the customer has placed the order with revisions but doesn't want to be re-
guoted? First click Ok to convert the quote, then revise the newly created order.
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7.4 Entering a Wide Format Order

Entering a wide format order is nearly the same as making a wide format quote.
Except for the obvious differences, such as entering a ship to address, the two
screens are virtually identical.

ﬁj From the main menu, either click the Wide Format Order button, or select
Enter Order > Enter Wide Format Order.

File Log-in Quote Price  Write Estirmate | Enter Order | Invoice View Print Window Help

'i . _| — Enter Print Order n
F__ i -@ — ﬁ Enter Print Order My Way

Enter Book Order
Enter Wide Format Order

Enter Merchandise Order

Price of 1

£ast lo make

I
—
—
—

VISTA Charer Flights
helanie R

Billing Acldr

3 =
P A oo
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Customer Discount

In the United States it's common trade practice to offer a discount of 5-10% to
existing customers. When work is slow, even walk-in customers are sometimes
quoted a lower price to secure the order. In Morning Flight, discounts (and

surcharges) are set at the customer level and are automatically dropped into quotes
and orders. They're not meant to be adjusted case by case.

wer VISTA Charter Flights I8
1k Melanie Reisner .|

Addrezs 1 Contact Stationemny

VISTA Charter Flights

Credit Linit
Reduce Prices B0%

Billing

Ihcreasze Prices

Product Discount

Pioduct  Yard Slgn

Click to customize

Independent of the type of customer, discounts can balloon to as high as 15% once
the size of the job exceeds $5,000. That kind of discount clearly needs to be adjusted
case by case, since it's tied to the size of the order. There are two ways you can do
that with wide format:

¢ Click the custom product button
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¢ Adjust either the quantity discount or the markup, or both, whichever is
appropriate.

Quantity
Discount far quantity deduct

- 2 12.0%

v Discount 5 || 250%

7.5 Acknowledging an Order

Order a book from Amazon or a Sunbeam Mixmaster from the Sears catalog, and
you'll get an email telling you what you ordered, how much it will cost, and when to
expect delivery.

Confirming what the customer ordered is good policy for any business, doubly so for
printers. When a carton of envelopes comes back because they were printed with the
wrong ink color, forget about putting those envelopes back on the shelf, ready for the
next customer to walk in. A print shop's Returns Department is the nearest dumpster.

Morning Flight makes acknowledging orders quick and hassle-free. There's never a
good reason to keep the customer in the dark, wondering.
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ACHME Supplies

04142000

NEE A

¢ From the main menu, select Enter Order > Acknowledge Order.

%l Fiote:

If the customer is included in the quick-list on the left side of the window, use that
instead. Or, start typing the customer's name into the Jet-Entry box just above the
quick-list. Keep typing until you've narrowed it down to the one you're looking for.
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L
3

B Click the Add button.

Customer Jobs Options

Jennifer Jones
ACME Supples

Ackrowledgment Date | 10/11/2010 |
PO Mumber | |
[v Charge Shipping FParcel Post 8.50

[ Charge T ax I:I
Paprment m Met 30 Dapz

L ot Sl SRy NPV ol SV L

¢ In the window that opens, complete the entry boxes in the Customer tab.

¢ Click the Jobs tab. Left-click the jobs you want to include in the acknowledgment.

Cusgtomer Jobs | Bemarks Dptions

Jennifer Jones
ACKME Supplies

10 0-00001 | Letterheads
» 1010-00004 | Envelopes
v’ 1010-00005 | Digital

] Z:[8
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To change the sequence in which the jobs are listed in the acknowledgment, click the
sort button. Select the job, then click the up or down button to reposition it.

Sort Job Sheets

{1M0-00004 | Ernvelopes
1010-00005 | Digital

¢ Click the Options tab. Configure the acknowledgment by checking the
appropriate boxes.

Custamer | Johs Bemarks Optians

Jennifer Jones
ACME Suppliez

[v Show Job Mumbers [ Print on Letterhead

v Show full Description v Conzolidate [nks

[v Show Merchandise Hours

W Show Delivery D ate » | 101472010

¢ Click OK to save the acknowledgment.
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7.6

The Results

M=, Jennifer Jones
ACME Supplies
55 Main Street
Chicage, IL 43735

Dear Jennifer:

Thank wou far your arder. We are pleased to confirm as follows:

Acknowledgment

A-1002

October 141, 2010

Terms: Met 20 Lays

Changing an Order

Quantity Crescription Job Mumber Amouni
400 Digital, 010, 8-142 = 11 1010-00005 51.65
1-Calar on front, 1-Colar on back. Paper: 20 Ib Copy Bond,
Wrhite.
1,00  Enwelopes, Size 10, 4-1/8 x 3-1i2 1010-00004 104.55
Black ink on front. Paper: 24 Ib Wiove, White.
Subtotal $156.20
Shipping 0.aod
Tax 0.aod
Total $156.20

This topic describes how to find and edit an order. If you know its ID number, you can

import and edit the order from within the order entry window. Select Enter Order >
Enter Print Order, then click the Rolodex button at the bottom of the order entry

window.

That won't happen often. You normally have to search for the order before you can
edit it. In that case, select Enter Order > Edit Order to open the job sheet selection

window.
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Morning Flight Gold
File Log-in  Quote Price  ‘Write Estimate NaglE/aelislT

Enter Prink Crder

Enket Print Crder My Way
Enter Book Order

Enter Merchandise Crder

Repeat Order
Make COrder From Quoke

Edit Order

Acknowledge Order

‘h‘_'ﬂ"wr andlr - a A - gl ot o A ol e i .

Sobotreels

I} Custommer Product
10700-00008 ACME Supplies Sheet
1010-00007 The Pretzel Shop Carbonless
1070-00006 Precigion Automotive Sheet
1010-00005 ALCME Supplies Drigital
1010-00004 ACME Supplies Envelope
107 0-00003 Precizion Autamativg Digital
1010-00002 &5 Precision Automotive Digital

OER

Invoice  View  Prink

205

Window  Help

o
Exial n

Hewsletters
x11
B0 Ib Cormrnodity Offset
[

321.85

Cluantity

400

The Update button does what you would expect it to do, it opens the Edit

Order window.

The Paperclip button copies the highlighted job sheet to the Windows
clipboard. When you open the New Print Order window and there is a job sheet in

the clipboard, an identical button there will let you paste in a copy. Not for editing, but

as a template for entering a new order.
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]
To search for an order for a specific customer, place the highlight bar over that
customer in the job sheet selection window, then click the Find button.

Wrong customer? Click the Rolodex button in the upper right corner of the Order
Finder window.

Too many orders to look through for the same customer? Click on a specific Product
Category to narrow the search to that category.

- B x|

* Date Product Kemaord ACME Supplies

I 011420 | Digital | October Fiyer
041142010 | Envelope
0052000 | Sheet

; g M- - . f’

E

| 1 s ™ Starks with: 4

: ‘\1& {* Contains: !

i: iy October ?

I . !

| 1
:.- R S ETUE A SR S S R e e DA S St

F : :

L z: [

The order finder window comes with its own Find button, one that let's you search for
a Keyword. Keywords are a powerful search tool that your customers will
appreciate, too. To add a keyword or special instructions for an order, press the F8
button in the order entry window.

%\Mutﬁ:

Neither the paperclip button nor the Rolodex button are available when we edit
an order. The paperclip button pastes a copy of another order from the
Windows clipboard, but that's for entering new orders only. The Rolodex button
imports an order for editing. Right, we're already editing!
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Frepress
Postpress E
Kepword [ Octaber Flyer

7.7 Adding a Note or Keyword

This topic describes how to add a note or keyword to an order. Keywords make it
easier for your customer to identify an order, and for you to find it. Much easier, in
fact, if you've entered scores of orders for the same customer.

Notes come in two flavors: General notes about the customer, and instructions for a
specific order. Notes about the customer are for office use only. They can be viewed
on the monitor, but don't show up on job sheets or job tickets.
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What gets printed

e Customer Alerts
"Fussy about ink colors"
e Keywords
"October Newsletter"
e Special Instructions

"Deliver with envelope order."

ACME Supphles

Alerts/Motes

Fuzzy about ink colors

Always azks for eventhing vesterdan but
doezn't pick it up until  week later, On the
ather hand, uzually pavs right awan.
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1010-00005 Digital. D141

October Mewslether

Dreliver with envelope order.

Bz

E From the main menu, click the Order button.

e Click the F8 button.

¢ Enter a Keyword and/or Special Instructions.

The Result
Faper 20 b Copy Bond On hand: 2.691
White (from our stock)
Oty used:
e neead: 428 8102 =11
Crrawu: 429 B-102 = 11
Fackaging Shrinkwrap
Ok owverfunder |+ o6 ||- o6 | | O to print: |

Save | File Samples / | Final Count: |

Motes: Deliverwith envelope order. Caution: Fussy about ink colors,

Sl e g ans s e s e F PRy Ce R
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Once an order has been invoiced, the job sheet can no longer be edited. You can,
however, add or edit a note.

e Go to View > All Orders

¢ Double-click the order for which you want to add or edit a note

Eﬂ Click the button to the left of the Exit button.

7.8 Printing Job Tickets

Job tickets describe what the job is, what has to be done to complete it, and when it
has to be delivered. No other piece of paper plays a more critical role in avoiding
mistakes and assuring a smooth work flow. With that much on the line, you'd expect
the program to offer a variety of options of how print job tickets and job-related lists,
along with delivery notes and shipping labels. It doesn't disappoint.

Morning Flight Gold

File Log-in  Quate Price  Write Estimate  Enter Order  Inwvoice  View BEEGS Window Help

el l Price Sheet
§BT EE s

Quoke Sheet

Job Sheet
Job Ticket

Estimates
Mermos

Crders . . . Iy Whiork Session
Job Sheet

Irvaices | . . 4
Acknowledament Job Ticket
Delivery MNoke
Shipping Label

Open Orders List
Crder Due Dates

i Open Orders List
L Order Due Dates

R MG e R - T T Y

List of my Orders

)

First, some quick definitions: Job Sheets are for office use and describe the job, but
may lack some details on how to produce it. Job Tickets add production specs but
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take away pricing. They're meant to travel with the job from prepress to delivery. Both
include keywords, customer alerts, and special instructions.

Work Session: Having just entered a bunch of orders in one sitting, you certainly don't
want to print all those job sheets separately, one at a time. When you select Print >
Orders > My Work Session, a window opens in which the last orders you entered
have been preselected. They're all checked, provided you haven't printed them yet.
That's your work session. To print the work session sheets as a group, complete with
matching tickets,

Click the Print button, then click Ok on the message box.

Joboticels

] Customer Product Hewsletters
11

v 101000008 | ACME Supplies | Sheet B0 b Commodity Offset
» 1010-00007 The Pretzel Shop Carbonless e 4
v 1010-00006 Precizion Automaotivg Sheet
v 1010-00005 ALCME §
» 10710-00004 ACME
v 1070-00003 Precizi
1010-00002 |5 Precisi "
1010-00001 |ds ACME SE
2o
|
4
i
6 Job Sheets ?
far !
Warious Cuztomers j
. gt e .l L L ST T N S

Selecting Print > Orders > List of my Orders lets you print a range of orders within
a certain time frame, placed by a single customer or all. You can have the list sorted
by order number, customer name, order value, or status (open, shipped, invoiced).
Check the Show Preview box for an on-screen preview before you send the list to
the printer.
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Phins Lz

From
iQ Al Customers
i@ One Customer

Sort by

Show Preview

Brother MFC-J 44100

Orders

<[10710/200 |
SEEEETIN

i Thiz Week-to-date
Lazt Week
Thiz Month-to-date
Lazt Maonth
Thiz Y'ear-to-date
Lazt Year
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ACME Supplies
55 hdain Street

Job

Sheet

Oectober Mevsletter

Chicagao, IL 43735

jEnmY@acme. com

1010-00008

Ordered by: Jennifer Jones Receiwed: A0M2/2010 Ship wia: Motify when ready
Fhione: 555-3728 By el ail Oate Oue: Whednesday, 1020020410
F=i: 555-4965 12:00 Pl
400 Newsletters. 8-1/2 x 11 144.50
Front: Black + 1 Calar
Back: Black ink
1-up on 8-1/2 = 11
Faper G0 Ib Commuodity Offzet 12.7E
White (from our stock)
e need: 544 8102 w11
Crrawe: S 2102 =11
Ink PS5 109 Chrome vellaw a0.ac
Prepress Composition 1:20 Haurs 122.0C
2 BE&WN Scans
Fostpress Faolding: Letterfald 12.0C
Fackaging Shrinlrap 0.3c
TOTAL FRICE $321.85

Motes: Deliverwith envelope order.

Caution: Fussy about ink calaors.

Enterad: 10M2/2010 1:03 FM HH

Changed: 10/1322010 HH
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ACME Supplies
55 Main Street

Job

Ticket

October Mewsletter

Chicagao, IL 43735

jEnny@acme. com

101000008

Sawe

| File Samples |

Motes: Deliverwith enwvelope order.

Ordered by: Jennifer Jones Receiwved: 10M12/2010 Ship wia: Motify when ready
Fhione: 555-3728 By e b ail Oate Oue: Wednesday, 10,200201C
Fax: 555-4865 12:00 P
400 Newsletters. 8-1/2 x 11
Front: Black+ 1 Colar
Back: Black ink
1-up on 8-1/2 = 11

Fress Sheets: 400

Flates: CTP | Ryabi |

il akeready: Medium

Run Speed: Medium | 29 Minutes |
Faper G0 b Commadity Offzet oOn hand: 10,000

White (from our stock)

Oty uzed:

Mie need: 544 8102 =11

Crraw: 544 8102 =11
Ink FMS 109 Chrome “ellow
Frepress Composition 1:20 Haours

2 BEW Scans
Postpress Folding: Letterfold
Fackaging Shrinkwrap
Ok owerfunder | + %6 ||- %6 | | Ok to print: |

| Final Count:

Caution: Fussy about ink calaors.

Entered: 10M2/2010 102 FM HH

Changed: 10/13/2010 HH
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8.1

Tracking Orders

Using the Order Tracker

215

In the print shop my friend Jerry and | opened in 1969, order tracking never graduated
beyond the oversized cork board and pushpins on our shop wall. Not because a
computerized tracking system would have been difficult to code, but because in all
those years | never felt the need for it. There's some information that just works better
on paper than it does on a monitor. We, of all people, should know that. We make our
living putting information on paper.

Printing isn't the only industry where that's being recognized. The U.S. government
has spent billions modernizing our air traffic control system. Yet when you board a
plane for your next business trip, you're in the hands of Air Traffic Controllers who
keep track of your airplane on strips of paper. The reason that time-tested system is
still in place is not because the FAA hasn't tried to deep-six it. They just haven't come
up with anything better.

BATR/E - J o
1io b, | l M T | e neke
MNR = fa o |b&raa et
hasof = | B3
iy =58 EQER S42% los-1/a8
1014 o i T i
1 PR |Ae -,J EGAC ._."-._\ sEe | ob IS o tax @el
= e ] WL 1
S — . W |I iy P
| ¥ i
i |— 2t SEHARS (oo e e rd b

Now, does order tracking work on a computer screen? Absolutely. It will work
phenomenally well once we can shuffle jobs around with our index finger on a 10-foot
wide touch screen, the way newscasters do on CNN. Until then, tracking orders on
your desktop monitor is as good as it gets. But I'll confess, if | ever found myself
running a print shop again, that big plasma touch screen would top my list.
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Morning Flight Gold

File Log-in Quoke Price  ‘Write Estimate  Enker Order

]

How Orders are tracked

Invoice  View

mrink  Window  Help

1527 EET O

| SR vh . #-."""‘---H"‘ B A PN m.-J

ﬂm@&%

1D Customer Due Station Mewsletters
41010000171 | The Pretzel Shop Delivered
10000010 | The Pretzel Shop Delivered
4101000009 | The Pretzel Shop Delivered
Pooamo-moos | ACME Supplies 2 1045200 ] Prepress
1010-00007 | The Pretzel Shop | 10/18/2010 | Design
10710-00006 | Precizion Automoti Ready to ship
1010-00005 | ACME Supplies Fress
10710-00004 | ACME Supplies Press Dezigned
101000003 | Precision Automotid 8 1078/2000 | Press
1010-00002 | Precision Automotiv @ 10/20/2010 | Postpress ’;ppmd"ec' LE il
101000001 | ACME Supplies Invoiced [EHoane
Frinted
Fost done
Delivered

i @ by

All orders are tracked as soon as you enter them. Tracking stops once the job has

been invoiced. You don't need to initiate or terminate the process. That allows run-of-
the-mill small jobs without a deadline to be along just for the ride. Most shop owners
will agree that not every order needs to be shepherded through the production cycle.

What the Buttons do

m Puts orders on hold. A toggle switch that either releases or activates the
hold.

. Marks orders as shipped, using today's date. Another toggle.
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i Marks orders as shipped, using a calendar.

E The primary tracking button, opens the Job Control window.

Diue Date Job Status

day. 12:00 PM ne October 2010
10 :

Due Date is Job iz S M T WT F

Approximate [v Designed 1

Firm 34 5 B 7 8
Critical B 10 11 12 13 14 15
[ Printed 17 18 19[521 22
™ Pust dome 24 25 26 27 28 29
gl

karming
Moon

End of Cray [ Delivered

Qo Zo

The Job Control window is where you update the status of an order. Here you can
also change the due date you set when you entered the order, or enter a new due
date if the order wasn't promised initially.

8.2 Showing Due Dates on Startup

Showing due dates on startup is a two-stage process. First, make sure there's a
check mark in front of the menu item. Second, shut Morning Flight down at night (or
the morning after) so a startup actually happens. Then, when the program does start
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up again, and you have orders in the system that are promised for delivery, a pop-up

box will remind you.

Morning Flight Gold
File Log-in  Quote Price  rite Estimate NSpl=laelysT
Enter Prink Crder

Enker Print Qrder My Way ! I! n
Enter Book Order s ;
Enter Merchandise Order I

Invoice  Wiew Print  Window Help

Repeat COrder
Make Crder From Quoke

Edit Crder
acknowledge Order

\ Browse Orders

‘ Tiack Crders
:n.-'-.l Due Dates on Start-up | |

p—

B T N T s il T V.V Sy oY

Cholor loonchies

Customer Due Station Hewsletters
8142511
08| ACME Subplies z 10/15/2010 | Prepress B0 Ib Commadity Offset

03 | Precizion Automaotive | 8 10/18/2010 | Press e 8
07 | The Pretzel Shop B 1018/2010 | Design

Order Due
Friday
10452010
12:00 P
“ Firrn **

gt P | s gt . e T ¥ PR ey

Unlike the regular order tracker, the pop-up only shows orders that are promised for

the next three days. A green circle says the due date is approximate, a yellow circle

means firm. Leaves the number 3 and code red: The order absolutely, positively has
to be delivered by the time and date specified.
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9 Making Invoices

9.1 Creating the Invoice

Creating invoices is a virtual clone of creating estimates, so we'll keep this short.
Let's assume you've just completed a stationery order for letterheads, envelopes, and
business cards for The Pretzel Shop.You'd like to get paid, so we'll need to create an
invoice.

Morning Flight Gold

File Log-in  Quake Price  ‘Write Estimate  Enter Qrder

; kefEdit Invoice
,f. ] = » - - 2 1
i “— I T

My Invoice Preferences

View Print  Window Help

The Pretzel Shop

104442010

NEER AL

AL,
Normally you would click the Rolodex button in the black panel, but since
The Pretzel Shop is included in the Quick List on the left, click the radio button
instead.
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Click the Add button.

Custorner | Jobz | Bemarks Optionz

The Pretzel Shop

Historny

Irenice Date | 10/1422m10

PO Mumber |

v Charge Shipping Delivery Service
v Charge Tax Monroe County

Paumnent Met 30 0

‘-\-.-.-._*#. .. = '-#—-—"**"

i.,-""---"'

¢ In the window that opens, enter the customer's PO number, if applicable, and

complete the rest of the fields. If you have selected payment terms that are
different from the customer's regular terms, a click in the red circle will restore

their regular terms.

%\ P ote:

To change the shipping, tax, or payment method, click the appropriate button or

press the F2, F3, or F4 key. You'll then be able to select, add, and update

methods on the fly, as well as designate a primary method as your default.
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The Pretzel Shop

B0 Mumber
[v Charge Ship}
[v Charge Tax Mare Bat

Fayrnent ]
& Matify when ready

Prearranged Pickup

Cur Truck,

Delrver Service B,

] Parcel Post
LIPS

b da et et L o ] e o o g o JF

¢ Click the Jobs tab. Left-click the orders you want to include in the invoice.

Custamer Jobs Bemarks | Optiohs

The Pretzel Shop

1010-00007 | Carbonless Forms
v 1010-00009 | Letterheads
v 1010-00010 | Envelopes
v 1000017 | Buginess Cards

vty ML B

¢ Click the Options tab. Configure the invoice by checking the appropriate boxes.
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M

Optians

Custaomer Bemarlks

The Pretzel Shop

[v ShowJob Numbers [ Print on Letterhead

Iv Show full Dezcription [v Consolidate Inks
[v  Show Merchandise Hours
W Show Date Shipped | 10/14/2010 El

| Change Inyoice Number | |

%R ke

When you check the "Consolidate Inks" box, the customer will be charged for a
single washup, not three separate washups for the letterheads, envelopes, and
business cards. See the credit for duplicate ink colors on the invoice below.

¢ Click OK to save the invoice.

Back in the Invoice Manager window, highlight the invoice we just created and
click the Print button.
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The Results
Invoice
The Fretzel Shop 1002
52 Bayside Blvd.
San Francisco, CA 994421 October 14, 2010
Shipped: 101420410 Terms: Met 30 Days
Qi antity Dezcription Job Humber Amouni
1,000 Letterheads, 8-1/2 = 11 101 0-00002 169,50
Bladk+ 1 Caler on front. Ink Colars: PSS WMfarm Red. Papen
24 b Claszic Laid, Whitestone.
1500 Enwelopes, Size 10, 4-1/8 = 9-1/2 1010-00010 30610
Black + 1 Calor on front. Ink Colars: PS5 Warm Red. Papern
24 b Claszic Laid, Whitestone.
500  Business Cards, 2 x 3-1/2 1010-00014 1132680
Black+ 1 Calor on front. Ink Colars: PMWS WMfarm Red. Papern
20 Ib Classic Laid Cower, Whitestone,
Credit far duplicate ink colars 40.00-
Subtotal $543.20
Shipping 5.50
Tax 43,94
Total $533 64

9.2 Changing an Invoice

Changing an invoice is essentially the same as creating one, so here we'll focus on
how to manage the contents. For instance, how do you remove an order so you can
use it in another invoice? Or change the job specs once an order has been delivered?
And should you even do that? (Not normally, but I'll get to that.)

When you click OK to save an invoice, every order you checked in the Jobs tab is
locked and marked "Delivered." Automatically. No need to manually update the status
- the Order Tracker does it for you. Locked means you can't use the same order in
another invoice. Delivered means you can no longer edit it. But what if you checked
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the wrong order by mistake and saved the invoice and now need to fix that? Here is
how.

Examples - Step by Step

Morning Flight Gold

File Log-in Quake Price  ‘Write Estimate  Enker Order

5 F'_ L vl | ] kefEdit Invoice
_'ﬁ i _| ﬁfi Eﬂ Browse Invoices

My Invoice Preferences

Wiew Print  Window Help

Z&m{::ﬁ

Cuztomer Jobs Femarks Cptionz Higtory

The Pretzel Shop

v 1014-00002 | Digital
v 1014-00003 | Envelopes
107 4-00005 | Posteards

How to remove an order

E Go to Invoice > Create/Edit Invoice, highlight the invoice you want to edit,
then click the Change button.

¢ Click the Jobs tab and uncheck the order you want to remove (1014-00005
Postcards in the example above).
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¢ Click OK to save the updated invoice. The deleted order is now unlocked, ready

for use in another invoice.

ACHME Automotive

:10/ 642004

i@ 3 Empire Bui

0E [

How to cancel an entire Invoice

In the Invoice Manager, first highlight the invoice, then click the Trash can. The invoice
will still be visible but is now marked "Void." All orders in a voided invoice are unlocked

and can be re-invoiced.
%\Nﬂtﬁ:
This action is not reversible! Voiding an invoice is like voiding a paper check. It

can't be undone.
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I

fmm

Customer e Station Postcards
Eq0 w0 /2
e 101400005 | The Pretzel Shop Delivered
£ 1014-00004 | Empire Bulders Invoiced
£ 1014-00002 | The Pretzel Shop [reeoiced
£ 101400002 | The Pretzel Shop Imvoiced
101400007 | ACME Automotive Feady to ship

Dezsigned
Approved
Frep done
Frinted

Fozt done
Deliverad

fl,._'\
1 [ I\_‘I If ]
W\ s

N .'“u:‘HM.w-*M

How to edit an Order that has already been invoiced

. First remove the order from the invoice to unlock it, then go to the Order
Tracker and reset the status to anything other than "Delivered.” The quickest way
to do that is to click the "Delivered/Undelivered” toggle (the second button from the
left).

e On the Main Menu, go to Enter Order > Edit Order and make the changes.

¢ Finally, go back to Invoice > Create/Edit Invoice and reattach the order to the
invoice.

%\Mutﬁz

Here is the key fact to remember: When you unlock an order, its "Delivered”
status doesn't on its own revert back to "Ready for Shipment," to where you can
edit it. That's intentional, as a precaution. It's one thing to juggle orders between
invoices. It's another to change an order when the goods are already on their
way to the customer. Make sure you're not billing for something the customer
isn't getting.
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9.3 Changing the Invoice Number

For each new invoice you create, Morning Flight automatically increases the invoice
number by one. In addition, the program assigns each invoice a unique internal ID
that's independent of the number displayed on the invoice. As does QuickBooks.

Manipulating invoice numbers is both tolerated and blissfully ignored by either
program. There is a downside: At some point you're bound to end up with duplicate
numbers. This will annoy your bookkeeper but won't mess up your accounting. Best
to ask, nevertheless.

Morning Flight Pixelblitz

File Log-in  Quokte Price  Write Estimate  Enter Order BGEGIE=8 Yiew Print  Window  Help

- F— Y Create/Edit Invoice
-:@ i o | ﬁj Eﬁ Browse Invoices
= : el (Bl s

My Invoice Prefer

R G R A e i R SSRGS W ra—"

Invoice Options

Theresza Sican

[~ Print on Letterhead
v Charge Shipping

[v Consolidate Inks

W Show Job Mumbers
v Show full Description
[~ Show D ate Shipped
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Invoice numbers can be changed in two places: In the My Preferences window
above, or on the fly, in the Estimate window below. Whichever method you choose,
the number you enter will decide the starting number for any invoices that follow.
Morning Flight picks up the numbering sequence from the new number. If you enter
1003, the program numbers the next invoice as 1004.

If this is a one-time event, maybe because you want to match the Morning Flight
invoice number with a number in QuickBooks or another accounting system, don't
forget to reset your numbering sequence in Preferences.

| Jobs | Bemarks Options

Custamer

The Pretzel Shop

v ShowJob Humbers v Print on Letterhead

[v  Show full Description [v Conzolidate Inks

[v Show Merchandise Hours

[ Show Date Shipped | E
[+ Change Imyoice Mumber | 1.003 ‘} |

n it Y a B R
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10 Working with Wide Format

10.1 The Big Picture -in a Nutshell

M W Price of 1
Make New ] 1 1 600
Lost i mrake A7 83

Product B anner e |le | Quantities

r

Option 1 [E@l Grommets (4) [ Filz Prep
Option 2 . . Degign
Option 3 [ [ Procf

Empire Builders

Pricing 5.1 istomer Discount (uated

Kewword [Quate Changed

The marketing strategy we adopted for Morning Flight is what the wide format
community seems to be doing almost universally: Sell wide format by the square foot.
Advances in inks and substrates are too rapid, and the technology itself too volatile for
prices to be tied to a specific press or ink formulation.

Most consumers will treat wide format, and to some degree all digital products, as a
commodity rather than a service. They're sold as customized shelf items and priced
as such. Few buyers would connect a banner or a vehicle wrap to a printing press.
Environmental concerns aside, when a customer visits your website or walks into
your store, he or she is unlikely to ask what type of ink you'll be using. They'll want to
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know attention-getting their sign will look, how well their banner will stand up to the
weather. And, of course, the price.

Always the price. Starting with Morning Flight V17.1, you now have instant access to
market pricing, how much American printers generally charge for digital and wide
format printing. Those figures didn't come out of thin air. They're an amalgam of
published surveys (such as the highly regarded NPOA pricing study for signage and
wide format), and the pricing some of our more than 6,500 users have shared with
us.

NP o u NATIONAL PRINT OWNERS ASSOCIATION

What we've learned ...

e Banners account for a third of all wide format sales, with an average retail price of
$110.00 for a 3x6 foot banner.

e Most printers in the U.S. automatically offer a 5% discount on digital and wide
format to repeat customers.

¢ While the variation in price for identical digital products is rarely more than 5%
between different regions of the country, it often climbs to a much higher
percentage within the regions themselves. In other words, the greatest variations
are found not between Long Beach and Brooklyn, but within the two.
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Putting it all together ...

I
=
@

-

7’{7 PM w\%

[v  Llze Comme
Mame Size

r Category

© Bariner, 'W4/0 Wk 72 3% 6 feat Lopies
© Corgalast Panel, wd/0 | 24 1 36 2w 3 feet Fhrgrial
C Decal, w40 Ixb
fan' ' A D 1% fd 0 W Y| b n b B N 3 (3
—

Uice ForrmatZ™ Price of 1 1

{ipdaie 571 0
Cast fa make — 4087

Froduct Hame B

Coroplast Panel

T

e f

Price/sgft | A
—

Setup Price Minirmum Price ¥ Discount | 10 ” oz

18.00 2h.00

Mode

7eldpi +B5%

Rushk

The Product

Every wide format quote and order starts with a product. The program comes
preloaded with at least one product in each category. Treat those products as
templates. They're mandatory and can't be deleted, but you can edit nearly anything
you like, including cost and price. My advice is, don't alter templates. When you do
you'll lose their usefulness as a market price guide. How do you recognize a
template? By the small circle in front of it.

Use a built-in product:
1. As is, as just another product in a quote or job ticket

2. As a starting point for building a custom product in a quote or job ticket
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3. As a starting point for making your own templates, to cut down on having to
customize. Different sizes for the same product come to mind.

Wide fM Price of 1
Make New ] 41 80
fast o make 29 85

Customize it

Quantities

*

%\ Fiote:

Unless you need price variations of the same product (retail vs. wholesale,
different quality levels), try to maintain as much uniformity in the pricing of your
own products as you do of the products that came in the box. Adjusting your price
in a quote is much easier when you can count on consistency.
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b aterial Size Cateqary per =q.ft. printed 1 side Categﬂry
<15 0z Scrim Yingl 43496 Banner E.00 TRels] 450
< 9oz Mezh Vingl 43496 Banner E.RO L] 5.00
2 3 mm Dibond 484 96 Rigid 16.00| 1500 14.00

Aateral Casit 78 x 24— 1245

e L

Thick Calar

ay per zquare fook

printed 1 side, price per sg.ft.
we bil | 1600  18x24

| 1500  24x36
| 1400 48x9

il

inches

harket Frice 16.00 18x24 1hx?
15.00 2436 2x3
14.00 48 x 96 4x8

The Substrate

In wide format, substrates set the price. Not because their cost contributes the lion's
share of a product's price (which it rarely does), but for a reason much simpler:
Banners aren't printed on aluminum, and yard signs aren't printed on scrim vinyl. In
wide format printing, the substrate is the center of the universe because it first
controls the type of product we can make from it, then dictates the type of press we
have to run it on.

About the only thing substrates don't control is whether a sign or banner or vehicle
wrap is printed in black or in full color. Fortunately, that doesn't seem to matter.
Should it ever become a factor, offer the same product in two separate versions: One
priced for black, one for color. Creating two different prices can be as simple
adjusting the ink coverage.

© 2018 Helmut Heindel



234

Morning Flight Gold

But making two versions should rarely be necessary. Check the web, and you'd be
hard pressed to find a shop that charges extra for color. Disregarding size and
substrate and whether printed on both sides, a banner is a banner. None of this was
ever part of a greater scheme of things. | think it all just fell into place.

Price of 1 1
103.70
£ost o make — 7408

Product Mame

Dibond Panel, bfw

ft.

15.00

Setup Price Minirmum Price

15.00 25.00

fior quantity deduct

v Digcount

] |'ir|i I

e | Lo ||
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10.2 Creating Options for Wide Format

This topic describes how to create and update Options for Wide Format.

235

[ Fihe] Quote Price  View Print Window Help

My Preferences

Change Background

Show Window ID

My World
My Shop
My Store

Add Custorners
Update . ..
Translate. ..
Exit

L4

_.__..'T"""E

Customers
Contacts AVranrod
Vendors ."5.,‘._..'... e
ot et
My Products * T e
. k -
My Inks

iy Substrates
My Wide Format Options
My In-Stock Paper

My Buy-It Paper. ..

L4

From the main menu, select File > Update > My Wide Format Options.
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Censtom plions

M arne Setup Price ke irirriLar
v Banner Stand, 3692 200 | per Uit 40.00
v [arommets, set of 4 B.00 | per Unit .00
v Grommets, set of B .00 | per Urit 4.50
v Yardzign Stake 280 | per Unit 1.25

i JL =
@

L
3

MY Click the Add button.

Alaena S Desonitog

Larminating

3-mil

Ll geninie s GOl sides
v Double the price

2.00 per SgFt

Setup

Price kinimum

2.00 || 5.00 |

" per Unit
" per 1,000

" per Order

&SR ZzZ0
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Enter the Name of the option, and optionally a brief description.

If the option needs to be applied front and back (on a display board for instance),

check the box marked 'Double the price.' Leave the box unchecked for options such
as banner stands and grommets where it would be inappropriate.

Select how the option is priced: Per Unit, per 1,000, per Order, or per square area.

Enter the Price and, if applicable, Setup and Minimum charges.

bty greiimed Sath siaies
[ Double the price

%\ P ote:

The discount box and entry fields only make sense for options priced per unit.
They go away for anything else.
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11

111

Working with QuickBooks

Preparing QuickBooks

What you'll need

Morning Flight generates invoices but doesn't accept payments or track receivables.
For that you need an accounting system. In much of the world that's likely to be
QuickBooks. So here you are. Two separate programs and the nuisance of having to
key in a stack of invoices into QuickBooks every night. Would be nice if you could get
the two to talk to each other. Starting with version 14.1 of Morning Flight you can. Here
is what you'll need:

1. Version 14.1 or higher of the Gold or Pixelblitz edition. Why only those
two? None of the others generate invoices. Version 14.1 includes an expanded
Flight Engineer that produces CSV import files of your Morning Flight invoices,
mapped for QuickBooks.

2. Acommercial import utility such as the Transaction Pro Importer from
Baystate. Importing transactions into QuickBooks with the old IIF Files used to be
a messy process, often yielding unpredictable results. Fortunately, a number of
third party vendors have found a way around the barricades. Foremost among
them is Baystate Consulting. Their Transaction Pro 5 Importer now lets us use the
same reliable CSV (Comma Separated Values) file format for importing
transactions that was used all along for lists.

We don't sell the Pro 5 or get a commission from Baystate. When we developed
the new QuickBooks link for Morning Flight, we tested a number of utilities from
different vendors. Theirs just happened to come out on top. The program supports
29 different import types in addition to invoices. Baystate advertises an installed
user base of 25,000 and has been certified as a Gold Developer by Intuit, the
makers of QuickBooks. The Transaction Pro 5 Importer is available directly from
Baystate and sells for $199.95 U.S. with a perpetual use license. A trial version
can be downloaded from the Baystate website.
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. Morming Flight Engineer

File RO AL Inventory Tools Window Help
E Export Inveoices to QuickBooks

My Export Preferences
—  View Export Log

Irnport Customers from QuickBooks

View Import Log

- it i gk

Those are the requirements for invoices. For transferring a QuickBooks customer list
into Morning Flight, all you need is the new Gold or Pixelblitz version where
everything's built in. Exporting lists out of QuickBooks has always been easier and
more reliable than transactions, primarily because the exchange of lists is riding on
tried-and-true CSV files. With version 14.1, we've automated the second step,
importing and merging your QuickBooks customers with those already stored in your
Morning Flight file.

What about the reverse, transferring your Morning Flight customer list into
QuickBooks? After all, the Pro 5 Importer works for both lists and transactions, so you
might be tempted to bulk-import all your customers into QuickBooks ahead of time
and be done with it. Not a good idea. For openers, it's unnecessary. The Pro 5
program will piggy-back customer and other relevant list data whenever you import a
Morning Flight invoice into QuickBooks. If you're invoicing an existing customer and
you've changed their address in Morning Flight, it will be updated in QuickBooks
automatically.

Second, you may have built up a customer list in Morning Flight for a while, and that
list will include folks who asked for quotes but never bought anything. Your list could
probably stand a little pruning anyway, so why drag all that baggage into QuickBooks?

%R ke

The Harry Smith you have on file in QuickBooks is not the same customer as
Harry Smith & Co. in Morning Flight. To keep duplicates from sprouting up in
QuickBooks, double check the names in both programs to make sure they
match.
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Creating a Dummy Company in QuickBooks

To avoid putting your active company file at risk, let's first set up a dummy company
so we have a sandbox to practice in. That's actually one of the easier things to do in
QB, and "Dummy Company" is as good a hame as any. You could use one of the
QuickBooks sample files, but those come preloaded with a bunch of stuff that will

only get in the way.

e Open QuickBooks, then go to File > Close Company.

e Select File > New Company and click Express Start.

¢ Enter a fictitious Company Name, then click "Help me choose" for Industry and

Company Type. Ignore the Tax ID.

¢ Bypass "Contact Info" on page 2.

e Ignore all the Add buttons on page 3 and click "Start Working" at the bottom.

Tell us about your business

Enter the essentials so we can créate a company file that™s pust right for your business.

* Company Name

* Industry
* Company Type
Tax 1D 2
* Requined
8 Moo bl G w3 £

Dumimy Company

Wl e this on your invosoes and reports, and 1o name your compady e,

General Product-based Business

We'll use this to creabe accounts comman for your industny.

Sode Proprietorship L

Wl ise: thes o sekect thee right ke settings for your business.

W'l use this on your ta forma,

.o_._

Hedp me choose

Hilp v Chooso
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You've got a company file! Now add your info. 0o—o o—
Get your critical imfo into QuickBooks o you can start working. ':: Co:"};!l f:r:

B Got 90 sevonde? See how caty ML

Add the people you do business with
Why dio this? Emport of entiée your contaats so you an bl your custonmens, pay “

YO wenador, 3 Rrack your ermgiois. Bhes bow B works (2123]

Add the products and services you sell

S ]
i
—

senell irrvoeces of MOoeiAs. T See how it wacks (245)

Add your bank accounts
Why do this? So you can tradk depodsts, payments and hiow misch money you Add

e, Dont wWorry s wonL COnmEct B0 your basie T Sor how & werks (4]

Mo data to enter ght now? No problem. You can akways add it ater.
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Activating Sales Tax in QuickBooks

IT Calendar i | My Preferences Company Preferences
[ =
E Checking Do you charge sales tax? i Mo
U Desktop View Set Up Sales Tax [tem
%5 Finance Charge Add a sales tax item for each county, district, parish, etc. where you
®a General collect sales tax.  Show Examples
Your most common sales tax item

gri Integrated Applicatio . K NV LU . o e T

Add sales tax item. .. Manroe - |
‘ Items & Inventory 5 "
= Jobs & Estimates
[_'—_'-:-"I Multiple Currencies Assign Sales Tax Codes
% Payments Sales tax codes determine if the items you sell are taxable or non-taxable.
@ Payroll & Employees Taxable item code |12y - | Mon-taxable item code  [pyon |
. Reminders : :
% Identify taxable amounts as "T" for "Taxable™ when printing
M Reports & Graphs
% Sales & Customers When do you owe sales tax? When do you pay sales tax?

@ As of invoice date (Accrual Basis) a Monthly
oy o () Upon receipt of payment {Cash Basis) b ey
Send Forms 1 Annually
% Service Connection
le Spelling
22| Tax: 1099

1] Time &Expenses |

1

If you're collecting sales tax, your active company file is already set up for it. Here is a
refresher on how to turn on sales tax in our "Dummy" company:

¢ In QuickBooks, go to Edit > Preferences.

¢ Click Sales Tax in the list on the left, then click the Company Preferences tab.
e Where it says "Do you charge sales tax?", enter Yes.

¢ Click the Add Sales Tax ltem button.

¢ Enter a sales tax item matching the name and tax rate of your most common
District in Morning Flight (where you'll find it under File > Update Taxes). Note
that the "Sales Tax Name" in QuickBooks corresponds to "District” in Morning
Flight, and the QuickBooks "Description” to Morning Flight's "Name".
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Type I 0K ]
. | Useto calculate a s_lngle sales tax at a spedfic rate _
that you pay to a single tax agency. | Canc=l |
Sales Tax Mame
| MNotes
Monroe T
Description ; e @m
Sales Tax
Tax Rate (%) Tax Age Diistrict Marme Fate
8.0% | | NYS Sal
A Monme Sales Tax a0 % :
Taw Free 000 %

¢ Assign Sales Tax Codes. Unless you have good reason not to, accept the
QuickBooks defaults. One good reason not to would be because you're using
different Sales Tax Codes in your active company file. In that case, use the
active file codes for the dummy too, but be sure to adjust the corresponding
settings in tab 2 of your Morning Flight QuickBooks Preferences so they'll match.

.

-

|__J;| Sales Tax Code List E@
Code Description Taxable
Tax Taxable Sales o

Mon Mon-Taxable Sales

Sales Tax Code

Activities "“ Reports = Indude inactive

Setting up the Transaction Pro 5 Importer

What follows are basic setup instructions for using the Transaction Pro 5 Importer
with Morning Flight invoices.

e Download the Transaction Pro 5 Importer Demo and install it, but don't run it yet.

¢ Open the QuickBooks dummy company file you set up in the previous chapter.
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o Start the Transaction Pro Importer. A window will open in QuickBooks, asking for
access to the dummy company. Select “Yes, whenever this QuickBooks
company file is open.” Click Continue on this window and Done on the next, the
one showing your Access Confirmation.

An application is requesting access to the following QuickBooks
company file:
Dummy Company
Access may incude reading and modifying QuickBooks data as well as
enhancdng the QuickBooks user interface,
The Application Calls Itself
Baystate Consulting

Certificate Information
Description:
Developer:  Baystate Consulting

Developer identity has been verified by:
Thawte Code Signing CA - G2

QuickBooks Solutions Marketplace
Search for information about this application at the
+ QuickBooks Solutions Marketplace

Do you want to allow this application to read and medify this company file?
"1 No
"1 Yes, prompt each time

"\ Yes, always; allow access even if QuickBooks is not running

% ote:

Some quick facts about the demo: It's fully functional and has no expiration
date, giving you plenty of time to evaluate howwell your transfers are working.
You'll discover that invoice dates, while real in Morning Flight, will be arbitrary
and random in QuickBooks. You'll have to page through the invoice file to locate
them. Needless to say, that only happens in the demo.

¢ When the main Transaction Pro 5 window opens, click Cancel to exit the

importer.

e Close the dummy company file and exit QuickBooks.
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Going Live

When you're ready to import invoices into your active company file, simply hide the
dummy company until you want to practice again:

No Company Open

Select a company that you've previously opened and dick Open

Company Mame Last Modified File Size

Dummy Company. gbw 10,/08,/2014, 02:34 PM 9,65 MB
 Initac. QBW 10/08/2014, 02:33 PM 14.94 MB

¢ Close the dummy company file, then click Edit List in the window below.

e In the "Edit Company List" window, highlight the dummy company and click OK.

To make it accessible again later, click the "Open or restore an existing
company" button.

Open |

‘ Edit List

Location: C:\Users\Public\Documents\Intuit\QuickBooks\Company Files)

4 [ 4 |[ T

Create a Open or restore an Open a
new company existing company sample file

Edit Company List

Select a company to hide it from the list.

»

Hide Company Name Last Modified File Size

o Dummy Company.obw __ 11/19/2014, 05:21PM

5.80 MB

Unitac. QBW 11/17/2014, 10:53 AM
Printfire. gbw 11/17/2014, 10:51 AM

11.2 Setting up for Invoices

14.94 MB
10.81 MB

In these final steps of getting ready to transfer invoices from Morning Flight into

QuickBooks we're mainly setting preferences. Do you want to keep product

descriptions in the QuickBooks invoice short or spell them out? Price prepress and
postpress separately or include them with the product? Naturally, including the
Country Name in the customer's address is redundant if your sales are all in-country.
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Invoice Range? Just a default. You can override any preference during each export.

Progorences

Optionz ] 5 etlings

[tem Codes - 1 | [tem Codes - 2

[ ltemize Prepress
[ Itemize Postpress

B D

[ Include Country

Invoice Hange
This ‘Week-to-Date
This Month-to-D ate
Lazt Month-to-D ate

el

m ZN

Setting Preferences - Tabl

— 4 Open the Flight Engineer (F-11), then go to QuickBooks > My Export Preferences.
The first tab is self-explanatory, but does deserve a few illustrations:

1. Description. You'll find examples of minimal, standard, and verbose product
descriptions below. If you use QuickBooks invoices primarily for bookkeeping
and Morning Flight invoices to mail to your customers, go minimal. In
QuickBooks, every unique description turns into an item and clogs up your files.
That's unwieldy even for tracking nuts and bolts in a hardware store, but there
at least it makes sense. In a print shop, none of the multiple versions
QuickBooks creates for even simple products will ever serve a purpose.
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Quantity Item ... Description Price E... Class Amount |
500 Digital Digital 0.4224 |Digital 21130 -
500 Envelo... [Envelopes 0.2706 |Offset 135.30 ||
Quantity Item ... Description Price E... | Class Amount |
500 Digital  |Digital, D4/0, 8-1/2 x 11 0.4224 |Digital 211,20 »
500 Envelo... |Envelopes, Size 10, 4-1/8 x 9-1/2 0.2706 |Offset 135,30 | |
Standard
Quantity Item ... Description Price E... Class Amount |
500 Digital Digital, D4f0, 8-1/2 x 11. Color on front. Paper: 20 0.4224 |Digital 211,20 =
|b Copy Bond, White. Preparation: |
Design/Type/Scans, Finishing: Folding. fira
500 Envelo... |Envelopes, Size 10, 4-1/8 x 9-1/2, Black + 1 Color 0.2706 |Offzet 135,30
on front. Ink Colors: PMS 109, Paper: 24 b Waove,
White, -
Quantity Item ... Description Price E... | Class Amount |
500 Digital Digital, D4/0, 8-1/2 x 11. Color on front. Paper: 20 0.1589 |Digital 79.45 =~
|b Copy Bond, White, |
¥ Prepar... |Design/Type/Scans 122.00 |Prepar... 122.00
g Finishing |Felding 9,75 |Finishing 9,75
500 Envelo... |Envelopes, Size 10, 4-1/8 x 9-1/2, Black + 1 Color 0.2706 |Offset 135.30
on front. Ink Colors: PMS 109. Paper: 24 b Wove,
White, -

ltemizing prepress and postpress charges is another matter. If you use Class
tracking in QuickBooks, you'll need to itemize. If you don't track but would like

to, go to Edit > Preferences on the QuickBooks main menu, then click
Company Preferences > Accounting and check "Use class tracking."

_ = | My Preferences | Company Preferences

23 Accounting

gy Bills

:T Calendar
g Checking
=34 Desktop View
%y Finance Charge
®a General

:ri Integrated Applicatio
it - gl e, Y

o— Accounts

Use dass tracking

Prompt to assign dasses

Show lowest subaccount only

Require accounts

Automatically assign general journal entry number
il i, i B i, Caspll . el

Invoice Range. Use it to narrow or widen the range of invoices you'll see and

can select in the pick list. Set the default to fit your invoicing schedule. If you

generally bill at the end of each day, there's no point wading through a month's
worth of invoices. "This Week-to-Date" would be a safe choice. Now and again

you'll want to click on "Last Month-to-Date" to see if you missed anything.
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FDedes :

S ettingz

Optians [tem Codes - 1 [tem Codes - 2

E=port File Mame | IMWOICES
Export File Folder | C:\MFlight

[uickBooks Template |Intuit Froduct |nvoice

Memo Text | FFlight lrvoice

T axable Code | Tax

Mon-T axable Code |N|:|n

m ZN

Setting Preferences - Tab 2

1. File Name and Folder. Based on the sample entries you see in the "Settings"
tab, your invoices will be exported into an empty C:\MFlight\INVOICES.CSV by
default. Use any drive\folder\file combination for the file that's convenient, but
limit the path to no more than one sub folder. For instance, C:\Users\Joe.
Create the folder ahead of time, then remember what you named it. The CSV
file will be purged before each export.

2. Invoice Template. If you mail or email QuickBooks invoices to your

customers, enter the name of the template you're using.

3. Memo Text. Morning Flight and QuickBooks both auto-generate invoice
numbers, and neither program cares what that number is, or whether
somebody might have changed it. That's because both track invoices internally
with different numbers, not the numbers displayed on the invoice.

As you would expect, the displayed numbers are bound to vary between the
two programs. The only function of the memo text label is to identify 1032 as
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the Morning Flight invoice matching the QuickBooks invoice in front of you. The
customer will never see it.

%\ kot

You could, if you wanted to, try to keep the QuickBooks number in sync with
the Morning Flight number, but trust me, you'd be herding cats. Besides, if you
changed the QuickBooks number and imported the same invoice again later,
the Pro 5 Importer might think it's a different invoice and create a duplicate
when it should be updating. Best to leave well enough alone and look for
matching Morning Flight invoices in the memo field.

- To be printed I Add Time/Costs... I l Apply Credits... | Payments Applied
|| To be e-mailed Balance Due

Mema | MFlight Invoice 1032
[] Enable online payment

Save & Close | [ Save & MNew

. Taxable Code and Non-Taxable Code. Both taxable and non-taxable codes

in Morning Flight have to match the codes you're using in QuickBooks. The
defaults are "Tax" and "Non" in both QuickBooks and Morning Flight.

File Edit View Favaorites Company Customers  Vendors  Employees

el '_4" Chart of Accounts Ctrl+A | o

Home Calenda Ttemn List nline Banking
—_—
 Home Fixed Asset Itern List
Price Lewvel List

E Sales Tax Code List

=

g Class List

=
P it oW & it b

%\ FJote:

Sales Tax Codes represent one of two tax related entities that must be identical
in both Morning Flight and QuickBooks for the invoice transfer to work. The
other entity is Sales Tax Items. In a nutshell, Tax Codes decide whether or not
to charge sales tax, Sales Tax Items determine how much. If your original
Morning Flight invoice includes sales tax but the generated QuickBooks invoice
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does not (or applies a different rate), check here first. Make sure your Sales
Tax Items and Sales Tax Codes are a matched set in both programs.

P

|y Sales Tax Code List =B [
Code Description Taxable
Tax Taxable Sales 4

Mon Mon-Taxable Sales

Al _ AM _ AN _ AP
S PriceEach LineltemClass F.0.B. SalesTaxltengf SalesTaxCode
— 0.0958 Digital Webster, NY Monroe Tax

Progoronces

] S ettings

[tem Codes - 1

[tem Codes - 2

Optians

| Offset
| Digtal

| Copies
| Books

| kerchandise

| Service
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Setting Preferences - Tab 3 and 4

Entries made here will change the wording but not the meaning of item codes. Call it
what you will, offset will still be classified as offset, and merchandise as
merchandise. The reason for allowing edits is to enable translations. The only item
codes you could conceivably rename in English and not change what they represent
are prepress and postpress on tab 4.

Matching Payment Terms

Morning Flight uses one set of payment options, QuickBooks another. There's nothing
you need to do here. The Pro 5 Importer will automatically bring in new payment
terms and add them to the QuickBooks list if they're not there already.

Ship
Balance C.O.L = - || 10/12/2014 I Callwhenr... = |,

Quantity Item ... Description | < AddNew > Price E... Class Amount |
500 Busine... |Business Card o 10 et 30 0.1161 [Offset 53.05 =

2% 10 Net 30

- Balance C.0.D

Consignment

Due on receipt

Met 15 2]
Customer |Thank you for your Met 30
Message |business. Met 60

Total 58.05

Synchronizing Shipping Options

Shipping options, too, are automatically imported when they're on a Morning Flight
invoice but not found in QuickBooks. Here you should probably maintain uniformity. If
an option says "FedEX" in one program and "Federal Express" in the other, settle on
one name in both programs. It's easy enough. In Morning Flight, go to File > Update
Shipping on the Main Menu. In QuickBooks, go to Lists > Customer & Vendor
Profile Lists > Ship Via List. Add or edit a method by clicking "Shipping Method."
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(et | (e Ship Vi L=]
% ShipVia ~
Zone 1 add 15 Mail
Ups
Hame | |Federal Express
DHL

® Call when ready
Pick-Up

"L Mail
UPS |
Federal Express I8

Shipping Method '” Reports 'lDIndudE inactive

11.3 Transferring Invoices into

Assuming you've completed the preliminary steps in the previous chapters, let's jump
in and transfer your first invoice. (You did, didn't you?! Get things ready | mean? If not,
you could be in for a bumpy ride!)

B Moring Fiight - V141 Gold Edition Demo b Een oy

File Log-in  Quote Price Write Estimate  Enter Order  Invoice  View Prinyﬂindow Help

RER BaRT @RS 0

PV R il L O b S N R S P eV Tt Y
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W D INVOICES
® A
WULAMEE O

Invoice Customer Amnount

<| 10412014 El

Empire Builders Inc. | 10/13/2014 s 1032014 E
ista Flight Charters 1041342014

& ACME Automative 101242014

& Empite Builders Inc. | 10/ 8/2014 Today
& The Pretzel Shop 10/ 6/2014 This Week-to-Date

Thiz Month-to-Date
Last Month-to-Date

All
Exported

Mot exported

il B = z:

Step one - Exporting from Morning Flight

!-f 1 Open the Flight Engineer (F-11).

e Go to QuickBooks > Export Invoices. You'll see the window above. Invoices
1032, 1036, and 1038 were exported earlier, indicated by the small blue icons.
Invoices 1039 and 1040 are waiting to be exported and come up checked
("ticked" for our users abroad) when the window opens.

e Because we're using real invoices for this exercise (though initially importing
them into a dummy company file), the first invoice displayed in the pick list will
be based on the range you entered under Preferences > Options. Uncheck all
but one or two invoices, then click OK. Those same invoices can later by
checked again and imported into your real company file, disregarding the little
blue icons. The checked invoices get converted to a QuickBooks-friendly file
structure and saved into the INVOICES.CSV file you specified earlier under
Preferences > Settings.
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{1}1
'13' Want to change your preferences from within the Export window? Click
the blue light bulb.

Export for QuickBooks?

2 Invoices

¢ Accept the Confirmation window that opens.

INVOICES

Imvoice Custamer

CAMPFlight\INVOICES.C5V already exists.
Do you want to replace it?

1040
1039

1020 s 6 ThAD Ak

Export Invoice File into . ..

File name:
[INVOICES CSW c\mlight

= e
@ MFiight '
wported

ot exported

Save file as type: Drives:

Comma Separated _vJ | Hc: 05 L] Netwark | % m

¢ Verify the drive, file name and folder (C:\MFlight\INVOICES.CSV in the example),

and click OK. You'll be greeted with a pop-up that asks whether you want to
replace the existing file. Click Yes.
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Done . . . 2 Invoices exported

Mumber of Jobs: 3

e Congratulations! You've completed step one. The invoices you checked are now
stored in the INVOICES.CSV file, ready to be imported into QuickBooks.

%\Mutﬁ:

INVOICES.CSV is a temporary holding file that will be overwritten every time
time you export. You can use Excel to viewits contents, but make sure you
keep the file in its original CSV (comma separated values) format if you're going
to use it for importing.

| B30 - |

A B C F | ] K
CustomerMame InvoiceDate Invoic Template Billaddrl Billaddr2 BillAddr:
Empire Builders Inc.  10/13/2014 1040 Intuit Product Invoice Empire Bu123 Main Street
Empire Builders Inc.  10/13/2014 1040 Intuit Product Invoice Empire Bu123 Main Street
Vista Flight Charters  10/13/2014 1039 Intuit Product Invoice Vista Flight Charters

L wpa e

Step two - Importing into QuickBooks

e Open QuickBooks. Go to File > Open Previous Company and select the dummy
company file we set up when we prepared for QuickBooks.

ChUsers\PublichDocumentsiIntuit\ QuickBooks\ Company Files\Dummy Company
ChUsers\PublichDocumentsiIntuithQuickBooks\ Company Files\Unitac
ChlUsersiPublic\Documents\IntuithQuickBooks\Company Files\Printfire

Set number of previous companies..,

e Open the Transaction Pro 5 Importer. Under Select your file source choose "File"
and browse to the INVOICES.CSYV file we exported earlier. Make sure the rest of the
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fields are identical to what's shown in the window below.

Welcome to the 01 Transaction Pro Import
Transaction Pro Wizard Application.

Thiz program will guide you through the steps necesszan to

Impu[‘ter 5.0 import data to QuickBooks as transactions or lists.

The imported data will be stored in wour CuickBooks comparny
[QBW file.

A

Select your file source: (+ File " DSH
ll::"xh-1FIig|P'|t"~II‘\lR-’EIII:ES.I:SR-f Browsze. .

upiter and new record character:
Record {EH /LF v}

Select a QuickBooks transaction or list to import:

Import Type ]Im-'l:uiI:E I_.J

! \ " Program Options: Options
Dezigned for ug :

Yerzion 5.013

¢ Click the Options button. In the window that opens, select the Basic tab and
check the three options that are checked in the example.

Yendor Transaction Options
[~ Lookup“Yendar Mame in QuickBooks when Account Mumber is Mapped to Yendor Field

Tranzaction Reference Numbers
[+ Let QuickBooks Auto-fssign lnvoice Mumnbers

Lizt Items

I Do not update addreszes on exristing QuickBooks List lkems
[T Do not add new custarners o QuickBooks

[T Donot add new wendors to QuickB ooks

[T Do not add new items to QuickBooks

[T Do rnot add new accounts to QuickBooks

[T Dornot add new emplavess to QuickE ooks

Import Options

[+ “alidate file before importing - attempts ta first save sach tranzaction [catches most emrors)
[¥ Truncate import field data that exceeds maximum length allowed by QuickBooks
[~ Clear Tranzaction Bill ta/Ship to Address when imparting
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i Fiote:

Once you're done experimenting, read the Transaction Pro 5 help file, then adjust

any other preferences to the way you use QuickBooks. For now, ignore the
Advanced and e-Commerce tabs.

¢ Click the Next button. You'll see a preview of the invoices you're sending to

QuickBooks.
File Contents D'ata in gnd can be edited befare sending to QuickBooks
Record # | Cuztomert ame | Invoicellate | InvoiceMum | PO Mumber | Temms | Templat
1| Empire Builders Inc. 10/13/2014 1040 Balance C.O.D Intuit Pre
2| Empire Builders Inc. 10/13/2014 1040 Balance C.O.0 Intuit Pre
3| Wizta Flight Charters  10/13/2014 1039 2% 10Met 30 Intuit Pre
¢ Click Next.
tdap the figlds in your file to the GuickBooks fields: Select the row of the field pou want to map and
chooge the matching CluickBook s field from the drop-down lisk. Bepeat thiz for all the fields you want to
map to QuickBooks. Clicking the Mext button sawes the curent map, ovenariting any existing map.
C:MProgram FilezhPrintfireMormingFlightsbaF Ineoicekd ap. dat
QuickBooks Fields Import File Columns Static Yalue/Formula [ =
Custarner CustarnerM arne _ i
Tranzaction D ate Invoicelate _
R et umber Iroicet um _ E
PO Mumber PO MHurnber _
Terms Terms =
Clazz
Template Mame Template [ E—]
To Be Printed T | —
Ship Date ShipD ate | —
BilToLinei Bilsc ——
BilToLine2 Bilhci2 —)
BilToLine3 Bl ——
BillTo Lined
BilTo City BilCity [ ——
BillTa State Bill5tate [
BillTo PostalCode BilPostalCode |
Fieldz marked in red are required Field Match | Load Map | Eos | Clear Map |

¢ No need to map fields. Morning Flight V14.1 versions come with a predefined
map in your active Morning Flight directory (C:\Program
Files\Printfire\MorningFlight\ by default). Click the Load Map button in the
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window above, then locate the "MFInvoiceMap.DAT" file. Highlight the file to
select it and click the Open button.

%\ kot

You may want to make a copy of the original map file, paste the copy into the
folder containing the INVOICE.CSV file, then load the copy as your map
instead. That will safeguard the original should the copy get scrambled. True, we
could send you a replacement, but it's quicker to just copy and paste.

Organize * MNew folder =~ [0l @

=

& OneDrive X Mame Date modified Type

5| Recent Places

%] MFlInvoiceMap 10/13/2014 8:40 AM  DAT File

4 Libraries =
@ Documents
Jﬂ Music

[&| Pictures

B videos

m

*& Homegroup

18 Computer - || m | b

File name:  MFInvoiceMap - ’Map Files (*.dat) VI

| Open v | Cancel ]

e We're almost there. Keep in mind that most of what we've done until now is set

defaults and preferences. In a production setting, it's largely a matter of clicking
Next a few times, then clicking Finish to complete the import. All of the entries,
including the map location, will already be filled in.

In the final window (shown below), accept the default settings, then check the box
"Save all Settings" at the bottom. It's unlikely you would create items under an
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account other than "Sales," but if do, you'll want to select the account you're going
to use when importing invoices into your real company file.

After Transaction Pro 5 Importer confirms that your invoices have been imported,
don't click Next, click Cancel instead. | know, there should probably be an Exit
button for that, but we had no voice in designing the program. Except for that one
little niggle, we really liked the Pro 5 Importer. | think you will, too. Beats keying in
invoices by hand - by a mile!

= QuickBooks tem Settings
Transaction Pro 2

When creating QuickBaooks ltems, uze the fallowing item type:

- ‘.ml rter 5.0 tern Type: !Nu:un-lnventu:ur_lrl Part ;i
Create ltems Under the Faollowing QuickBooks Accounts:
Aocount: I S ales ;i
COGS Account:

[nzome Account:

Azzet Account:

Sales Tax Code: iTE“"

L]

¥ Save Al Settings

[dle

Activate | Help | < Back | Eirizh LCancel

11.4 Importing Customers from

Compared to working with transactions, getting lists in and out of QuickBooks is
pushbutton-simple. With one notable exception: Tax Districts. They're easy enough,
just something we have to take care of before we start importing.
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When Morning Flight imports an invoice for a new customer into QuickBooks, it also
imports that customer's billing information and tax district. What it doesn't import is
the TAX RATE for the district. That's standard relational database practice. Hundreds
of customers can have the same tax district, but the rate for that district is stored in a
single location outside the QuickBooks customer file. When it's changed in that single
location, the new rate is applied to any new invoice that references that district.
Imagine what would happen if the rate was stored embedded with the customer and
the County changed the rate and you'd have to look up every single customer affected
by the change and update their tax rate individually - it would be a nightmare!

If you have scores of districts to contend with, the quickest way to sync them is to
print the QuickBooks item list, then make sure the districts and rates you've set up in
Morning Flight are identical to the sales tax items you've set up in QuickBooks.

To print the QuickBooks item list, go to Lists > ltem List, then Reports > ltem
Listing. To view tax items in Morning Flight, go to File > Update Taxes.

L} Ttem List o | = ]
Look for in | Al fields = Res

Mame Description Type Account Price Attach
+Manroe Sales Tax Sales Ta... |Sales Tax ... 8.0%
+Tax Free Sales Ta... |Sales Tax ... 0.0% B
Itemn = “ Activities = | I Excel = ” Attach I [7] ndude inactive
QuickReport: Genesee Ctrl+Q
Rrpmeisise
Itern Listing
Reports on All Itemns r

Receive

-;JJ**_.JM*L&WHJ-W
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The Transfer - Step by Step

-E,g, New Customer & Job - lew Transactions » [gg Print » Iﬁ Excel » tEI Word » E! Collecl

[ Customers & Jobs 1 Transactions Customer ]“farr“! Export Customer List...

mr d_ Lok Teancachione

View | Active Custo
COVE LUStomErs What would you like to do with this report?

Find >
() Create new worksheet
# Name ~ Baland {7 Update an existing worksheet How it works
+VISTA Charter Flights
. o ") Replace an existing worksheet

+The Pretzel Shop

+International Publishin...

@ Create a comma separated values {csv) filei

1. Open QuickBooks, then go to Customers > Excel > Export Customer List.

2. When prompted, enter the folder into which you want to export your
QuickBooks customer file (C:\MFlighttQBCUST.CSV by default). Use any
drive\folder\file combination that's convenient. If you already have a folder for
invoices, no need to create a second one. Use the invoice folder instead.

CAUTION: If you should happen to open the CSV file in Excel, don't update or
save it. Close it without saving any changes. Excel has a habit of adding
formatting options even when you tell it not to, making the file useless for

importing.
P 3
Save in: | MFlight - @& = G-
i Name Date modified Type
el GOINVOICES  11/21/20149:30 AM  Microsoft Office Excel .
RecentPlaces  @hopcyst  11/21/201410:24 .. Microsoft Office Bxcel .

‘k T P R e TSR T

3. On the main menu, got to File > QuickBooks > Import Customers from
QuickBooks.

4. Click the Payment button to enter your most common payment terms.
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5. Click the Tax District button and do the same for sales taxes.

ﬁ Fote:

When Morning Flight can't match up an incoming tax district with a tax district
in its own database, it defaults to the district you designated as your "most
common.” That's the district you see below. On average that will work, but it's a
double-edged sword. Most of the time is, well, most of the time. If your
QuickBooks tax rates don't match your Morning Flight rates, at some point
you're going to get messed-up invoices.

Fayment

Irnparted

GuickBooks
" QuickBooks 2014

b anroe

File M arme

QBCUST I Omit if Duplicate

v Omit if Mizzing Address

File Falder

- v Omit if Inactive
C:MhaFlight

o Z0

6. Enter the File Name and File Folder for the Excel CSV file you exported from
QuickBooks in step 2. It's OK to leave off the CSV file extension when you enter
the name.

7. Select your version of QuickBooks - 2013 and earlier, or 2014 and later.

8. Finish up by setting your preference for omissions, then click OK.

0. E When the transfer is complete, click the Import Log button, or go to File >
QuickBooks > View Import Log.
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Imported Why Mot
o Al

i International Publishing| 17 Swigs Cottage | 11/22/20014
ACME Autornotive 438 Dearborn &ver) 11/22/2014
WISTA Charter Flights | 436 Hylan Drive & [yplicate

Uritac International Ing 15 Anthory Circle ® Dyplicate

The Fretzel Shop Studio 45 ® Dyplicate

" Imparted
" Duplicate
" Incomplete

[ Inactive

'#’ e, th QF'H

Preview and Update as you go

During the transfer you'll have a chance to edit customers as they're being imported. |
can tell you from experience, the time you set aside for that will be time well spent.
Making corrections now is so much quicker and easier than having to go through all
your customer records later. About the buttons: To save the customer on display and
bring up the next, click OK. You can bypass a customer by clicking the arrow button,
third from the left. To terminate the transfer, click the exit door.

Copied to Morning Flight Payment 3
['ue on receipt

ritac International Inc. 15 Anthaor Circ

WISTA Charter Flights 436 Hylan Drive

Campary The Pretzel Shop Cantact Bruce Baker

Address Studio 45 Informal P [Dear Bruce:
435 Park Avenue FPhaone 555-3662

City Fochester Fax
State/Zip NY || 14807 eMai bruce. baker@live. com
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One final note: When you're merging your QuickBooks list with your Morning Flight
list, you're going to get duplicates. If the "Omit if Duplicate" box was left unchecked,
enough duplicates possibly to put you into an endless loop. Reject one alert and up
pops another. Here is how to get out: Click the magnifying glass in the alert box. The
object is to preview the about to be duplicated customer. Which it will, and you can go
on from there. But thankfully you also get an exit door to terminate the transfer - and
restart it with the "Omit if Duplicate” box checked this time.

Duplication?

'ou entered:
The Pretzel Shop

Already an file:
The Pretzel Shop

Enter angway?
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12 Managing your Prices

12.1 Matching your Offset Prices

265

This topic describes how to match Morning Flight offset run prices to the prices you

were charging before you installed the program. The objective is to find an hourly
press rate that will do that. While the press rate contributes the lion's share, other

factors also play a role in the price of your products. Before you can start matching

prices, you first need to

1
2
3
4

. Set your hourly prepress rate
. Set your film prices

. Set your packaging prices

. Set your preferred quantities

How to synchronize your Prices

_EI{ Click the My Shop button (or click File > My Shop).

Click the Presses button, then double-click the 1-Color Offset press.

e In the window that opens, click the letterhead icon. It's the first one on the left.

The next two represent envelopes and catalog sheets.

Letterheads
1.000
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e Click the up arrow to select the lowest quantity. Most likely, the price for that
quantity is different from the price you're charging now for one-color letterheads
(excluding the cost of paper). Keep adjusting the hourly press rate until the new
price comes close to your current price. Write down the quantity, the hourly press
rate, and the price at that rate.

e Click the up arrow to select the next two quantities, then repeat the price
adjustment described in step four above.

¢ Click the envelope icon and repeat steps 4 and 5 for one-color envelopes.

¢ Click the catalog sheet icon and repeat steps 4 and 5 for one-color catalog sheets.

At this point, you'll have a total of nine one-color rates, derived from three different
products at three different quantities. Those hourly press rates will all be different, but
with luck they'll be close and you'll have an easy time deciding on a happy medium. In
the table below, $100.00 would be a good starting point ($899.90, the total of all nine
hourly rates, divided by nine).

If you rarely print one-color envelopes, you could omit them from the equation and
divide $613.10 by six, for an average hourly one-color rate of $102.00.

1-Color Letterheads Envelopes Catalog Sheets
Price Press Rate Price Press Rate Price Press Rate
565.00 599.60 578.00 593.60 585.00 5102.80

5105.00 5103.00 5135.00 596.70 5135.00 5104.20

5155.00 $101.00 $210.00 $96.50 5200.00 $102.50

As you would expect, there can be only one hourly press rate for one-color. If there's
a significant gap between the rates you've written down, experiment with plate costs
and your hourly prepress rate to bring them in line. Keep in mind that the press rates
you set here will affect all your products, not just letterheads, envelopes and catalog
sheets.
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Once you're satisfied with your one-color offset prices, repeat the process for two-
color and four-color.

12.2 Matching your Digital Prices

This topic describes how to match Morning Flight digital run prices to the prices you
were charging before you installed the program. The objective is to find press rates
and click charges that will do that. Before we start, you'll first need to

1. Set your packaging prices
2. Set your preferred quantities

How to synchronize your Prices

r=

—azu  Click the My Shop button (or click File > My Shop).

¢ Click the Presses button, then double-click the 1-Color Digital press.
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Herox RS

—
L=

100.00 SRFE
100.00 Back

=
[}

Mirirmum Charge

t akeready JUN 10 Minutes

o
o

Price of 100
11 x 17. Black 1 Side

fur Margay —

Click Charges

1 - 499
500 - 933
1.000 - 4333
5,000 - 3,599
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0.0600

0.0500

0.0400

0.0300

0.0200

WiE E 0.0050
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¢ Click the up arrow to select the lowest quantity you want to start out with (from a

choice of five). Most likely, the price for that quantity is different from the price
you're charging now for black digital, excluding paper. Keep adjusting the hourly
press rate and click charges until the new price comes close to your current price.
Write down the quantity, hourly press rate, click charges, and price.

¢ Click the up arrow to select the next two quantities, then repeat the price

adjustment described in step three.

%\ kot

Click charges in the light gray panel are prices, not costs. They're what you
charge your customers. "we pay" is what the vendor charges you. Note that the
price in the upper black panel updates as you complete each entry.
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At this point, you'll have a total of three rates for three different quantities. Those rates
will vary, but with luck they'll be close and you'll have an easy time deciding on a
happy medium. In the table below, $85.00 would be a good starting point ($255.20,
the total of all three hourly rates, divided by three).

As you would expect, there can be only one hourly rate for digital black. Once you're
satisfied with your black prices, repeat the process for color.

Current Price Press Rate Click Charge
550.00 586.50 50.03
595.00 585.00 50.03

5230.00 583.70 50.03

12.3 Pricing Products

Before we explore how to price Morning Flight products, let's first define what a
product is. Technically speaking, it's a container. Something to hold sheet sizes,
makeready, press speed, plate type. A template then, in plain English? Well, sort of,
but not exactly. When we think of templates, we see half-finished, fill-in-the-blanks
frameworks, with placeholders telling us where to put the missing bits. In contrast,
Morning Flight products are completely finished, ready to use as is. They can stand in
as models for making other products, and in that case they do act like templates, but
generally they're used straight out of the box.

Take a letterhead, for instance. As a template, that letterhead might have its size and
plate type hardwired. Makeready and press speed stay open, to be filled in by the
estimator. In a Morning Flight product, makeready and press speed are hardwired as
well. Everything is. Except we would probably have at least three different letterheads
in our product line-up: A standard, run-of-the-mill corporate version, a letterhead with
just an address on top, and a demanding prima donna with an exact color match.
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The Benefits

Ok, so what can a product do that a template can't? First and foremost, a mockup of
the job that needs to be quoted can be compared to some predefined products. Even
buyers unfamiliar with printing can match their mockup to one of your samples. Your

estimator does his job once, attaching makeready and press speed and other factors
when creating each product. Few buyers would have the skills to do that. If you want

to sell printing on line at different price levels, you can show pictures that reflect each
level.

Along similar lines, cousin Mel can now be entrusted to do most of the low-end
guoting, leaving complex and more important projects to a professional estimator. In
the smaller shops that's likely to be the owner or manager. Between helping with
production and pacifying customers and filling in for employees out with the flu, she's
hardly the person who should estimate ten-dollar jobs that rarely materialize anyway.
Cousin Mel, on the other hand . . .

Finally, products open the door to automation. Few consumer products are more
automated than digital cameras. How automated would those cameras be if they had
to work with templates, if exposure and focus had to be dialed in for each picture?
With Morning Flight products, parameters are inherent. That allows the program to
intelligently increase press speeds as run lengths go up, make sure letterheads don't
get printed on card stock, calculate ink consumption based on coverage, keep
envelopes from being folded ... the list goes on. Products just generally make life
easier.

How do we price Products?

Actually, we don't, not directly. Copy products and wide format are notable
exceptions. On offset products, Morning Flight integrates the properties of the product
with the hourly rate of the assigned press, reads the quantity, and comes up with a
price. On digital products, it's the size and ink coverage of the product that combines
with the properties of the press (hourly rate, run speed, consumables and click
charges) to determine the outcome. It's a little more complicated than that - a host of
other factors get pulled into the mix - but in principal that's how it works.

© 2018 Helmut Heindel



Managing your Prices 271

What separates Wide Format

In a word, technology. And to a lesser extend, the internet. Evolution in this field is so
rapid that press-based pricing just isn't practical. What keeps pulling the rug out from
under us isn't just the onrush of new inks and hardware, but where and how wide
format products are being used. Think fabrics for interior decorating, and contour-cut
decals that hardly anyone associates with ‘wide'. When you factor in the internet,
prices driven by costs go out the window as well. Think Vistaprint.

What's left are value-driven prices based on size, substrate, and what our regional
market says they should be. If we can't produce wide format for that, we probably
shouldn't be in the wide format business. And if we're planing to sell wide format
online, we really do need to look at Vistaprint and other high volume vendors selling
banners on the internet. Not to get our prices down to their level necessarily, but to
see whether a snazzier banner is the knife we want to bring to the gunfight.

It took nearly a hundred years for print marketing to catch up to how Henry Ford
priced the 'Tin Lizzy'", his revolutionary model T automobile. In "My Life and Work"
published in 1922, he writes:

"We have never considered any costs as fixed. We first reduce the price to the point
where we believe more sales will result. Then we go ahead and try to make the
prices. We do not bother about the costs. The new price forces the costs down."
That's a shining example of value-driven marketing, far beyond giving people what
they want. Henry also wrote: "If | had asked people what they wanted, they would have
said a faster horse." Ahead of his time, old Henry was.
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Why Copies are different

Copies are priced per copy, so here the product alone determines the price. And
that's what separates Morning Flight copies from Morning Flight digital. With
advances in copier technology, the clear dividing line that once existed between the
two methods - toner versus ink - has blurred. Many copiers now serve as digital
printers. Today, it's no longer how the image is put on paper, but which pricing model
best fits your needs.
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Copes

1.000
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[30% coverage, 1 zide]
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Mo Charge

-49 0075 75coents

-95 0070 T cents
0065 | E5 cents

Miniiruirn . 0.060 E certs
RIF 12.00 s 0055 | 5.5 cents

B cents

CommonSenze Pricing

12.4 Pricing Paper

For years, paper pricing in Morning Flight was linked to volume. The price you quoted
your customer depended on the size of the order you placed with your vendor. Was it
for less than a carton, a full carton, or so many cartons the commission alone would

buy the sales rep a weekend in Vegas?

Later we opened the Morning Flight Forum and discovered that most printers now pay
the same price no matter how much paper they order on any given day. That's true at
least here, in the U.S., though I suspect a nice discount might still be on the table if
the order was large enough.

That kind of pricing policy may not make sense from a marketing perspective, but
happily, we don't make the rules. Our job is to make sure Morning Flight can deal with
them.
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Category

Mame

Carton Content

We pay per 100 Ibs

Less than 1 Carton
Full Carton

B Cartohg ar more

b anual Entry

Pricing Options

per 100 |bs

by Copy Baond

2400

“wihite:

Colars

33.00

45.00

26.00

3000

17.9

2067

“AQv ZD

All paper categories let you enter paper costs per 1,000 sheets, in three different
guantity brackets. The number of cartons in the final bracket is user adjustable, and

each paper item can have its own custom markup. Starting with version 13.1, all
three categories now offer a check box to prevent paper from being priced in broken

reams or partial boxes of envelopes.

Custom and in-Stock paper add another layer of flexibility. There you can enter costs
either per 1,000 sheets or per 100 Ibs (50 kg when the program is set for metrics).
For bracket configuration, you have a choice of cartons only, weight only, or cartons

up to a full carton, and beyond that by weight.
%\ b e

In the next window, left-clicking within the red circle will increase the number of

cartons, right-clicking will lower it. Clicking anywhere else in the area pointed to

by the arrowwill change the bracket configuration. Be sure to match up your

configuration with how the paper is sold by your vendor. Entering a cost for 100
Ibs. when your entry is set for 1,000 sheets will get you a bad price in a hurry.
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We pay per 1,000 sheets
11«17

Lesz than 1 Cartan 35000

Carton 350,00
e- oh af mol Ja0.00

One-Frice Lock
e |
a0 Zm

What the Buttons do

o

5 , .
pry S Clicking the Manual Entry button makes all cost fields available for manual
entry. The only rule is that you can't sell less for less:

1. The cost in the full carton bracket can't be less than what you've entered in the
multiple carton bracket, and

2. The cost in the broken carton bracket can't be less than what's in the full carton
bracket.

& Clicking the Auto-Price button speeds things up because you need to enter
just one value - your paper cost in the full carton bracket. Costs in the other two
brackets are automatically recalculated to common defaults. Because the program
has no way of knowing what's in your vendor's price book, these costs are estimates.
Likely to be good enough for 500 letterheads but not for 10,000 catalog sheets.

Clicking the One-Price button ignores brackets and applies the full carton
vendor cost regardless of quantity. You could still see a difference in the cost +
markup price charged to the customer if you're using sliding-scale markup rates. For
instance, a 25% markup in the full carton bracket and 30% if less than that.

“ Clicking the Color button will price in-Stock color paper the same as white.
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%l Fiote:

The color button is found only in the in-Stock window. With the other three buttons, it's
either manual, auto-price, or one-price. Only one can be active at a time. The entry
method in use is displayed at the bottom of the window. It's attached to the paper item
to which it applies, but can be changed during edits.

Wwe pay per 1.000 sheets

W hite: Colors
Lezz than 1 Carton 33.00 33.00
Full Cartaon 26.00

¥ Cartans or mare

12.5 Setting Paper Markups

Setting up paper markups ought to be simple. Far too many printers forgo markups
entirely and think it's Ok to sell paper at cost. That being the case, why not settle on a
single markup rate and be done with it? Absolutely - no reason not to.

On second thought, better make it two rates. The best way to motivate buyers to
select paper we have on the shelf is to reduce the markup on it. We definitely want to
encourage that. Three rates then, one for paper we keep on hand, one for paper we
have to order as needed, and a third for blank second sheets. Ok, we're good. Let's
run with that.

No, wait. Shouldn't we use smaller markups on larger quantities? Good point. So nine
entry boxes to fill in. Still, simple enough, all things considered.
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Paper Markups

In-Stock  Bug-t Blank

Lezs than 1 Carton 45% 45%
Full Cartan 40 40
3 Cartong or more 3 35

by Substrates | v Usze CammanS ense Pricing
11

Except, and | don't mean to throw a wrench in it, shouldn't we also have custom
markups for exceptional projects? "Make 'em up as you go" rates we can apply, like,
whenever? Why, yes, we should.

You can see where this is going. Our simple train has left the station. Ditching general
markups altogether and relying solely on custom markups for each individual item
isn't such a brilliant idea either. Who'd want to update hundreds of paper records, one
at a time, when it's time for a markup makeover? Proving once again that KISS
(Keeping It Simple Stupid) and functionality don't always go hand in hand.

Setting General Markups

The markup rates you enter into the nine boxes in My Store are what Morning Flight
uses by default, based on paper category and quantity. If you want to use a single rate
across the board, just enter identical rates in all nine boxes.

In the window below, the little gold triangle points to the quantity in use. The 25% rate
is linked to the settings in My Store. Had the quantity been three cartons or more, the
markup rate would have dropped to 20%.
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Working with Custom Markups

Here is where it gets interesting. A little difficult to decipher maybe when you first
encounter the buttons, but scratch the surface and you'll discover a mechanism
that's still simple.

Worth noting is that custom markups are an option not only when you make a quote,
but also when you set up or edit paper. You could, if you wanted to, give every paper
item in every paper file a different markup rate. And then spend way too much time
keeping track of it. Seriously - don't even think about it!
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per 1,000
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b Bond

M arme Copy Bond

Carton Content 5,000

%11
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Mo partial reams Less than 1 Cartan 1575 2250
Full Carton 1050 15.00
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Ik aral E ntry
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Take a peek at the four radio buttons. You'll note they've been graphically separated
into two groups. The first button is dynamic, linked to the markup rates set in My
Store. The next three are static, totally independent, producing fixed markup rates not
linked to anything. Not to quantity, not to category, not to My Store. When the markup
says 10%, ten percent is what Morning Flight adds to our cost. Values range from 0%
- 20%, 25% - 45%, and 50% - 150%.

Let's revisit the first button. Here you can fine-tune the markup rate coming in from My
Store by left-clicking or right-clicking the black slider. Each click increases or lowers
the markup by one percentage point. The effective rate will vary, depending on the
guantity in use.

In the example below, the quote calls for a full carton. The slider is set at its lowest
point, so the markup drops two percentage points, lowering it from 25% to 23%.

b arkup
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So to recap, the first button offers a two-point adjustment, up or down, for each of the
nine markup fields in My Store. Because the slider gets its mid-range value from My
Store, when you adjust a general markup rate in My Store, the custom rate rides
along with it.

The next three buttons serve up a flat, permanent markup rate, regardless of the
guantity or the type of paper. What you see is what you get. Down to, and including,
zero - no profit of any kind. Sometimes, in the real world, often less. But you already
knew that!

12.6 Pricing Ink

Not much to cover here. Every entry will be self-explanatory to anyone who's ever
worked in an offset shop.

Update Buy-It Paper L | |
Update Inks » Update Inks

Update Merchandise Update Ink Pricing

T T
L B i A T
-

Update Taxes f S el ]
iR o el e | oy )l A ™

© 2018 Helmut Heindel



Managing your Prices 281

Color Charges Our Costs

We charge

Washups [v Dark Calor
Iv Light Calar

[ 4-Colar

Iv Custom Colar Mix
[v Cloze Begister

Rk Z:M

e From the main menu, go to File > Update Inks > Update Ink Pricing.

¢ Enter the prices you charge for washups and extras. Uncheck any item you plan
to offer free of charge. For instance, it's common for shops that specialize in
four-color process to not charge for process color washups. If you uncheck the
light color box but leave the dark color box checked, Morning Flight will price light
colors the same as dark colors.

¢ Click the Our Costs tab and enter what you pay per pound or kilo. Consumption
is automatically calculated by the program.

per pound

Black. Ik

Spot Color Inks
4-Colar nks
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12.7 Pricing Prepress

This topic describes how to price composition and other prepress charges for offset,
digital, and copies.

pw

Composition | Filrn | Photes | Proofs

Composzitian £0.00 | per hour
Miniraurn 10.00

B1u11 . Medium 1 ” 30 | Hourz: Minutes

Prepress 4500 | per hour

Rk Zs0

ngf From the main menu, click the My Shop button.
¢ In My Shop, click the Prepress button.

¢ Enter the hourly rate you charge for desktop publishing, then enter the hours
and minutes it takes to compose an 8-1/2x11 or A4 page of medium complexity.

%\ bk

Complexity is a property assigned to each product. For standard letterheads,
the complexity is set to medium. That's user-adjustable when you update the
product. If you prefer, you can enter actual hours and minutes instead. Here are
the values that result when you enter 1:30 hours for medium:
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Composition
Very Heavy
Heavy
Medium

Light

Very Light

Percent Hours/Minutes
220% 3:18
150% 2:15
100% 1:30

60% 0:54
30% 0:27

¢ Enter the hourly rate you charge for other Prepress operations, such as

imposition and stripping.

¢ Click the Film tab. Check the Camera and Imagesetter boxes as appropriate.
This tells Morning Flight what type of equipment you have. If both boxes are
unchecked, your only film choice will be Outsourced.

Composzition

Eilrn | Photoz | Froofs |

v [mageszetter

v Camera

Outzourced

Color Separations

e Click the Photos tab. Enter the prices you charge for Black and White and
Color Scans. It's common in the industry to offer discounts. If you do, enter the

guantity range and discount percentage.
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Comnposition Eilrii Phatasz Proafs

Photos Jek s a0

B’ Scan

Color Scan

v Dliscount

¢ Click the Proofs tab. Check the boxes as appropriate, then enter prices and
discounts.

LComposition | Eilm | Photoz Froofz

Proofs kdirirnim

I+ Lazercopy

| Colorcopy

| Matchprint
v Dliscount
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12.8 Pricing Custom Prepress

This topic describes how to price My Prepress for offset, digital, and copies.

Pm

Compozitian

by Prepress

| Composition £0.00 | per hour
Py Proofs Minirmum 10.00

B1u11 . Medium 1 ” 30 | Hourz: kMinutes

Freprezs 45.00 | per haur

Rk Z:0

.glf From the main menu, click the My Shop button.
¢ In My Shop, click the Prepress button.

¢ In the prepress pricing window, click the My Prepress button.
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M arne Setup Frice

kinirmum

LAY

Wwe deduct

| File Conversion

Setup Price

| 850

10%

¢ Enter the Name of the custom prepress item.

e Enter the Price and, if applicable, Setup and Minimum charges.

© 2018 Helmut Heindel



Managing your Prices 287

e If you decide to make the item eligible for a quantity discount, check Discount,
then enter the percentage and respective quantities.

%\Mutﬁ:

In the example shown for file conversion, you would grant a 10% discount for
converting 3 to 9 units, and a 20% discount for converting 10 units or more.
Those units would likely be pages, but could just as easily be a time value - 10
minutes per unit, for instance.

12.9 Pricing Custom Proofs

This topic describes how to price My Proofs.

Pm

Composzition | Film | Photoz Froofs

v Lazercopy

ky Proofs v Calorcopy
[ Matchprint
v Dizcaunt
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.gl{ From the main menu, click the My Shop button.
¢ In My Shop, click the Prepress button.

e In the prepress pricing window, click the My Proofs button.

74 Begb

[v 1-Color

[v 4-Calor

by 1C Proof

5.00 ||

by 4C Proof

10.00 ||

10.00

B Z:0

e Check the 1-color and 4-color boxes, as appropriate, then enter the Name,

Price, and Minimum Charge for custom proofs.
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12.10 Pricing Postpress

This topic describes how to price postpress and finishing operations for offset, digital,
and copies.

pm??itw

Cut/Dorill | Fold | ScoredPert Laminate/Mum/FPad

.. Cut/Drill

Setup 1000 Minirnurn
Size Limnitz

Cut Band | amof 150

birirnum per cut

3-Hole Drill Bord E

Our dill haz € 1 Spindle
f+ 3 Spindles

RiEs Z:[0

_glf From the main menu, click the My Shop button.
¢ In My Shop, click the Postpress button.

¢ Enter the prices you charge for Cutting and Drilling writing-grade paper (24 Ib /
90 gsm).

%\ kot

Morning Flight will automatically compensate for the greater thickness of cover
paper and adjust pricing. Note also that the four cuts needed to cut 3-1/2x8-1/2
note sheets out of 8-1/2x11 in the example below will stay at four, regardless of
whether you're cutting 500 sheets or 5,000. The price of $5.00, on the other
hand, will increase for higher quantities because the blade has to come down
more than once.
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Mote Sheets
[3-Lip]

Filrn Uit
Shrippitig

0.60

¢ Click the Fold tab. Enter the prices you charge for folding. Uncheck the Cross
Fold Bond box if you don't offer right-angle folding.

CutADorill Ecld | SooredPerf | Laminate/Mum/Pad Stamp

Setup 1000 Minimumn
Size Lirnitz

Single Fold Bond 5.00 |

Cower

Letter Fold Bond 2,00 |

Cover

W LCross Fold Bond | 3000

e Click the Score/Perf tab. Enter the prices you charge for scoring and
perforating. Uncheck the Right-Angle Perf box if you don't offer right-angle
perforating.
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LoDl | Eold Score/Perf LaminateMum/Pad Stamp

Score/Perforate Setup 1.000  Minimum
Size Limits

Score | 1500 1500

Straight Perf 15.00 15.00
v Right-fingle Perf 25.00 3000

¢ Click the Laminate/Num/Pad tab. Check the boxes as appropriate, then enter
the prices you charge for laminating, numbering, and padding.

Cut /il | Fold | ScoesPert LaminateMurm/Pad Stamp

m Laminate/Mum/Fad Setup 1.000  Minimum
Size Limnitz

¥ Laminate - 8%:11 [ 10.00] 3s0.00]

¥ Number | 1s00f 2300

Pad Carboniless E
FPad Eond per pad Q.30

¢ Click the Stamp tab. Check the boxes as appropriate, then enter the prices you

charge for foilstamping, diecutting, and embossing.
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Cut /Dl | Eold | ScoresPer LaminateNum/Pad Stamp

Setup 1.000  Mikirum

Size Limitz

v Foilztamp
v Diecut
v Emboss

Failztamp Die

Embozzing Die

¢ Click the Size Limits button. Enter the minimum and maximum sheet sizes your
cutter and folder can accommodate.

Firirnrn Cut
;3

b airnearn Cuat

irirnurn Fold

b a=irnuarn Fold
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12.11 Pricing Custom Postpress

This topic describes how to price My Postpress for offset, digital, and copies.

Size Limnitz

r'.'1_lrl E|:|:5:t|: Bag

| ScoredPert Laminate/Mum/Fad

Cuts/Dnll Setup 1.000  Minimum

Cut Bond o0 150

birirum per cut

3-Hole Drill Bond E

Qur drill haz " 1 Spindle
[+ 3 Spindles

ik Z:M

ngf From the main menu, click the My Shop button.

¢ In My Shop, click the Postpress button.

e In the postpress pricing window, click the My Postpress button.

293
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Wf;z Pm

M are Setup Frice kdinimum

LAY

Click the Add button.

We charge 24.00 per 1.000

Friced per f+ 1,000 " Jaob " Set

| Found Cornering |

Setup Price Mirirnum

| 100 2400 |

DEE Z0

e Select whether the item is to be charged per 1,000 pieces, per job (a one-time
flat rate), or per set.

© 2018 Helmut Heindel



Managing your Prices

e Enter the Name of the item.

e Enter the Price and, if applicable, Setup and Minimum charges.

%\ Hiote:

If the item is priced per set, you'll be asked to fill in the number of units that make
up a set when you're doing the quote or entering the order.

.
T ;‘;_1
| Laminate/Mumber/Fad

Cut/Drill#Fald Ferf/Score

B MyPostl [ 200][ ¥ 5] percet
Shrinkwrap in Setz

I M y Pozt 2
o ..

295
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12.12 Pricing Bookbinding

This topic describes how to price bookbinding for offset, digital, and copies.

. o .

Collate | Saddlestitch | Perfecthind Staple GBC/Cail e | by Bind

Size Limnitz

Collating Setup 1.000  Minimum

W Flat Sheets E

Collatar Stations

WV Folded Sheets [ 1a00]

Collatar Stations a

By Hand Tl EE

ik Z:M

ngf From the main menu, click the My Shop button.
¢ In My Shop, click the Bookbinding button.

¢ Click each tab and enter the prices you charge for Collating, Saddlestitching,
Perfectbinding, Stapling, and GBC/Coil/Wire binding.

¢ Click the Size Limits button. Enter the minimum and maximum sheet sizes
your bookbinding equipment can accommodate.
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W axirum 5 addle
Mirirnurn Perfect

— Maximum Perfect

If you need to set up custom bindery, click the My Bind tab, check Custom Binding,
and enter the price you're going to charge per book.

For custom pads or carbonless forms where

1. the copy or run configuration may differ between sheets,
2. the sheets may be of different size, coating, or color,
3. the carbonless form may have a heavy backer,

check Custom Padding to make that option available for quoting.

Colate | Saddestich | Perfectbind | Staple | GBC/Cailfwire My Bind

Custom Binding Setup per Book  Minimum
Size Limitz

W Custom Binding | 1] oz

Frice includes [ Callating

¥ Custom Padding | soof oosof

Price includes [v  Caollating
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%\Nﬂtﬁ:
Custom binding and padding are derived from GBC/Coil/Wire and use a similar
pricing formula. Covers are presumed to be flat, not wraparound.

12.13 Pricing Packaging

This topic, what there is of it, describes how to price packaging.

We charge

v Letterbos
[v  Bizcardbox
[v  Shrinkwrap
[v Cartan

Rk Z=0

ng* From the main menu, click the My Shop button.
¢ In My Shop, click the Packaging button.

¢ Enter the prices you charge for Packaging. Morning Flight automatically
determines how many sheets will fit into a box, shrink package, or carton.
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12.14 Pricing Custom Packaging

This topic describes how to price My Packaging.

Prchaging oke

e

We charge
by Pack aging

[v  Letterbos
[v  Bizcardbox
[+ Shrinkwrap
[v Cartan

.gl{ From the main menu, click the My Shop button.
¢ In My Shop, click the Packaging button.

¢ In the packaging pricing window, click the My Packaging button.
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7%y Fockaging

M arne Setup Price kA irirnLir

LA

‘We charge 0.85 per 500

| Prermium Letterhead Box

Setup Price Minimum
| | 5

| perdob per 500

&N Z=m

¢ Enter the Name of the custom packaging item.

e Enter the Price and, if applicable, Setup and Minimum charges.

¢ Enter the Quantity per unit.
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%\Mutﬁ:

In the previous example, the program would allocate one box for every 500
letterheads. If custom packaging is to be charged as a single item regardless
of quantity, check per job.

12.15 Pricing Merchandise

This topic describes how to price merchandise. Originally intended for brokered
products - mugs, T-shirts, wedding invitations - this catch-all category is being used
more and more for items that don't fit the conventional printing mold. The cool thing is
you're not limited to working with physical objects. You can also put a merchandise
wrapper around time-based activities charged for by the hour.

By the hour? Merchandise, by definition, implies tangible goods, things we can see
and touch and stuff into a box. We don't envision it as something we bill by the clock.
Morning Flight sees merchandise as a blank canvass, just a convenient way of
producing price tags. Doesn't matter whether those tags hang off physical goods or
are for services rendered. As long as the price is right, your customers will never
guestion your billing method.
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Color Posters

a0
100
250
a0a
© per piece @ per lot 1,000 =
@ per1.000 @ per hour

[ Mo Customer Dizcount
[ Ma Customer Surcharge

What makes merchandise so versatile? Credit its wide range of pricing options:

1. Priced per Piece. Same as copy products. High to low, in up to six different
guantity ranges.

2. Priced per 1,000. With setup and minimum charges, and optional quantity
discounts.

3. Priced per Lot. For goods that vendors sell only in fixed lots, with no quantities
in-between.

4. Priced per Hour. Not much to add here. The clock-based activities mentioned
earlier.
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Priced per Piece

If you've worked with copy pricing in Morning
Flight, this first window will look familiar.
That's because the per-piece method is

Mame Color Pozsters

identical. Note the two check boxes: No = ! ;: jzg
Customer Discount and No Customer ™ =50
Surcharge. If you extend discounts to some ~e0 | - 433 >0
of your customers on products you produce 500 | -999 1.50
in-house, here is where you can suppress 1.000 | > 1.00
that discount - for this item only. You can [~ NoCustomer Discount

also eliminate surcharges, but there you [ Mo Custamer Surcharge

may want to think twice. The reason the
surcharge is being assessed rarely goes
away with outsourcing.

Knowing how to get things done is knowing what to leave undone, and
having to do the math is not only wasteful, it's error-prone. To enter prices per
piece, just enter the first and the last price, then click the sort button and let
Morning Flight come up with what's in between.

Priced per 1,000

Easy to understand just by looking at the

. . . Mame Prezentation Folders
window. Entering setup and minimum

charges is optional, as are quantity Setup 1000 Minimum
discounts. | | 1isboo|  sooo0]

[v  Quantity Dizcount

5.0% 2,000
10.0% 5.000

[ Ma Customer Discount
[ Mo Customer Surcharge
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Priced per Lot

Color post cards, flyers, any outsourced

Mame Full Colar Poztcards

printing where you're locked into ordering

fixed quantities. The reason is simple:

) Guantity 5,000 239.00
Those cards and flyers are gang-printed. 0,000 F9.00
Your batch of cards is being printed 15,000 2900

alongside card orders from other buyers, all
on the same press sheet. For that to work,
the vendor has to predefine sizes and

quantities. v Mo Customer Discount
[ Mo Customer Surcharge

A step up from Henry Ford's business
model ("any color as long as it's black™), per
lot commonly offers a choice of more than
one quantity.

Priced per Hour

Here is where we step out of the box. It's : :
] ] ] Marne File Preflight
simple, really. Try to think of priced per hour

as a packaged service and it all falls into Rt per Hour
place. The only entry that might need

Standard Hours of 30
explaining is the 'Standard Hours' box: It's Minimum Hours alf 18
what time-based merchandise defaults to M agimurn Haurs T30
when you select it for orders and quotes. You e
can enter any amount of time you like, but the
default value is what pops up when the
window opens. K 1ote:

To make time a fixed number of

hours and minutes, make both
minimum and maximum equal

to standard hours.
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13 My Way Pricing

13.1 Quoting it My Way

My Way pricing is an entirely new press-based pricing model that complements the
product-centric approach of the standard Morning Flight pricing engine. Exclusive to
the Gold, Pixelblitz, and Skypricer programs, My Way lets you switch between 'Safe
for Cousin Mel' estimating and a less safe but more flexible alternative: The option of
full manual control.

In a nutshell, where in product-centric automatic mode you select a product that then
controls press parameters and the type of paper you can use, in press-based manual
mode you select the press, then enter specific amounts for imposition and RIP, press
makeready, and press speed. The only restrictions on stock are that flat products get
printed on flat paper, and envelopes on envelopes. Once press parameters have
been set, paper, inks, prepress, and postpress are entered the old-fashioned way.

Both pricing models co-reside. You're able to mix conventional and My Way quotes in
estimates just as easily as you can mix quotes for printing and merchandise. You can
even create a quote the conventional way, then edit it manually in My Way.

File Log-in  Quaokte Price  Write Estimeate  Enker Order  Inwoice  Wiew  Print  Window  Help

AfEE B2 EET O

P

_‘-'\ﬂ""-.'\. _\_‘__.-ﬁ. it G U U AT g ¥ 1 _,-"-..a-.-.,ia_J
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Product

Mewsletters, D40
8142 % 11, printed 1 Side

FPaper

80 Ib Coated Book

11 w17, Wwhite A

Digital 4-Color an frant

’

Frepress

Postpress

Kenword

=M
EEE Z0

My Way - Step by Step

. From the main menu, click the Quote My Way button.

257.40

92.70

350,10

le

576.70 1.037.50

¢ Click the F2 button. Note the lack of a Ctrl-F2 custom product button - in manual

mode, everything is custom.
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8-1/2 x 11 Bleed [2-up]

(B Tinting
MNewsletters

10 I IFH

n

Shrinkwrap

¢ Under Quote Printing, enter "Newsletters" and select Sheets, Digital.

¢ Make sure the press is set to any of your 4-color digital presses, then click the
pushbutton in the upper black panel (circled in orange) until the configuration
shows 4/1 (4-color front / 1-color back).

¢ Click the down arrow to the right of Quantity until a single quantity remains.
Enter 1,500.

e Enter Imposition/RIP and Run Speed values as shown. Adjust Makeready to
medium with the slider.

e Click the Press Sheet button and select 11 x 17.

¢ Click the Bleed button and select a 1/8" bleed all around. The program will
automatically increase the size of the press sheet.
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T
Click the Camera button to get a breakdown of run costs.

¢ Click OK, then add paper, prepress, and postpress the conventional way.

1.500

Mewsletters, D441

2142 w11 [2up)

Impozition/RIF 1:30 Howrs

%\ bt

Things you can only do in My Way: Input press parameters directly, quote all
but envelopes on any kind of paper, quote a single quantity. Things you can't
do: Quote copies, booklets, wide format, or merchandise.

13.2 Converting a Quote to My Way

When you select Quote Price > Edit Quote on the main menu, quotes entered My
Way will be funneled to the My Way window, quotes entered the conventional way will
open conventionally. So how do you get conventional quotes to open in the My Way
window?
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File Log-in BeliEd=N=d=0 ‘Write Estimate  Enter Order  Inwoice  View  Print  \Window  Help

2 =8  uoke Prinking :
ﬁ: Cuoke Printing My ‘Way !r} y 2 ; _r -

Cuote Bookprice
Quoke Merchandise

P - - & W B bt op Ay,

Step by Step

e g
ﬁ/ Click the My Way quote button.

B
=il Click the Rolodex button down below.

K.emmard [

L2
J=] v

AP il el ™

Easy, wasn't it!

%\ kot

While you can go from conventional pricing to My Way, you can't reverse the
process and convert the other way. For good reason: My Way can inherit a
product's run specs. It would be hit or miss to try to fashion a new product from
how you configured a press.
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13.3 Quoting Carbonless My Way

Short of printing post cards on envelopes, or envelopes on card stock, My Way lets
you print any kind of product on any kind of paper. Here is how to quote a digital run
on precollated carbonless.

Step

by Step

. From the main menu, click the Quote My Way button, then press the F2

key.

¢ Under Quote Printing, click the Sheets radio button, then click OK to close the

window.

¢ Back in the Quote window, click the F3 button or press the F3 key.

e Select Carbonless in the black panel on the right, then double-click 3-part

Carbonless Set. When the Quote window reopens, note how the program has

automatically reconfigured the product and updated the run price.

?@.PW

veight Mame Colar Size
2-part | Carbonless Set il bt ellow g-1/2 w11
Jpart | Carbonless Set Wbk ellow Pink, 21421
4-part | Carbonless Set WhiteSvellow/Pink Gold | 8-1/2 %11
B-part | Carbonless Set Whit/Gree v ell/Pink/Gold 8-1/2 =11
B-part | Carbionless Set WhidBlu/Gre/vel/PindGoll 8152511
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Product | Digital/ D170 AC
81/2 11, Fpart, pinted 1 Side 142.00
Faper Carbonless Set
8172 % 11, White/Y ellow/Pink s lle ] 294.10

Diigital 1-Caolar on frant

Prepress

Postpress

K.epward [

= Y _ 44210
‘- i_-j" =, L /

13.4 Entering Orders My Way

This topic assumes you've completed Quoting it My Way. Entering orders My Way
will build on what you've learned there. Other than the obvious that says orders are
always for a single quantity, there is little to separate the two. Both windows open with
the properties of your primary product preselected. Order entry, whether conventional
or My Way, goes one step further by preselecting your most active customer.

File Log-in Quaokte Price  Write Estimate BEgi=@elGE8 Invoice  YWiew  Print  Window  Help

3 i) Enker Print Order

f’. by =

.Elf ' | ﬁ-ir | Enktet Prink Order My Waw ! !jl n
. = . . L r- " -

Enkter Book Order

© 2018 Helmut Heindel



312 Morning Flight Gold

ACME Supplies

Product Catalog Sheets

B1/2x11

FPaper 20 Ib Copy Bond

8142 % 11, White A

s 1 ACME Supplies
i : " 2 The Pretzel Shop
Printing ; k o front F 5 e B e
" 4 Precision dwtomative
& Koslowski Plumbing Supplies
Prepress i 4 i i
Fostpress '$- [ -

k.eyward I

ZEE Z0
2 [

My Way - Step by Step

e From the main menu, select Enter Order > Enter Print Order My Way.

e Click the F2 button, then click the radio buttons for Sheets and Offset.
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8142 211 [2-up. W/T)

Enter Print Order Buantity

Catalog Sheets

5 Min P
A Difficult 2

Filrn

Mone

z:

e Click the Press Sheet button and select 11 x 17, then check the box
Work/Turn.

¢ Click the up arrow to the right of Press until one of your 4-color offset presses is
selected. If you can't select the press you want, it's probably too small for the
press sheet.

¢ Click the Plate button and select a plate suitable for 4-color process.

¢ Enter 45 minutes for Makeready. Note that the Makeready slider drops to the
bottom.

¢ Click OK, then add paper, printing, prepress, and postpress the conventional
way.
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14  Managing your Presses

14.1 Setting up for Offset

This topic describes how to update your offset presses and change their status. With
offset, changing the status affects pricing. That's why an offset press should never be
taken off line because it's down for a few days, waiting for a part to come in. The only
reason you would deactivate your four-color press is because you don't have a four-
color press. It's a way of telling Morning Flight to automatically assign all four-color
runs to the two-color press, twice through. In short, taking an offset press off line
won't change the number of colors you can quote. What it will do, without fail, is
change your pricing.

File GuowePrice Write Estimate Manage Skyprintstore  View  Print Window Help

FREE B 82 DAY O

Changing the Status

M ame Colors Type
2 bulti L Offzet - aurly Fate: 175.00
v Fpobi @ Offzet M
v T0 L Offset i
v Litho-4 1 Offzet
& |ithoh 2 Offzet
& | jtho-f 4 Offzet
& |jtho 7 4 Offzet
W RO 1 Crigital
v Herns 4 Digital
® Digital1 1 | Digtal Quotes
® Digital-4 4 | Digital |
» RIS0-1 1 Stencil
v RIS0-2 2| Stenci Orders
v Hante-1 1 Laser |
v Hante-4 4 Lazer i

O] % Z:
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.ngf Click the My Shop button, then click the Presses button.

o
. Click the Delete button in the press selection window to take the

highlighted press off line. Clicking the same button when a check-mark is showing
will reinstate the press. A press that's off-line will have a red bullet in front of it.

%\ FJote:

The one-color offset press can't be taken off line. Morning Flight assumes that
virtually every offset shop either has such a press, or at least offers one-color

printing.

Updating the Press

Gfpct Fiocss

Hame 2-Color |
Hourly F ate 130.00

Minimumn Sheetzize 2 5

P airnum Sk
Standard Flate

2-Color M akeready b8 15 Minutes

b awirum Speed 10,000 W=

Letterheads
1.000 106.50 T

Plates

[v 1 Metal
[v 2 PhataD
v 3CTF

ik Z=0

.glf Click the My Shop button, then click Presses.

¢ Double-click the press you want to update.

e Select the number of Colors (towers or printheads) and the Hourly Rate.
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%\ ko ote:

The price in the upper black panel updates as you type. This speeds up finding
the right hourly rate. If you swipe the cursor over the three icons, you'll instantly
see the letterhead, envelope, and catalog sheet prices that will result from the
rate you entered. Clicking one of the icons will lock in the product you want to
use as your main reference. To view different quantities, click the up arrow. To
change those quantities (they're the same as your personal preference for
guotes), go to My World > My Preferences.

e Click the Sheetsize buttons to set minimum and maximum sheet sizes.

Check or uncheck the plates available for this press, then enter Plate Prices
(not your cost, but what you charge your customers), excluding film.

Click the Standard Plate button, then set your preferred plate. The standard
plate is what Morning Flight selects when it sees AutoSet as a plate choice in a
product's properties.

Enter Makeready and Maximum Speed. The defaults are:

Offset Press Makeready Maximum Speed
1-Color 10 Minutes 8,000 IPH
2-Color 15 Minutes 10,000 IPH
4-Color 30 Minutes 8,000 IPH

Makeready is based on the number of print heads. If the press has four heads,
the program assumes you're entering total makeready for a 4-color run. In other
words, the total number of minutes it takes to set up all four print heads. If you're
running a 1 or 2-color job through a 4-color press, the program automatically
compensates by reducing the actual minutes.

%\ kot

In Morning Flight you'll find two different entry points for makeready: Product
makeready and press makeready. Product makeready is built into the product,
ranging from very lowto very high. It contains no actual time value, no minutes
or hours. Its sole function is to modify the press makeready to account for the
product's complexity.
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Say the press makeready is set to 10 minutes. If you're pricing a flat sheet and
leave the product slider at medium, the actual makeready time will stay at 10
minutes. Move the slider to high, and makeready time will rise to 15. Move it to
low and it will drop to 7.

Fun

b edivim

The run slider in the product window works the same way. "Medium" means the
run is of average complexity. This setting, too, has no hard value of its own but
becomes a contributing factor in how the program calculates total run time.
That's not quite as clear cut as calculating makeready. Other factors come into
play here, things like the type of paper and total run length. The longer the run,
the higher the true IPH.

Designating it as a Primary

A primary press is the press Morning Flight selects by default when you create a

guote or enter an order. Primary presses act much like primary products. You can
designate any offset press as your primary for 1-color, 2-color, or 4-color. Or
designate a single press as your primary for all three. A single press may be all you
have for printing by offset.
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2

ky Frimary 2-Cals
by Primary 4-Color OFffzet

Say you add a new press and make that press your primary for 1-color, replacing the
built-in Multi. Morning Flight will now select the new press instead of the Multi for all 1-
color work. You can still hand-pick the Multi, but your new press will come up as the
default.

CorsZom Fhodluc?™

Offzet

Wec
[printed

30 Minutes : Prepress

© 2018 Helmut Heindel



Managing your Presses 319

14.2 Setting up for Digital

This topic describes how to update your digital presses and change their status.

Unlike offset, where taking a four-color press off line won't prevent you from quoting

four-color printing, in the digital world that pretty much sinks the ship. No color press,

no color printing.

File Qumc I3"rice

Write Estimate

st

Manage Skyprintstore

- — 1 |
2. 48 BAY O

View Print

Window Help

Changing the Status

M arme Colors Type

2 bulti @ 1 Offzet -
v Ryabi @ Offzet M
v GTO @ 4 Offzet T
v Litho-4 1 Offzet

® | jtho-5 2 Offzet

® |jtho-E 4 Offzet

® | jtho-7 4 Offzet

v eron 1 Digital

v e i Chgital

® Digital-1 1 Crigital

® [igital-4 4 Chigital

» RISO-1 1 Stencil

« RISO-2 2 Stencil

v Hante-1 1 Lager

v Hante-d i Lazer il

.gl{ Click the My Shop button, then click the Presses button.

Hourly R ate:

207

[uates

120.00

Orders
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. Click the Delete button in the Press Selection window to take the
highlighted press off line. Clicking the same button when a check-mark is showing
will reinstate the press. A press that's off-line will have a red bullet in front of it.

Updating the Press

Price of 100

11 x 17, Color 1 Side
flur Margim —

Gl Color
Click Charges
1 - 489
500 - 933
1,000 - 4,339
5,000 - 9,939
10,000 >

WE Py

120,00 W

3000 BEEETS

- 439

o Sk
2433
4933

0

Fdirimum Charge

takeready N 10 Minutes
Spead XN |FH - Momal

2R

%\ Fote:

The price in the upper black panel updates as you type. This makes it easy to
find the right hourly rate. To see prices for different quantities, click the right up
arrow in the black panel. To toggle between 4-color prices and black (when
updating a 4-color digital press), click the left up arrow.

ngf Click the My Shop button, then click Presses.
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Double-click the press you want to update.

Enter the Hourly Rate, front and back.

Click the Sheetsize buttons to set minimum and maximum sheet sizes.

Enter Makeready minutes and Press Speed impressions per hour. The
defaults are:

Digital Press Makeready Speed
1-Color 10 Minutes 6,000 IPH
4-Color 10 Minutes 3,000 IPH

Sheet, Black

//‘DW 1-25 ' 1/0

Makeready Speed Warll ata
10 Minute : 6,000 IPH

Fackaging
Letterbox

%\ bt

Digital presses generally run at a fixed number of impressions per hour,
specified by the manufacturer. That's the speed you want to enter as Normal for
8.5x11 (A4). If your press slows down for heavier weight paper, you have the
option of changing to a slower IPH when you make the quote. Simply enter the
product as a Custom Product, then click Properties and adjust the slider.

© 2018 Helmut Heindel



322

Morning Flight Gold

14.3 Setting up for RISO Duplicators

¢ Enter Click Charges for 1,000 sheets 11x17 (A3), printed on one side. Click
charges in the light gray panel are what you charge your customers. "We pay" is

what the vendor charges you.

o If the press is equipped for variable data printing, check the VarData Setup box

and enter your setup charges. Then enter, as a percentage of the run price, your
Extra Charge for 100% variable data. At 100% VarData, every sheet is different.

Press Update Window

[+ % arData Setup 10.00
YarData Egtra 2R
%\ ke
Here we're charging $10.00

for setup, plus $12.51 (25% of
the run charge, give or take a
penny) for a total of $22.51.
Note the variable data slider
set to 100%.

Variable Data Results

Wwe charge
[printed 1 Side)

Run
Consumables
Click Charges
Yariable D ata
Firughing
FPackaging

Price

This topic describes how to update your RISO duplicator and change its status.
Positioned somewhere between offset and mimeography, the RISO's ease of use
and computer connectivity make it a natural fit in the digital world. Rather than create
a whole new category, we decided to treat it as just another digital machine.

File GuoiePrice Write Estimate Manage Skyprintstore  View  Print

SOl )

Window Help

H o3 AV O
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Changing the Status

7 :; esses
Mame Colors Type

v Herow 1 Digital Howrly B ate; 50,00
v Herom 4 Digital
® Digital-1 1 Digital
® [igital-4 ! Digital
v Hiso-] ] Stencil
v Riso-2 2 Stencil
v ¥ante-1 1 Lazer
v Hante-4 4 Lazer
v’ Rizo-3 1 Inkjet
v Riiso-4 4 | Inkjet Huoates
v Canon 1 Copier |
v Canon 4 Copier

Orders

i JO) & Z:

.gl{ Click the My Shop button, then click the Presses button.

e

. Click the Delete button in the Press Selection window to take the
highlighted press off line. Clicking the same button when a check-mark is showing
will reinstate the press. A press that's off-line will have a red bullet in front of it.
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Updating the Press

53.00

Price of 1,000

8-1/2 x 11, 1 Color, 1 Side

%\ ko ote:

7600 DB

{ur Margir —

Ink Costs
per Cartridge

we charge, black 60.00
WE Iy

we charge, color
WE DAy

v Discount

for quiantity deduct
| 1,000 ||

N 10 Minutes

LRIN [PH - Mormal

The price in the upper black panel updates as you fill in the fields. This makes it
easy to find the right hourly rate. To see prices for different quantities, click the
right up arrow in the black panel. To toggle between black ink and color ink, click

the left up arrow.

%\ kot

If you're doing 2-color work on a 1-color RISO press, put the 2-color unit on line
as a virtual press, then cut the IPH for that virtual press in half. That will
compensate for having to run the job twice through on your 1-color. The

discount function lets you modulate the price curve for higher quantities.

ngf Click the My Shop button, then click Presses.
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Double-click the press you want to update.

Click the Sheetsize buttons to set minimum and maximum sheet sizes.

Enter the Hourly Rate.

Edit or accept the rest of the entry fields.
¢ The defaults for makeready and press speed are:

Makeready Speed
1 or 2 Color 10 Minutes 4,200 IPH

R

//‘7 ) Riso Sheets
Wi-ﬁ" u

:ﬁ 3 1.000 170 49.05

Makeready  Speed WarD ata

10 Minute: 4,200 [PH

1 PRI

%\ kot

Digital presses generally run at a fixed number of impressions per hour,
specified by the manufacturer. That's the speed you want to enter as Normal for
8.5x11 (A4). If your press slows down for heavier weight paper, you have the
option of changing to a slower IPH when you make the quote. Simply enter the
product as a Custom Product, then click Properties and adjust the slider.
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14.4 Setting up for RISO Inkjets

This topic describes how to update your RISO Comcolor press and change its
status. Filling the gap between stencil duplicators and toner presses, Comcolor
inkjets are capable of printing full color at very competitive prices. Their speed and
versatility (two-sided printing, variable data for NCR numbering and mailings) make
them especially well suited for in-plant shops.

While the suggested per page prices are based on prevailing Comcolor costs, we
kept the structure of those prices generic.That means you'll be able to use the press
in any consumables-based scenario, regardless of whether it's inkjet or laser driven.
Simply adjust hourly rates, cartridge life and what you charge for ink, then prorate
other consumables such as belts and wrap them into the price of the cartridge. Might
be helpful to also change the name.

File QuoiePrice Write Estimate Manage Skyprintstore View  Print  Window Help

Hr2E @c a2 AV O
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Changing the Status

7 i,’vf (esses
M ame Colarz Type

w Hens 1 Digital Haurly Fate: 120.00
v Herny 4 Digital
& [igital-1 1 Digital
® Digital-4 4 Digital
w Rizo-1 1 Stencil
v Fizo-2 2 Stencil
w Hante-1 1 Laser
v Hante-4 4 Lazer
v Rizo-d 1 Inkjet
v Biian-d 47 nkiet Quotes
v Canon 1 Copier |
v Canon 4 Copier

Orders

0 E Z:

.gl* Click the My Shop button, then click the Presses button.

=

. Click the Delete button in the Press Selection window to take the
highlighted press off line. Clicking the same button when a check-mark is showing
will reinstate the press. A press that's off-line will have a red bullet in front of it.
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Updating the Press

Price of 1,000 137.80

8-1/2 x 11, color 1 zide

ur Margir — T 50 "‘?‘ E

Mame Riso-4 colar

Consumables
inirmum Sheetsize - % B | per Cartridge

b aimum Sh e 1 5/8 re we charge 350.00

black per page, &4 0.0158
Havrly Rate 120.00 By color per page, Ad 0.0633

Bl Eack we pay

20.00

v Discount
fior quiantity deduct
| 1,000 || 5.0%
| zs0 ] 100
takeready N 10 Minutes | 5,000 || 15.0%

Fediriirnurm

Speed SN [PH - Mormal

=
i ]
= 12

%\Nﬂtt‘f:

The price in the upper black panel updates as you fill in the fields. This makes it
easy to find the right hourly rate. To see prices for different quantities, click the
right up arrowin the black panel. Note howthe price per page updates as you
change either the price of the cartridge or its life.

ngf Click the My Shop button, then click Presses.
¢ Double-click the press you want to update.
e Click the Sheetsize buttons to set minimum and maximum sheet sizes.

e Enter the Hourly Rate.
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o Edit or accept the rest of the entry fields.

e The defaults for makeready and press speed are:

Inkjet
1 or 4 Color

Makeready
10 Minutes

Speed
6,000 IPH

o If the press is equipped for variable data printing, check the VarData Setup box

and enter your setup charges. Then enter, as a percentage of the run price, your
Extra Charge for 100% variable data. At 100% VarData, every sheet is different.

Press Update Window

[v 4 arDrata Setup 10.00
YarD ata Egtra 203
%\ ke
Here we're charging $10.00

for setup, plus $12.51 (25% of
the run charge, give or take a
penny) for a total of $22.51.
Note the variable data slider

set to 100%.

14.5 Setting up for Xante

Variable Data Results

We charge
[printed 1 Side)

Run
Conzumables
Click Charges

Wariable D ata
Firizhing
Packaging

Price

This topic describes how to update your Xante Impressia and change its status.
Unlike the RISO, the Xante is a true 4-color digital machine, most commonly used to
print envelopes. Like the majority of digital presses, the Xante is toner-based. What
separates it for pricing purposes is that, generally, there are no click charges.
Production costs are measured in hourly rates and consumables. That's also the
reason we've included it as both a physical 4-color press and as a 1-color virtual
machine. Last we heard, there is no such thing as a 1-color Xante Impressia. It's an
imaginary machine to help you price color printing different from black and white.
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File Qumc'i’rice Write Estimate ManageSkyprintstore View Print Window Help

Changing the Status

7 if}‘ (esses
M ame Colors Type
v Herox 1 Digital Hourly Fate: 120,00
W RO 4 Diigital
® [igital-1 1 Diigital
® [Digital-4 4 Digital
v RIS0-1 1 Stencil
» RISO-2 2 Stencil
v Fante-1 1 Laser
v’ ante-d 4 Laszer
v Canon 1 Copier
w' Canon 4 Copier |Duu:utes
Orderz

i O] % Z:

.ﬁg Click the My Shop button, then click the Presses button.

. Click the Delete button in the Press Selection window to take the
highlighted press off line. Clicking the same button when a check-mark is showing
will reinstate the press. A press that's off-line will have a red bullet in front of it.
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Updating the Press

Price of 1,000 207.20

8-1/2 x 11. Color 1 Side

Furr Maregim — 72 0r *—r* E

M arne

Consumables
b inimum Sheetzize /B | per Cartridge
b aximum Sheetsize 12218 | we charge, black

WE pay
Frant
we charge, calor
Back
WE pay 185.00

W Discount
fior quantity deduct
| 1,000 || 5.0%

b inimum Charge . | > 500 | | 005
5000 300%

Cartridge

b ak eready 20 Minutes |

IPH - Marmal

z: 1

%\Nﬂtﬁ:

The price in the upper black panel updates as you fill in the fields. This makes it
easy to find the right hourly rate. To see prices for different quantities, click the
right up arrow in the black panel.

%\ bk

The discount function lets you bend the price curve for higher quantities.

.ngf Click the My Shop button, then click Presses.
¢ Double-click the press you want to update.

e Click the Sheetsize buttons to set minimum and maximum sheet sizes.
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e Enter the Hourly Rate for both front and back.
e Edit or accept the rest of the entry fields.

e The defaults for makeready and press speed are:

Xante Makeready Speed
Black 10 Minutes 3,000 IPH
4-Color 20 Minutes 2,700 IPH

Envelopes

W A
:ﬁ '._ 1.000 a0

Speed Warllata

200 IPH

%\ P ote:

Digital presses generally run at a fixed number of impressions per hour,

specified by the manufacturer. That's the speed you want to enter as Normal for

8.5x11 (A4). If your press slows down for heavier weight paper, you have the
option of changing to a slower IPH when you make the quote. Simply enter the
product as a Custom Product, then click Properties and adjust the slider.
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14.6 Setting up for Copies

This topic describes how to update your copiers and change their status. Taking a
copier off line will prevent you from quoting the type of work associated with it. For
one thing, you can't produce color copies on a black-only copier. And while there is
often a good reason to run a one-color offset job on a two-color press (one-color
press too small, job has too much ink coverage), making black copies on a color
copier is almost always cost-prohibitive.

File QuoiePrice Write Estimate Manage Skyprintstore View  Print Window Help

&@ElE B3 AV O

Changing the Status

M ame Colors Type
v Herow 1 Diigital
v Herow 4 Digital
® [Digital-1 1 Crigital
® [igital-4 4 Diigital
»' Rizo-1 1 Stencil
v Fizo-2 2 Stencil
v Hante-1 1 Laszer
w Hante-4 4 Lazer
v Rizo-3 1 Inkjet
v Riso-4 4 | Inkjst Uuotes
v Canon 1 Copier |
v Canoh 4 Copier
Orders

i O] & Z:
F._

.ﬂg Click the My Shop button, then click the Presses button.
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. Click the Delete button in the press selection window to take the
highlighted copier off line. Clicking the same button when a check-mark is showing
will reinstate the copier. A copier that's off-line will have a red bullet in front of it.

Updating the Copier

Black Copier

v Document Feeder
v Collator

Caollating Setup
Callatings1.000

Feeding At ach L Iirirmum

i EE]

.ngf Click the My Shop button, then click Presses.
¢ Double-click the copier you want to update.
e Click the Sheetsize buttons to set minimum and maximum sheet sizes.

e Fill in the rest of the entry fields.

%\ kot

Document feeding and collating prices are the only charges specific to the
copier. The actual per-copy prices are determined by each individual copy
product.
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15 Managing your Products

15.1 Product Categories

Morning Flight divides all products into categories. Having separate drawers not only
makes it easier to find things, it's mandatory if we want the program to narrow down
the choice of paper. After all, when you're quoting envelopes, you don't want to have
to search through all kinds of flat sheets, none suitable. All you're looking for are
envelopes.

Offset categories have clear lines of demarcation. It's easy to separate flat sheets
from envelopes. Copies, digital, and wide format on the other hand are in a world of
their own.

Offset Categories

1. Sheets. Any sheet printed on other than
Categgry cover or self-adhesive label paper.
Includes carbonless sheets, but not

- carbonless sets.
Hsal (rrasd aled

{Hizet Envelopes 2. Cards/Labels. Any sheet printed on cover
Oifset Carbonless or self-adhesive label paper.

fomes

figrial 3. Envelopes

Wide Farmat

Py 4. Carbonless. Precollated sets only.

Individual sheets belong in the sheets
category.

=

Copy Category

This category accepts flat sheets only, no envelopes or carbonless sets. Carbonless
sheets are Ok, as are covers and labels, provided your copier can handle them.

© 2018 Helmut Heindel



336 Morning Flight Gold

Digital Category

Same as copies, but also accepts digitally printed envelopes and carbonless. If you're
a digital-only shop, you'll want to select a digital item as your primary product. Better
still, disengage offset altogether under File > My Preferences.

Fdy M arne

Thereza Licari

Fdp Cluantities v Format Text

Wide Format

A wide range of products printed by ink jet, from banners to signs, small decals to
huge wall coverings and vehicle wraps. Whereas offset and digital products are linked
to a specific press, wide format products are tied to the substrate on which they're
printed. Pricing is per square area.
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15.2 Your Primary Product

Tired of having the quote window open with copies, when the bulk of your work is
digital? Easy to fix. Designate whatever product you quote on most often as your

primary.
I ame Size
Category
v Elank Paper 81/2 %11 . Lapies
v Blank Paper 21/2414
w' Blank Paper 11 =17 MWiae Foarmat

v Carbonless Sheetz, D14 81752 %11 -
v Digital with trim, D121 | 8-3/4 w1112 Merchandise
v Digital with trim, D121 | 11-1/2 #1712 Al

v Digital with trim, D4/4 | 8-3/4 % 11-1/2
v Digital with trim, D4/4 | 11-1/2 2 17-1,/2

< Digital, 0140 8-1/2=M

< Digital, 0140 21281 2-up

{0 Digital, D1A a-1/2 01

» Digital. 0141 8-1/2= M 2-up

»* Digital. 0141 1117 -

QRNE O

= From the main menu, click the My Store button.
¢ Click the My Products button.
¢ In the black panel on the right, click the product category.

¢ Highlight the product you want to make your primary.

Click the Primary button, then close the window.
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The Result

Froduct Digital, D111

8.1/2 11, printed 2 Sides [Fz]le ] 93.40

Paper 20 Ib Copy Bond
o et lE2 VLS e L e ﬂl.ﬁ_?llﬂ sl 1715

15.3 Updating Offset Products

This topic describes how to update an offset product or create a new one.

@PM

I arne Size Category
= Book Page 31/2x11 -
v Book Page 1117 el Cardsd rbral
v Book Page with trim 8-3/M4 111142 Osat Envelopes
»' Book Page with tim 1M12=17142 eat Carbonless
w" Brochures 11 =17 i T
v Bulletin Imprints g-1/2«11 {,f:-‘p,_rg_g
v Bulleling 2152511 Lhgrial
»' Bulleting 3142 %11 2-up Hide Foarmal
»" Buziness Forms 51208142 | Zup y
v Busineszz Forms 212 =11 zﬁrﬂﬁaﬁdm&
w' Buzineszs Forms 21/2414
»' Carbonless Sheetz 212 =11
= Catalog Sheets 31/2x11 -

il QRE [

= Click the My Store button, then click My Products.

¢ In the black panel, click one of the first four Categories (Sheets, Cards/Labels,
Envelopes, or Carbonless).
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E Click either the Add button to create a new offset product, or the
Update button to edit an existing one. For this demo, we'll add a new product,
based on "Bulletins, 8-1/2x11" over which we've placed the highlight bar.

Mame Fram the Desk of 1/0

5142 x 8142 (2-up]

“We charge
[printed 1 Side]

Prepress
Ik,

 ak eready
Run
Postpress
Packaging

Fun
M edium

[luantity

Bleed | 1,000 u Price

z:

%\ bt

When you click the button pointed to by the arrowin the product window, the
configuration will change from 1/0 to 2/0, and then to 4/0. With offset products,
that's merely a way to show pricing for alternate run configurations. It's not
saved as part of the product's properties.

¢ Enter the Name (From the Desk of), then click the Size button and change the
finished size to 5-1/2x8-1/2.

¢ Right-click the Composition slider to lower composition to Light. This is the
setting the product will default to. It can be changed when you make the quote,
where you can enter the actual time in hours and minutes.

¢ Click the Properties button to change Makeready and Run settings. If those
were the only properties we wanted to change from the values we inherited from
bulletins, we could right-click the makeready and run sliders in the product
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window and be done. But we also want to change stripping, ink coverage, and
packaging.

Bulletins
1.000 170

Jet-Entry

¢ Drag the Stripping, Coverage and Makeready sliders to low, and the Run
slider to easy.

%\Mutﬁ:

The quick way to change property settings is to use Jet-Entry. All the sliders
have five settings: very low, low, medium, high, and very high. Entering a "1"
sets a slider to very low, entering a "5" to very high. To set all five sliders to
match the example, enter "22322" in the Jet-Entry box.

¢ Click the Packaging button and select Letterbox. Click OK, then close the
properties window with OK as well.
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[ Shrinkwrap
[ Cartan
[ Mo Charge

z0

“ Back in the product window, click the Stop button. Uncheck Print 4 Colors
and Print 2 Sides to prevent this product from being quoted that way. Click OK.

[v Print 2 > up
| Warnizh
[ Frint 2 Sides I whork and Tum
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15.4 Updating Digital Products

This topic describes how to update a digital product or create a new one.

7’?01 PR odncis

R ET Size
» Digital, 041 8172 %11
v Digikal, D4 g-1/2 011 2-up
2 Digital, D444 812911
v’ Digital, D474 a12x11 2-up
v’ Digital, D474 11 =17
< Ervelopes, Size 10, 014 4148 % 3-1/2
2 Ervelopes, Size 10, D44 41/8=931/2
v Ervelopes, Size 9, 01/0 3748« 3-7/3
v Ervelopes, Size 9, D4/0 3748« 3-7/3
v’ Rizo Envelopes, Size 10) 4-1/8 8 3-1/2
v Rizo Envelopes, Size 10) 4-1/8 % 3-1/2
v’ Rizo Sheetz, B1/0 212411
v’ Rizo Sheetz, R2/0 212411

QRNE O

= Click the My Store button, then click My Products.

¢ In the black panel, click Digital.

Category

sst Sheols
Hizat Cardsd alel
gt Emvelopes
ssl Carborfess
fopies

Hide Format
AMerchandise
Al

Click either the Add button to create a new digital product, or the
Update button to edit an existing one. For this demo, we'll add a new product,
based on "Digital, 8-1/2x11, D4/1, 2-up" over which we've placed the highlight bar.
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Hame Catalog Sheets

8-1/2 x11 [2-up]

“We charge
[printed 2 Sidesz)

Run 53.71
Click Charges 28924
Yarnable Data

Cutting 175
Packaging 0.E0

Price 35230

z:

e Enter the Name (Catalog Sheets)

¢ Click the up arrow in the black panel to change the Configuration to 4/4, four
colors front, four colors back.

¢ Right-click the Composition slider to lower composition to Medium. This is the
setting to which this product will default. It can be changed when you make the
guote, where you can enter the actual time in hours and minutes.

e Click the Properties button.
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Digital
444

Funtime  “arData
N Minutes

‘.

¢ Click the left radio button under Coverage to shift to a lower range, then drag
the coverage slider all the way up. Ink coverage should now read 25%.

¢ Click the Packaging button and select the type of packaging.

Digital

[ Shrinkwrap
[ Cartan
[ Mo Charge
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15.5 Updating Copy Products

This topic describes how to update a copy product or create a new one. Copies are
different from offset and digital, they're priced per copy. Here the product alone
determines the price. Well, almost anyway. One minor contribution comes from the
copier itself - the time spent feeding the original document. With multiple copies made
from a single original, that usually adds mere pennies to the total. Multiple originals, on
the other hand, can significantly increase the price per copy.

Say the order calls for 1,000 copies from a single original. You're charging 5 cents per
copy, plus 7 cents per original if there's more than one. Total price: $50.00. Now
change that to a single copy each from 1,000 originals, and watch the price soar to
$120.00. That's if your copier is equipped with an automatic document feeder. If the
originals have to be put on the glass by hand, the price goes even higher.

%\Nﬂtﬁ:
The pricing for document feeding, auto and manual, is tied to the copier and is
set in My Shop > My Presses.

?’?LPM

M arne Size Categﬂry
v* Copies with tim, C1/1 | 834 % 11-1/2
v Copies with tim, C1/41 | 11-1/2 2 17142 Digial
v Copies with tim, C4/4 | 834 % 11-1/2 Wodle Format
v’ Copies with trim, C4/4 | 11172 % 17142 -
© Copies, C1/0 8142 %11 Merchandise
© Copies, C1/0, RIP 8142 %11 Al
© Copies, C1/41 8142 4 11
S Eonies. i BIE BT
& Copies, C4/0 8172 %11
© Copies, C4/0, RIP 8142 %11
© Copies, C4/4 8142 %11
© Copies, C4/4, RIP 8142111

16 G @1
BED OR
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i Click the My Store button, then click My Products. In the black panel, click
Copies.

E Click either the Add button to create a new copy product, or the
Update button to edit an existing one. For this demo, we'll add a new product,
based on "Copies, C1/1, RIP" over which we've placed the highlight bar.

. Black : : Per Copy
0118 [printed 2 Sidesz)

Wwe charge
Copying 10330
RIF 14.40
Postpress

[uantity Packaging

Bleed | 1.000 u Price

RIS z:

¢ Enter the Name, then click the Size and Press Sheet buttons if you need to
change sizes.

o Left-click the Coverage slider to increase toner coverage, right-click the slider to

decrease it. Click one of the three radio buttons if you need to select an alternate
range.

%\Mutﬁ:

The prices we'll enter in the next step are for 8-1/2x11 (or A4) copies with 30%
coverage, printed one side. If we change the size to 11x17 (or A3), Morning
Flight will double the price per copy. If we change coverage, the program will
compensate for that as well. When updating standard copy products (those with
a circle in front in the product selection window), you'll discover that sheetsize
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and coverage are locked and can't be changed. That's what makes a standard
product standard.

¢ Click the Prices button.

per 8-1/2 x 11
[20% coverage, 1 zide]

Packaging s

Mo Charge

1-49 0075 [ 75oents

-39 0070 ¥ cents
00Es | E.5cents

kiniraur . 0.060 E cents
RIF 12.00 . 0.0585 | 5.5 cents

B centg

CommonSense Pricing

e Enter the Minimum amount per quote and RIP charges, if applicable.

e Change the Quantity fields, if necessary, then enter Prices per Copy, size 8-
1/2x11 (or A4), with 30% ink coverage, copied one side.

%\ ko ote:

Looking for a shortcut? When entering copy prices, just enter the first and the
last price, then click the sort button (third from the left) and let Morning Flight
come up with the intermediate prices. Note also that when you change a white-
box quantity, the quantity above it in black on gray will update automatically. In
other words, when you increase the quantity in the white box from 50 to 500, the
black on gray quantity will increase from 49 to 499.

¢ Click the Packaging button and select the type of packaging.
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=

15.6 Updating Wide Format Products

[ Letterbox
" Shrinkwrap

[ Carkon

L=

This topic describes how to update a wide format product or create a new one.

@pM

M ame Size

Z Banner, W/l IExTe 3 u G feet
{2 Coroplazt Panel, Wa/D | 24w 36 &mdfeet
< Decal, Wa/l 3uh

Z Dibond Panel, w40 2«36 21 3 feet
2 Foamcare Panel, Wa/0 | 24 1 36 213 feet
2 Magnetic Sign, wWa0 | 1218 151.5 feet
2 Tewtile Product, w40 | 36w 72 3 n 6 feet
ehicle wiap, W40 120 %300 10 % 25 feet
< Yard Sign, W40 18=24 1.5 %2 feet

e

[

BN [iei
b

Category

foapies
Lrhgrtal

AMerchandise
Al
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i Click the My Store button, then click My Products.

e In the black Category panel, click Wide Format.

E Click either the Add button to create a new wide format product, or
the Update button to edit an existing one. For this demo, we'll add a new product,
based on "Coroplast Panel, W4/0, 24x36" over which we've placed the highlight

bar.

Product Mame
Price/sq.ft.
780

Setup Price tinirnurn Price

1a.00 25.00

¢ Enter the Name (Exhibit Display)

Price of 1

1N
25290
780 64

Lostio make —

r

click here far ot
two-sided “m
vy 10.0%

v Discount | 1D|| 11.0%

¢ Click the brown two-page icon to price the sign as being printed on both sides.
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ety
vl
Elraiar

Amanste
Flaosl
etz
Ikmer

z

o We'll keep the category as is.

e What we could do is click the Substrate button and change the substrate from

Coroplast to Foamcore. That will make for a better sign and automatically adjust
our price.

Finally, click the Product Size button and increase the size from 24x36 to
36x72. That, too, will automatically recalculate the price and at the same time
resize of the substrate.

%\ ok

At this point you may be tempted to change the setup charge and minimum
price, and maybe adjust your markup. This really isn't the best place for it. Here
you're essentially creating your own templates. Unless you need variations of
the same product (retail vs. wholesale comes to mind), making inline price
adjustments is much easier when you know your templates are priced alike.
Keep in mind that all the sliders pictured are available in the quote and order
windows by just clicking the Custom Product button.
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15.7 Updating Merchandise

This topic describes how to update or create a new merchandise item. In Morning
Flight, merchandise items can be used for more than just material things that come in
a box. You can also wrap them around time-based activities charged for by the hour.

Service in a box, so to speak, if it helps hanging a label on it.

@PM

Category

fopres
Lhgiial

Mame Size
Calar Posters 1218 2847
Full Color Postoards 4-1/4 16 w4387
Presentation Folders 9wl B-4305

HWide Format

Al

12162017

i CRNE I

= Click the My Store button, then click My Products.

e In the black panel, click Merchandise.

Click either the Add button to create a new merchandise item, or the

Update button to edit an existing one.
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100

250

500

@ perlot 1,000

i per hour

[ Mo Customer Dizcount

[ Ma Customer Surcharge

¥

¢ Click the Description button to enter a catalog number and product description.

Both the catalog number and the description will appear on quotes, orders, and

invoices.

an

Product Color Posters
M-28497F, 12 %18

Full calar frant and badk. Printed on heawy
cover, glosscoated both sides.

150.0C

\-n‘n e . gl A o i B, gl Sl Sl *M‘ﬂ.,'-t,

e Enter the Name, then click the Size button if it's a dimensioned item.

e Click the Vendor button and select a vendor. This step is optional.

e Click the Packaging button and select the type of packaging.
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e Select the Pricing method: per piece, per 1,000 units, per lot, or by the hour.

See Pricing Merchandise for definitions.

e If you extend a discount to some customers on your in-house printing and you

want to withhold that discount for this particular item, check No Customer
Discount.
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16

Managing your Paper

16.1 Paper Categories

Morning Flight divides paper into five paper types, stored in two separate categories:
in-Stock and Buy-it paper. A third category, Custom paper, holds modified versions of
in-Stock and Buy-it paper which are then stored not in a separate file but directly with
the quote or order. Since you can't view or update it, Custom paper isn't really a
category. We just call it that for convenience. If you find yourself modifying the same
paper item more than once, there is a way to save and later retrieve it from the Buy-it
file.

Paper Types

1. Writing. Bond and Ledger.
Categow 2. Book/Text. Offset, Text, Coated Book.

3. Cover/Label. Coated and Uncoated Cover,

eanlsfeay Index, Bristol, Tag, and self-adhesive Label.

Coverd ahef
Emvelopes 4. Envelopes. Regular, Window, Booklet,

Larbanfess Catalog, and Social.
Al

5. Carbonless. Precollated sets only. Individual
L X sheets are stored in the Writing or

Cover/Label category.

My in-Stock Paper

Any paper you keep on hand, or can get your hands on in a hurry. It used to be the
only category Morning Flight would let you quote in broken reams or partial boxes, but
that has changed. Every category now has a check box to either prevent or allow it.

Today, the biggest difference between in-Stock and Buy-it paper is in-Stock's wider
range of pricing options. Where Buy-it paper must be priced per 1,000 sheets, in-
Stock offers you a choice of per 1,000 or per 100 Ibs. You can even redefine quantity
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brackets to cartons only, weight only, or cartons up to a full carton, and beyond that
by weight.

Something else that sets in-Stock paper apart is how individual items are stored in
the file, and how that affects the pricing of colors: They're all priced the same. There
are pros and cons here. With just two prices (one for whites, one for colors),
maintaining the paper file is a snap. Update the cost of ivory, and canary and blue and
pink are updated along with it. That's the good news. The downside is you can't have
a higher price for dark colors. With in-Stock paper that shouldn't be an issue. Dark
colors are infrequent sellers, known as "White Elephants” (don't ask me why) in
American English. Poor candidates for inventory in any language.

What if you needed to carry a higher priced color of, say Classic Laid Cover, for a
particular customer? Simple. Make a new in-stock item and label it "Classic Cover -
Dark."

My Buy-it Paper

As the name implies, any paper you need to order for a specific job. If a customer
orders 600 envelopes, Morning Flight assumes you have to buy at least two boxes of
500. The program is reluctant to let you buy one-and-a-half boxes because it knows
nobody will sell you one-and-a-half boxes. You can override that even for items you
don't carry in inventory by unchecking the "no partial reams" box. Before you do
though, ask yourself this:

1. Am I willing to buy 1,000 envelopes to print only 600 while keeping Morning
Flight from charging for the leftovers, then store those leftovers on a shelf in our
odd lot room?

2. Can | expect either this customer or another customer to order the same
envelopes, in the same color, before they glue themselves shut and start
wrinkling?

Cartan Content \

[v Mo partial reams

.. Waooy per 1,000 sheets
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Custom Paper

Regency Tesxt

per 100 Ibg

Cartan Cantent

[ Mo partial reams

We pay per 100 bz
23%35

Lezs than 100 lbs 34200
100 bs 228.00
500 |be or more 191.29

Auto-Price Lock
30 BED & A0 Z0
aar NN P /

Technically not a category, just a variation of either in-Stock or Buy-it paper. Custom
paper, like in-Stock, can be priced by weight or per 1,000 sheets, in a variety of
brackets. There's no file for it because the paper specs and costs are saved with the
guote or order.

The way you work with Custom paper is by first selecting the closest in-Stock or Buy-
it item with F3. When you then click Ctrl-F3 (the button to the right of F3), the specs
and costs from the paper you selected are inherited and presented in the Custom
paper window. If you don't modify what's there, the price stays as inherited.

How can you tell it's Custom paper? Same way you identify a Custom product, by the
button turning red.
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Product Digital, D141

81/2 4 11, printed 2 Sides A 93.40

Paper 20 |lb Copy Bond

3172 1 11, White AN 22.30

!:'ig!t-fd 1-Color an front

git=sl 17 ' e Hack

Customer supplied Paper

Another non-category, but we do have to allow for customers walking in with their own
paper. Usually bought years ago and yellowing around the edges, and more often
than not the exact, counted out by hand number of sheets the customer wants to
walk out with, but that's another topic. Morning Flight will exclude the cost of the
paper, but will raise the run price a little to compensate for the extra handling.

E To specify Customer paper, click the quantity button, then check the box.

Letterheads
i

1.000]  2oo0][  S000]

Reorder without Changes
Cuztorner ko zupply Film
Customer bo supply Paper
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16.2 Updating in-Stock Paper

This topic describes how to add or update in-Stock paper. The name used to imply
that in-Stock was paper you should carry in inventory, but that's no longer the case.
Today, your decision of whether to save paper in the in-Stock or Buy-it file essentially
boils down to

e Do we need the ability to enter costs per 100 Ibs (which leaves out the
Buy-it file)?

e Can we live with having all paper colors priced the same, making cost
updates fast, foolproof, and perfect for web2print, but at the same time
unwieldy for very large quantities?

Now that "no partial reams" can be enabled in every category, you should never lose
money on a job because you bought paper you're not charging the customer for.
Provided you can bring yourself to check the box.

YWieight M ame Type Size
. - Category
60 Ib | Uncoated Label Cover/Label | 8172 =211 Hiiting
65 b | = Uncoated Cover | Cover/Label | 8142 < 11 3
B51b |v Uncosted Cover | Cover/Label | 11417 Boack/Text
65 |b | v Uncoated Cover | Cover/Label | 23w 35
Al b | v Clazgzic Laid Cover | Cover/Label | 3172 %11 Eavelopes
30 |b | Coated Cover Cover/Label | 8172 =211 Larloniess
30 |b | Coated Cover Cover/Label | 11 17 AL
Al b | v Coated Label Cover/Label | 8-1/2 %11

8r

e L =
ViRNEl [0

= Click the My Store button, then click My in-Stock Paper.

e In the black panel, click Cover/Label.
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m Click either the Add button to create a new in-stock paper item in the
cover/label category, or the Update button to edit an existing one. For this demo,
we'll add a new item, based on 80 Ib Classic Laid Cover, shown under the
highlight bar.

Category Cover/Label

per 1,000

M arne Framekote Cowver
Carton Caontent 1.000

We pay per 1.000 sheets
‘white Colors

Lesz than 1 Carton 180,00 180.00
Full Carton 120.00 120.00
3 Cartons ar mare 8268 268

Auto-Price Lock, Colors zame az white

A A0V ZD

¢ Place the cursor over the paper type (where the glove is pointing) and keep
clicking until the type reads "Coated Cover." Place the cursor over the weight and
click that until it reads "100 Ib." Those are shortcuts. You can accomplish the
same thing, slower, by clicking the Weight/Type button.

¢ Click the Size button and change the size to 11x17.

¢ Click the Vendor button to enter the vendor. If your vendor file is empty, add a new
vendor or just leave the vendor's name blank.

¢ Enter the Name of the paper and the Carton Content.

¢ Enter the Cost of 1,000 11x17 sheets in the full carton bracket for white. This is
the price you pay your vendor, not what you charge your customer.
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“ Click the Color button. That will do two things: First, it will price colors the
same as white. Second, it will remember that setting for this paper.

Updating Colors

Here we'll add a new color, Baronial Ivory, to 80 Ib. Classic Laid Cover.

WWieight T Type Size
60 Ib | Uncoated Label Cover/Label | 8172 =211
65 b | 2 Uncoated Cover | Cover/Label | 3142 % 11
B5 b | Uncoated Cover | Cover/Label | 11 817
65 |b | v Uncoated Cover | Cover/Label | 23w 35
Al b | v Clazzic Laid Cover | Cover/Label | 3172411
30 |b | Coated Cover Cover/Label | 8172 =211
30 |b | Coated Cover Cover/Label | 11 17
30 b | Coated Label Cover/Label | 8172 =211

e L =
ViRNEl [0

Category

Wriding
HaaksText?

Emveiopes

arbonfess
Al

8r

¢ In the paper selection window, place the highlight bar over 80 Ib Classic Laid
Cover, 8-1/2x11.

“ Click the Color button.
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Ppor boboes

M ame Colar Graup

Clazsic Laid Cover

¢ Ao Brilhant white ' hite
M atural wehite W' hite
Antique Gray [aray
Whiteztone Gray

AL

Click either the Add button to add a new color, or the Update button
to edit an existing one. For this demo, we'll add a new color.

Pocs. bokes

Classic Laid Cowver

Calar Baronial lvory i

e Enter the name of the Color.

¢ Either click the appropriate Color Bar or drag the blue bullet up next to it. That
tells the program whether to price this as white or as a color.

%\Mutﬁ:

Morning Flight will try to determine the color group based on the name of the
color you enter. For instance, when you enter "Whitestone", the program will
automatically move the blue bullet to the white bar on top of the palette. That
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works sometimes but not always, and since it affects the price it's kind of
important, so be sure to check it before you click OK.

16.3 Updating Buy-it Paper

This topic describes how to add or update Buy-it paper. As the name suggests, that's
any paper you order on a case-by-case basis, with just enough extras to run the job.
So why save it in a file? Convenience. It's handier to have prices accessible from
within Morning Flight than to always have to look them up in a price book. But files
have to be maintained and updated. Which is why you'll want to keep this file small
and easy to manage. Save only paper and colors that tend to repeat, items you don't
mind updating.

Envelopes are a prime candidate for the Buy-it category. If your shop isn't air-
conditioned and the humidity feels like 150% for days on end, they tend to glue
themselves shut just sitting there. On the other hand, not stocking them also means
having to buy extras for each job, just in case. When a run comes up short because
you can't stop the wrinkling, the press will likely sit idle with ink on the rollers, waiting
for another box of envelopes to come in.

With in-Stock you could have grabbed another box off the shelf, took out what you
needed, and put the rest back. Still, the economics usually tilt in your favor if you treat
all but your fast-moving envelope items as Buy-it paper.

That's the theory. In reality, none of this matters if the envelopes have already been
collecting dust on your vendor's shelf and have glued themselves shut there.

Category 1. = Click the My Store button, then click Buy-it Paper.
Wirting
2. In the black Category panel, click Book/Text.

Coveld ahael
Emveiopes

Larhoniess
Al 3. = E Click either the Add button to create a new

Buy-it item in the book/text category, or the Update button
to edit an existing one. For this demo, we'll add a new item,
60 Ib Springhill Offset.
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Category Book/Test

Mame Springhill O ffzet

Calor Green
Carton 5,000

We pay per 1.000 sheets

Lezg than 1 Carton 17.25
Full Carton 11.50

@ T Of more 7.9z

b anual E ntry
Bl OB @ 120 Z0

¢ Click the Vendor button to enter a vendor. If your vendor file is empty, add a new

vendor or just leave the vendor's name blank.

¢ Enter the Name and Color of the paper, then click the appropriate color bar or
drag the blue bullet to it.

%\ P ote:

Where with in-Stock the color group has a direct bearing on pricing, with Buy-it
the palette merely helps you search. Each color is priced individually, so for the
purpose of quoting, white is just another color. In the example above, "lvory" is
the last color entered for Springhill Offset. To delete a color, place the highlight
bar over it, then click the trash can button. To zoom in, click the camera button.

¢ Enter the Carton Content. We'll leave the weight and type at 60 Ib offset, and
the size at 8-1/2x11.

¢ Place the cursor in the general area of the red circle. Left-click to increase the
number of cartons, right-click to lower it. The maximum is 10. Note the up/down
cursor.
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o

i
Ze8 Click the Manual Entry button, then enter the Cost of 1,000 sheets 8-
1/2x11 in all three brackets.

e When you're done, click OK. The window will stay open, ready to accept
another color or the next Buy-it paper to be entered. At the end of the session,
click the Exit button to close the window.

Adding Another Color

e In the paper entry window (still open), enter the next Color and your Costs for
that color.

e Click OK to save the color.

e Either repeat step one to add another color, or click the Exit button to close the

window.

Springhill QOffzet

Green

3 Cartons ar more

Auto-Price Lock

What the Buttons do

"o

- o] . .
e Clicking the Manual Entry button makes all cost fields available for
manual entry.
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%- Clicking the Auto-Price button speeds things up because you need to
enter just one value - your paper cost in the full carton bracket. Costs in the
other two brackets are automatically recalculated to common defaults.
Because the program has no way of knowing what's in your vendor's price
book, these costs are estimates. Likely to be good enough for 500 letterheads
but not for 10,000 catalog sheets.

Clicking the One-Price button ignores brackets and applies the full
carton price regardless of quantity. There could still be a price difference, but if
there is, it's due to sliding-scale markups in My Store. For instance, a 25%
markup for a full carton and 30% for less than that.

Clicking the Delete button will delete the item highlighted in the
black panel. Clicking the Zoom button will display it.

16.4 Fastpricing Buy-it Paper

Keeping your paper prices up-to-date is, well, housecleaning - tidying up and getting
rid of cobwebs. Not something we look forward to when we get up in the morning. But
with paper playing such a large role in most printing projects, unavoidably necessary.

It's almost fun with in-Stock. Here all colors are priced the same, confining the update
to just two entries, one for white, one for color. Done in no time.

In the Buy-it paper file, different approach. There each color gets its own price tag to
accommodate separate price levels the mill might be using (and usually does use) for
light and dark colors. Those tags all need to be updated one at a time. It makes your
pricing more granular, but price updates more time-consuming.

We can help with that. Here is how you can make short thrift of updating your Buy-it

paper prices:
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Update Products
Update In-5tock Paper

Update Buy-It Paper » Update Paper
Update Inks » | Bulk-Update Pricing

Update Merchandise o
e PSS ML;M S NS

e From the main menu, go to File > Update Buy-It Paper > Bulk-Update Pricing.
¢ Click the Paper Type button to select what you want to update.

e Enter your new costs, then click OK. This will save your entry and advance the
highlight bar.

%\ ke

In the next window, the only entries you can change are costs, pricing method
(manual, auto-price, one-price), and whether to allow partial reams. To edit other
Buy-it properties, go to My Store.

F.elly Paper

S pringhill Offzet

|veary
8-1/2%11, B0 b

We pay per 1,000 sheets

Lezs than 1 Carton 15.38
Full Cartorn 10.25

3 Cartong or more 706

Auto-Price Lock

a0l ZIOm

© 2018 Helmut Heindel



Managing your Paper 367

16.5 Saving Custom Paper

Custom paper is paper you create on demand when you have nothing on file to
choose from. You create it by "customizing" an item you do have, in either your in-
Stock or Buy-it paper file.

Custom paper is generally a one-of affair. There's no file available to save it in and
none is needed, because all the information is saved as part of the quote or order. But
what if you wanted to park this custom spec'd paper somewhere anyway because it
might come up again? Easily done. Click the piggy bank button to make it one of your
regular Buy-it papers.

Could pricing by weight present a problem? If you recall, Buy-it paper must be priced
per 1,000 sheets. Naw, we're good. If the Custom paper is sold by the pound or kilo,
Morning Flight will quietly convert each cost entry to its 1,000 sheet equivalent. Not for
the quote you're working on, just for the Buy-it file.

Step-by-Step

Precizion Automotive

Product Bulletins

5142 w11 [F2 e ] 64.80

Faper 20 Ib Royal Bond

17 22, white [Ealle 31.65

Printing i ik, on front

R Y

T T g %

¢ Click the F3 button, then select a paper either from your in-Stock or Buy-it file
that comes close to what you need. If you can't find one, go to step two. You
can always build Custom paper from scratch, you don't need a base item to
inherit from.

¢ Click the button to the right of the F3 button, then configure and price the paper.
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Regal Bond

per 1,000

Carton Content

[ Mo partial reams

We pay per 1,000 zheets
12418

Lezs than 1 Cartan 4293
Full Carton 28.65

3 Cartonz or more 19.74

Auto-Price Lock

B0 BED O A0 Z0

Click the Piggy Bank button before you click OK to save the paper as a
regular Buy-it item.

Bir.
=i Click the Im port button to retrieve a Buy-it paper, to use as is or as a base
for customization.

16.6 Changing Carbonless Colors

On quotes for pre-collated carbonless forms, Morning Flight automatically selects in-
Stock paper to match. To make that possible, the program comes preloaded with five
carbonless paper sets in the most common sequence of colors. Common in the
U.S., that is. Your standard color sequences for the five pre-collated sets may vary.
Here is how to change colors:
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YWeight I ame Type Size
2-part | v Carbonless Set Carbonlezs | 8-1/2 811
Jpart | v Carbonless Set Carbonlezs | 8-1/2 %11
4-part | v Carbonless Set Carbonlezs | 81/2 811
B-part | » Carbonless Set Carbonlezs | 3152 %11
B-part | » Carbonless Set Carbonlezs | 3152 %11

ViNE O

369

Category

Wiriing
Hook/ Fex?
fovend alfial
Emvelopes

Al

= Click the My Store button, then click My in-Stock Paper.

e In the black panel, click Carbonless.

“ Place the highlight bar over the item you want to change, then click the

Colors button.

e To change the color of the bottom sheet in a 3-part set to blue, click the third
Radio button, then click Blue in the list on the left.
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1 White
: L2 rellow
Gald @ EBlue

[areen

Non in-Stock Paper

To change the color sequence for Buy-it paper, click the button next to the color field.

MCR Carbonlessz

M ame

Carton Conte 1670

ST, T e e e SR L S e e

16.7 The Case for Inventory

Printing is a price-driven industry. Looking for an unfair advantage? Look no further
than in-stock paper. Carefully selected, then ordered in full cartons and always priced
that way, in-Stock can give you a significant competitive edge. The fact that it's
generally on hand for quick delivery just puts icing on the cake.

Say you want to sell letterheads and envelopes for less than what your competitors
are selling them. The most popular paper for stationery in your area is Camelot in
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white and a couple of off-white colors. Here's the rub: The average quantity on the
orders you're getting is less than 5,000. Much less in some cases. More like 500.

That's classic full carton territory. The way to undercut the competition is to add
Camelot in the most popular colors to your in-Stock paper list, always buy those
colors in full cartons, then enter "full carton" bracket costs into the "less than 1 carton”
entry fields and pass the savings on to your customers.

We pay per 1.000 zheets

Colors
Lezz than 1 Cartan l-w
Full Carton 39.00 41.00
3 Cartons or maore 26.87 28,25

Of course, having the lower price, that's just the beginning. Making your customers
aware that you have the lower price, that's when the plan comes together and brings
results. As it did years ago with our Great Instant Paper Caper, a Unitac promotional
campaign when we still ran a retail print shop.

The Great Instant Paper Caper

"me of the best naw ideas in prnting
t2 come alane in vaears.”
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And, like most good ideas, this one is simple. Most printers wait for the job to come in,
then order the paper. That looked peculiar to us from the very beginning, having read
that 91% of all printing paper is specified by the printer anyway, and having learned
early on that the penalties for buying paper piecemeal can be enormous.

For instance, while the usual press run is under 3,000, even the smallest carton holds
5,000 sheets. Orders for less than that can draw a surcharge of 100% ... One
Hundred Percent! That's double, in round numbers, and in effect makes the cost of
buying half a carton exactly the same as buying a full one. So it boils down to this.
Either we buy half a carton and pay for a full one, or we buy a full carton and hoard
what's left over and before we know it we're up to our dimples in old paper.

Comes now our Instant Paper Caper. The secret? Make a list of the most asked for
brands and colors, always buy those brands in full cartons ... and then get bigger
shelves! True, our caper does tie up money in inventory, but that's a small price to
pay when you look at the dividends:

No Penalties for Broken Cartons. Not when you order 2,000 of our in-stock house
sheets, not when you need just a few hundred. The money we save by buying paper
in full cartons, you save too.

No Excuses about having to wait for the Paper. Because at Unitac, the paper will
be waiting for you. Tons of it, from plain bonds to fancy texts, in a whole rainbow of
attractive colors.

No Over-Runs to allow for spoilage. When the job develops a few wrinkles, we can
go to the shelf for more paper. What we don't need we can put back. This means at
Unitac, when you order 10,000 flyers, you'll get 10,000 flyers, not 5% over or under as
is trade custom.

wery . . i

[here is a way o do
Y

i

s f P T _.'/.-r 1]
ICeter, nail.

T.A.E.

Thomas Alva Ediszon would hawve been pleased.
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17 Managing your Inks

17.1 Updating Inks

This topic describes how to add or update in-house and special mix inks. In-house
inks are inks you either buy ready-mixed or mix yourself, then offer them without
charging for the mixing. Special mix inks, the second variety, always carry a mixing
charge. Doesn't matter whether you mix them yourself or pay the vendor to mix them
for you.

Both in-house and special mix inks can be included in My Inks. Unless you offer a free
wash-up during so-called Color Days, all inks also carry a wash-up charge. With in-
house inks, the customer only pays for the wash-up. With special mix inks, you're
charging for the wash-up plus the mixing.

-ﬁ?%

Humber Mame Color
i PMS ADS e Flint [ray [aran i~
PrS 877 | v Metallic Sikver Gray [MET]
2 Process Cyan Blue
v PMS Reflex Blue Blue
v PM5S Proceszs Blue Blue
PMS 072 |+ Blue Blue
FHS 286 |« Delft Blue Blue
PS 300 |+ Briliant Blue Blue
»" PS5 Purple Purple
v R4S Winlet Purple
v PS5 Green Green
PRS 347 v lvw Mint areen W

e Wk # o B
SR

= Click the My Shop button, then click My Prepress, then My Inks..

e The ink selection window will default to the Ink System (Pantone, HKS,
Focoltone) in use for your country. To see all inks, click All in the black panel.
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e To restrict the display of colors to a specific Color Group, click the appropriate
color bar.

Click either the Add button to create a new ink, or the Update button
to edit an existing one. For this demo, we'll add a new ink, PMS 187, to our in-
house list.

%\ bk

Morning Flight is shipped with both mandatory and standard ink colors. The
mandatory colors - White, Process Yellow, Process Magenta, and Process
Cyan - are marked with an open circle. Standard colors will show either a check
mark if they're active, or a red bullet if they're not. The only difference between
standard colors and colors you add yourself is that standard colors are
deactivated, the colors you add are deleted.

| 187 ” Burgundy Red

[ Special Miz

Ho Charge on
| Monday | Thursday
[ Tuesday [ Friday
| wednesday [ Saturday Brovin

e Enter PMS 187, Burgundy Red. Because we're adding this as an in-house ink,
we'll leave the Special Mix box unchecked. Leaving the box unchecked doesn't
mean we won't have to mix the ink. In fact, we probably do, but the program will
quote the ink at the pre-mixed price.
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%\ ko ote:

Although both the ink number and the ink name are optional, you'll need one of
them to identify the ink. To illustrate, "PMS Reflex Blue" is Ok without a number,
and PMS 187 is Ok without the name "Burgundy Red."

Select Wash-up, Ink Type, and the appropriate Color Group. With the
Pantone system, Morning Flight generally knows what the color is from the PMS
number, and whether it requires a light or a dark wash-up. Still, check to make
sure.

Some printers have "Color Days" (if it's Tuesday, it must be PMS 300). This
doesn't affect quoting, because you rarely know in advance on which day the
order will be placed. But it will affect job entry in Morning Flight Gold. If you
advertise color days and want to plan ahead, check the appropriate boxes. With
all six boxes checked, there is no charge for that ink, ever. Not in orders, not in
estimates.
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18

Managing your Customers

18.1 Adding New Customers

Technically, saying we're "adding a new
customer" can be somewhat of a
misnomer. Customers are people who've
bought things, people who have placed
orders. People who ask for quotes we
ought to call prospects.

Then again, this probably isn't your first
day in business. You're likely to have real
customers, regardless of the distinction
the program makes internally.

This topic describes the quickest way to
integrate those customers into Morning
Flight.

bllel Coratormess

Previous Additions

Ermpire Builders Inc. 112242014
ACME Autormobive 11/22/2M4
International Publizhing Co. | 11/22/2014

Campary The Pretzel Shop

Addresz 148 Main Street

City Killeen

State/Zip T || 43558

My Preferences
Change Background
Shows window 1D

Py Sarld
My Shop

My Store

Update Customers !

Update Customer Contacts

T TS L U I S W

Contact Bruce Baker
Informal i Dear Bruce:
Phare 435-3504

Fax

ebd il bruce.baker@live. com

{7 Z0
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e From the main menu, go to File > Add Customers.
e Enter the customer's Name, Address, and Contact information.

¢ Click the icon (or the box to the right of it) to enter the contact as male or
female.

¢ Click "Informal/Formal” to the left of the icon to change the salutation.

%\ P ote:

If there is more than one contact, you'll be able to add them later. The contact
you'll want to enter here is the one you're working with most often.

e To enter payment terms, click the Payment button.

e To enter the tax rate, click the Tax District button.

%\Mutﬁ:

Neither payment terms nor tax rates are used in the Free Edition of Morning
Flight. However, all editions use the same customer file. The payment and tax
information you enter here will be needed later if you decide to upgrade and add
job entry and invoicing.

When you're done, click OK. The window stays open, ready for the next customer to
be entered. At the end of the session, click the exit button to close the window.

fil

customer in that list (and also from the customer file), place the highlight bar over the

The last customer entered is shown under previous additions. To delete a

entry, then click the trash can.

S

[

To zoom in on a previously entered customer, click the camera button.
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Previous Additions

Met 30 Days

Ermpire Builders 9/ 8/2009 Ta
Precizion Automotive 99742009 § A :
The Pretzel Shop 3/19/2009 Maonroe

18.2 Updating a Customer

This topic describes how to add or update customers. The customer file is without
guestion the most heavily used file in any kind of business system. It's also the most
fluid, the file with the most changes. That's why, in Morning Flight, you can add or
update customers on the run. Virtually every customer selection window comes with
its own add and update buttons.

Mame City
ACKME Supplies Killzen
Empire Builders Syracusze
Precizion Automotive | S pringfield
The Pretzel Shop San Francizco ;

2005

e [ 1] ] ]

Lazt Quote /202009

L T T ]

|- L _
Ed AL
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Step by Step

i Click the My Store button, then click My Customers.

E Click either the Add button to add a new customer, or the Update
button to edit an existing one. For this demo, we'll add a new customer.

Corslomer

Addresz

| Contact

The Pretzel Shop

The Pretzel Shop
A8 Bayside Blvd.

San Francizco

Cé, [ 54305

¢ Enter the Company Name and Address.
e If necessary, click the Country button, then select the customer's country.

e Click the Contact tab.
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Address Cantact Terms

The Pretzel Shop

Tina Baker
BBh-295E
t.baker=gmail. com
Comparny Phone AR5-2956

Company Fax

¢ Enter the main contact's Name and profile.

%\ b ke
If there is more than one contact, you'll be able to add them later. The contact
you'll want to enter here is the one you work with most often.

¢ To change the salutation from Dear Ms. Baker to Dear Tina, from formal to
informal, click the Salutation button, then check the "Informal” box. To only
change Gender, click the icon in the black panel.

5 alukation

The Pretzel Shop

Dear Tina:

Tina Baker

e Click the Terms tab.
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Address | Contact Terms

Payment

The Pretzel Shop

Credit Linnit
|v Reduce Prices

taonme

| Increaze Prices

lv Charge Tax

¢ We might be getting free pretzels now and then, so we'll check the Reduce
Prices box and enter a 5% courtesy discount. Keep in mind that only quote
sheets, estimates, and invoices reflect discounts or surcharges. Price sheets
and time sheets always show the actual prices calculated by Morning Flight.
e To change payment terms for the Pretzel Shop, click the Payment button.

The Pretzel Shop
2510 Days, Met 30

Deposzit

Cazh Dizcount

Digcount 0 aps

Met Days
Credit Limit
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¢ To change the Pretzel Shop's tax district, click the Tax District button. If
Charge Tax is checked, Morning Flight will automatically add the combined tax
rate (State tax + County tax in the example below) to the invoice amount.

Tnves B

]

konme

Sales Tax

State Tax B.00%
County T ax 3.25%
0.00%

|v Charge Tax on Shipping

&N 20

%R ke

If you're not collecting tax because a customer is tax-exempt, uncheck the
"Charge Tax" box under terms. If you're not collecting it because the customer
is out of state, change the tax district to "Tax Free" instead.

District Hame Rate
_Monme Salez Tan b
@ TaxFree 0.00 %

R LR S e Y A
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18.3 Updating for Order Entry

Morning Flight divides customers into real customers, people who buy things, and
prospects, people who merely ask for quotes. You don't actually see the difference
until you're ready to update and notice the two extra tabs at the end that have
magically appeared for the good guys, the buying kind. This topic describes what's
hidden in those extra tabs.

Corslomer

Addresz

| Contact

Ilzually Orders

ACME Supplies

Alertz/Motes
Fusgzy about ink, colars

Always azks far everthing vesterdap but
doezn't pick it up until a week, later. On the
ather hand, uzually pays nght away.

Z0

Tab 4 - Notes

Most of the entries on the Notes tab are self-explanatory. Two that warrant
commenting are

¢ Transactions. When you mark the customer as either difficult to deal with or,
worse, suspended, it shows up on the customer selection window. As you
would expect, suspended customers are blocked from placing orders.
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M ame City
{1 ACME Supples Chicago
pirz Builders Syracuze

ozlovwzki Plumbing 5| Bockford
Precizion Automoative | Springfield
# The Pretzel Shop San Francizco

Aol i W

o Alerts/Notes. Only Alerts show up on job sheets and job tickets, following any
notes you've entered for a specific order. In the example below, "Deliver with
envelope order" is job-specific. Customer Notes are for internal use only, for
viewing by office staff. They don't get printed.

FPackaging Shrinkrap

Ok owerfunder | Ok to print: |
Sawve File Samples | Final Count: |

Hotes: Deliver with envelope order. Caution: Fussy about ink calars.

_.Lf..—-l.l‘."-w‘- ey MM\*-.#H M«," “.M
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Tab 5 - Stationery

Woea\

Address | Contact Terms Mates Statianerny

ACHME Supplies

Paper (F3 fl@ |

“endor Faper 24 || Clazzic Linen

Antique Gray
Ink Colors Fa  Fs | PMS PMS Purple

Black + 1 Color on front

0E Z[

How often has this happened to you? The customer reorders letterheads but wants a
darker shade of the purple ink they've been using for their stationery. Or decides to

switch to Classic Linen from Classic Laid. Two months later they reorder their

envelopes. When the job jacket is pulled for the envelopes, still showing the old specs

of course, who gets the blame for not remembering that the letterheads were
changed two months earlier?

That's where the Stationery tab comes in. With any luck, whoever enters the

letterhead order will update the tab. And whoever enters the reorder for envelopes will

remember to check it.
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18.4 Updating Taxes

Before sales tax (or VAT) can be charged, it's necessary to first set up a tax district.
This topic describes how to add or update tax districts and the corresponding tax
rates.

Taxes rarely need updating. Actually, you don't use them at all when making quotes.
On estimates, Morning Flight excludes local taxes and instead states under remarks
that "these prices do not include sales tax." The only reason taxes are included in the
Silver Edition is because all editions use the same data files. Setting up taxes now will
save you from having to update each customer later, one at a time, when you decide
to upgrade to the Pixelblitz or Gold for job entry and invoicing.

Vo Roies

Digtrict M ame Fate
i Maonroe Sales Taw B.2h
T TaxFree 0.00%

z:1

e From the main menu, select File > Update Taxes.

Click either the Add button to add a new tax district, or the Update
button to edit an existing one.
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b onmoe

Sales Tax

State Tax B.00%
County T ax 3.25%
0.00%

Iv Charge Tax on Shipping

&N Z0

e Enter the new Tax District and Tax Name. The tax name is what will be

displayed on invoices created with the Gold Edition.

e Enter the Type of Tax and the Percentage. If the district is subject to more
than one tax type, invoices will reflect the combined tax rate (State Tax + County
Tax in the example).

e If Shipping is taxable, check the box.

¢ Click OK to accept and close the tax update window, but don't close the tax
selection window just yet.

To make the new tax district your primary district (your default), place the
highlight bar over it, then click the Number 1 button. Now click OK.

low Roes

District MHame Rate
T Monmoe Sales Tan i
Tax Free 0.00%

gl e ) _-ﬂr_‘-- x.‘tﬂ e
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18.5 Updating Shipping

Before you can charge for shipping, you first need to decide what shipping methods
you'll be offering. This topic describes how to add or update shipping methods and

Sk Vi

Harme Hate

rates.

(Y Moty whien ready
Frearranged Pickup
COur Truck,

Delivery Semvice 6.50
Parcel Post
PS5
FedEx

ol

¢ From the main menu, select File > Update Shipping.

Click either the Add button to add a new shipping method, or the
Update button to edit an existing one.
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Delivery Service

Zone 1 add
£one 2 add
Zone .3 add

Minimum

':i MNa Charge

e Enter the the Name.
¢ Select how you intend to charge for it (per box, per shipment, etc.)

¢ Enter the Base Cost and extra charges for shipping to zone 1, 2, and 3.

To leave any of the zone charges blank, click the umbrella to turn off data
validation.
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19 Managing your Contacts

19.1 Updating a Contact

This topic describes how to add and update a customer or vendor contact. First, we'll

add a new contact for ACME Supplies, a customer. The procedure for vendors is
nearly identical.

Step by Step

- Click the My Store button, then click My Customers.

Hame City
ACME Supplies Filleen
Empire Builders Syracuze
Precizion Automative | 5 pringfield

o o RS RS LB Francizge,

e Double-click "ACME Supplies."
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Address Contact | Tems t

Bk

mid Click the Contact tab, then click the Rolodex button at the bottom of the

ACME Supplies

Dear Sandy:

Sandy Peterzon
555-3478

5. peterson@msm. com
BB5-3478

Z0

window.

L
3

(]

In the contact selection window that opens, click the Add button.

391
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Coniac?™

Mame/FPhaone | Motes | Custom Entries

S alutation

ACME Supphes
Dear Mike: PP

Full Hame kike Hamilkon

Job Title/D epartrment Buyer

Phone 555-2945

ri. hamilkaniEacme, com

Bz

¢ Enter the contact's Full Name. The rest of the information is optional.

¢ To change the salutation from Dear Mike to Dear Mr. Hamilton, from informal to

formal, click the Salutation button, then uncheck the "Informal” box. If you only
need to change Gender, click the icon in the black panel.

ACME Supplies

Dear kr. Hamilkar:
tain Contact kdike Harmniltan : |
%\ btz

There is another way to update customer contacts. In the window below, note
the menu item "Update Customer Contacts" just above "Update Vendors."
Clicking that item will open a selection window where the entire customer
contact file becomes available for editing.
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Updating a Vendor Contact

1. From the main menu, click Update

Vendors.
My Preferences _ _
Change Background 2. In the selection window that opens, double-
Shiowy Window 10 ] click to select the vendor.
Py iarld .
Mz Shap 3. When the contact window opens, follow
My Store the steps outlined earlier for customer
Add Customers contacts.

IUpdate Customers
Update Customer Conkacts

_Updste vendors )y

pdate In-Stock Paper

L U NN PR TR I U SR S

19.2 Changing the Salutation

This topic describes how to change the title (Ms., Mr.) and salutation (Dear John) of
customer contacts.

Step by Step

¢ From the main menu, select File > Update Customer Contacts.

Add Customers ’

Update Customers J

Update Customer Contacts

Update Yendors h }
U ——

e In the window that opens, double-click the contact you wish to update.

e In the contact update window, click the Salutation button.
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Title bz, v Female
v Irformal

Eirzt Mame Sandy
Hiddle

Last Mame Peterzon

Salutation Dear Sandw:

Sincerely yours,

iR Z:

¢ Click the appropriate check boxes for Female and Informal.

¢ The three radio buttons next to each other are mainly for use outside of the
United States. The button you'll click will decide which of the three names (first,
middle, last) will become part of the Salutation.

%\Mutﬁ:

In many Spanish-speaking countries it's common to find three names on a
business card. Sr. Galo Ocampo Aldaca would be addressed in English as Mr.
Ocampo, not Mr. Aldaca. Galo is his given name. His father was Mr. Ocampo
and his mother was Miss Aldaca before she married. To have the salutation
read Dear Sr. Ocampo, you would click the center button.

e If necessary, enter a Custom salutation and closing statement.

19.3 Adding Notes

This topic describes how to add notes and comments for customer contacts.
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Step by Step

e From the main menu, select File > Update Customer Contacts.

Add Customers ‘
Update Customers :

Update Customer Contacts
Update Yendors h }

DT S R S PR S W S S (O

¢ In the window that opens, double-click the contact you wish to update.

¢ In the contact update window, click the Notes tab.

Condact™ R

HamePhone Notes LCuztom Entries

Doreen Palmer

Dareen generally does the ardering of
stationery and other office material. Wery
knowledgeable and a pleasure to work
with,

Bz

¢ Enter any notes and comments.
¢ Click the Custom Entries tab, then click the My Entries button.

¢ In the window that opens, enter "Birthday" in the left entry box on line 1.
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L L]
Doreen Palmer % » Default

Birthday

¢ Click OK to close the My Entries window.

¢ Back in the contact update window, enter Doreen's birthday. All custom entries
are optional.

Mame/Phone | Motes Custom Entries

My Entries m

Doreen Palmer

Birthday T 95R
ke e, ﬂ-,q_***‘x«“-r-

Working with Custom Entries

Custom entries are various bits and pieces of information about each contact that you
may want to keep track of. Such entries can be custom tailored for each contact, but

are usually universal descriptions you set up in advance and make available as
defaults for other contacts.

You can enter and update these defaults whenever the "My Entries” window is open.

© 2018 Helmut Heindel



Managing your Contacts 397

Doreen Palmer

D efault

Birthday

Birthday

Interests

1
4

I

RS Z:

e To copy and paste your universal default descriptions on the right into My

Entries for Doreen on the left, click the left arrow.

e To copy and paste My Entries for Doreen on the left into your default

descriptions on the right, click the right arrow. That will change your universal
defaults to match the descriptions set up for Doreen.

%\ bk

Default descriptions don't cascade through your contact file. Whatever
descriptions you have already entered for a particular contact will remain

unchanged when you change the defaults. The only function of defaults is to

present you with a convenient, predefined set of descriptions that will make it

easier to add or update a contact. You can import these defaults and use them
as is, or import and then customize or delete them.
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20  Writing Memos

20.1 Writing a Memo

What can the Morning Flight memo writer do that your word processor can't? For
openers, it can access your customer and contact file. That means you can
compose, fax and e-mail a memo from within the program ... in under a minute. "Dear
Jennifer, Thank you for your inquiry. Our quotation is attached. Please call me with
guestions," or something along those lines.

Often though, that's enough. A short but quick response is almost always better than
no response. And even a canned, boiler-plate note will get you more customer
satisfaction than all those meticulously crafted e-mails you meant to send but never
got around to.

Step One

Before you can write a memo to someone, that someone has to be in your contact
list. Already have contacts on file? Skip step one and go to step two. Otherwise, let's
add a fictitious Jennifer Jones at an equally fictitious ACME Supplies company.
Remember to delete both after we're done writing this memo.

= From the main menu, click the My Store button.

¢ Click the My Customers button.

Click the Add button and enter "ACME Supplies" as the customer.

¢ Click the Contact tab and copy the information from the screen below. Make
sure the salutation is "Dear Jennifer" and that Jennifer is listed as female.
Otherwise, click the salutations button and make the corrections. For help, see
"Changing the Salutation".
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| 1-:' . o 15 1
Address Contact | Tems |

S alutation

ACME Supplies

Dear Jennifer:

Main Contact Jennifer Jones
Phone ARG 28

ehd ail [EnrpEiacme, com

Cormpany Phone ABA-3728
Cornpary Fax 555-4365

B Z[

Step Two

The whole idea behind the memo writer is speed, so rather than compose each
memo from scratch, we'll build a small library of memo clips. See "Making Memo
Clips" for instructions. Here are the three clips we'll need. Replace 555-2643 in clip
two with your own phone number.

1. Thank you for your inquiry. Our quotation is attached. Prices are valid for 30
days and do not include sales tax. We estimate that delivery could be made
within 3-5 working days after receipt of your order.

2. Please call me at 555-2643 with any questions. | hope we can be of service.

3. A closing statement (with your own name, title and company), formatted as
shown below.
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Sincerely,

Tom Baker
Sales Manager

Step Three

sl s ot - ot W

If your company information already exists, skip this step and go to Writing the Memo.

-
From the main menu, click the My World button.

¢ Click the My Company button and enter your own company name, address,

and phone number.

¢ Click the My Preferences button, then click the My User Account button and

enter your personal profile.

Ky Account

bp Mame

Fhone

Eax

ehdal

| by Paszword

Taom Baker

Adrmin

Salez Manager

hhh-2643

5h5-2688

torn. bak er@acme. com
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Writing the Memo

It took us a while to get here, but luckily, the first three steps are strictly make ready,
one time only. With those out of the way, writing the actual memo takes less than a
minute.

e From the main menu, select Write Estimate > Write/Edit Memo.

File Log-in  Quoke Price BANIENEEE RN Yiew  Print  Window  Help

Wwrite Edit Estimate
Browse Estimates E m E

My Estimate Preferences

Write Edit Memo k
Erowse Memos

TG N S WS

Lizkarmer

x

ACME Supplies

C 4454009 | Jennifer Jones ¥ our gy of Ao

il B AL

AL,
In the black panel above, click the Rolodex button to select the customer.
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E Click either the Add button to create a new memo, or the Update
button to edit an existing one.

Br.
=i the window that opens, click the Rolodex button to select Jennifer.

Jennifer Jones

Ehere FEE-3728 | Eax | 5954365

[ENNYERACTIE COMm

“'our inguing of April 13
4/14/2009 B Page

Dear Jennifer:

iR Z:0

¢ Click the Text button pointed to by the arrow.

¢ In the window that opens, double-click "Thank you for your inquiry ..."

Language Mezzage

Englizh Fleaze call me at 555-2643 with any quest
E nglizh Sincerely,  Tom Baker Sales Manager
Englizh

e i
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e Click the Text button in the memo window for a second time.

e Select, but don't double-click, "Please call me ...

Click the Copy to Clipboard button. Now position the cursor after "your
order” in the text box, press the Enter key twice, then press Ctrl-V to paste the
second memo clip next to the first clip. Repeat steps six through eight for the
closing statement ("Sincerely"), then press OK.

Drear Jennifer:

tax. “We estimate that delivery could be made within | #
35 working davs after receipt of pour order.

Fleaze call me at 555-2643 with any questions. |
hope we can be of zervice.

- oo #,.‘._. - _-' et i,

%\Mutrﬁ:

If this particular combination of clips is something you need regularly, save
them as a group. Now you need to press the text button just once. And if the
text in the text box isn't exactly what you would like it to say, you can edit it
without having to change the original clip. Hard carriage returns (when you press
the Enter Key) are preserved in memo clips. Note the extra line space between
"Sincerely" and "Tom Baker" in our example.

The Result

a3
Click the camera button in the memo browse window to view the memao.
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DATE: <M 4Z009

TO: M= Jennifer Jones

ALCME Supplies

FHOME: 555-3723

FAX: 5554065

FROM: Tom Baker

FHONE:

FAM:

SUBJECT: “vourlnguing of April 13

FAGES: 1 Including this page

Dear Jertifer:

Thardk you for your inguiry. Our quotation is attached. Prices are walid for 30 days and do not
iiclude zales tax We estithate that delivery could he made within 3-5 working davs after
receipt of wour order.

Please call me at 555-2643 with any questions. T hope we can be of service.

Situzerely,

Tom Baker
Sales Manager

20.2 Adding your Logo

Here is the shortest topic in the whole book. Want to have your logo show up on the
memos you write? Save a picture of it as "MyLogo.gif" or "MyLogo.bmp" in your
Morning Flight directory (C:\Program Files\Printfire\MorningFlight by default). The logo
you see here is 120x60 pixels, but you can make it any size that will fit. It will have to
be either a .GIF or a .BMP - no JPG's or TIF's allowed.
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MyLogo.gif

[or MyLogo bimp)

DATE: 37154

TO: M= Jo

ACME

fl n:nr'ning":FIight

PHOME: &55-2]

DATE: 3¢ 152002

FAX: 55544

TO: M= Jennifer

20.3 e-Mailing a Memo

ACME

This topic describes how to e-mail a memo to a customer contact. More specifically,
to a customer contact with an e-mail address. No address, no e-mail. Browsers are
pigheaded that way. When you think about it, so is the Postal Service. And UPS,

FedEx ...

Step by Step

e From the main menu, select Write Estimate > Write/Edit Memo.

w'tite Estimate

File Log-in  Quaoke Price

Wiew  Print  ‘Window  Help

al B

Write/Edit Estimate
Erowse Estimates

My Estimate Preferences

Wtite/Edit Memo k
Browse Memos

o -q_.“.--.._"'\._ s r“"" ~, -“_\ .‘\\_-H.-.“_w o
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=
Permo 25 Lerslomer -@t%%@ = -
'{.\; I.,.bﬁ"”_u g

Customer

x

i@ 1 Empire Builders
g 2 ACME 5.

ACME Supphes

4452009 | Jenniter Jones ¥ aur Jnauiny of Ao

B
=il Click the Rolodex button and select the customer.

¢ Highlight the memo you want to e-mail. If the memo was written to a contact with
an e-mail address, the "@" button at the bottom of the memo browse window
will light up. If it doesn't, it's either because no memo has been selected yet (no
highlight bar in the browse box), or the browse box is empty.

. Click the e-Mail button. This will copy the memo to the Windows clipboard
and open your e-mail program (such as Outlook or Thunderbird) with the contact's
e-mail address filled in.

¢ Place the cursor in the message area of your e-mail program and press Ctrl-V
to paste the memo. You may want to add a reference in the Subject line and
make any changes or additional comments before you click the send button.
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/’I:E,a 1 R B R S S Your Inquiry of April 12 - Message (HTML) e e
- Message Insert Options Format Text Adobe PDF L7
2 s y
= 53 || (B L=
Paste — Mames Follow 3 Spelling
¢ b =
7 ’ g =2 e = = - g' Up~ -
Clipboard ™ Basic Text Include Options T || Proofing
jenny@acme.com
__ o
= Ct...
ey ||| -
Subject: Yaour Inquiry of April 12
£
Dear Jennifer: Y

Thank you for your inguiry. Our quotation is attached. Prices are valid for 30 days and
do not include sales tax. We estimate that delivery could be made within 3-5 working
days after receipt of your order.

Please call me at 555-2643 with any questions. | hope we can be of service.

Sincerely,

Tom Baker
Sales Manager

20.4 Making Memo Clips

With names, phone numbers, and e-mail addresses of your contacts readily available
in Morning Flight, why load a word processor just to write a short memo? Take it one
step further: Store common phrases as memo clips, then use them to build routine
messages, often without having to resort to the keyboard.
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Pomo s

English

Thark, pou for your inguiry. Our guatation iz attac a
Pleaze call me at Bb5-264.3 with any questions,
Sincerely, Tom Baker Sale: Manager

Thark, pou for your inguiry. ‘w'e are pleased to ol

These prices do not include zales tax and are wi
COur estimate includes total ink charges of

Ordenng all itemsz together would save

Eztimated delivery time after receipt of order

In anzwer to your request, we are pleazed to off
These prices do not include zales tax and are .
Thank, yau far pour arder. We are pleazed to col ™

mm

Adding or Updating

-4 In the Gold and Pixelblitz editions, click the Flight Engineer button (F-11).
Otherwise, go to the main menu and select File > Translate > Memo Clips.

¢ In the black panel of the memo clip window, select your Language.

Click the Add button to add a new memo clip, or the Update button to
edit an existing one.

%\ P ote:

Memo clips marked with an empty circle are mandatory and can't be deleted.
EST means the clip was created from within the Estimate writer. ORD, INV, and
GEN represent Order, Invoice, and General categories.
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21 International

21.1 Translating the Program

Thanks to Morning Flight's built-in translator, printers in Holland, Denmark, Greece -

any country where English, French, German, Italian, Portuguese, or Spanish isn't the

native language - can customize the program to suit their needs. What's more, they
can profit from their work by making the generated translation file available, for a fee,

to other printers. If you have a custom "My Language" file, please let us know and

we'll announce it on the Morning Flight Forum.

%\ ko ote:

Except for English and German, all built-in languages are works in progress.
We're translating the program one section at a time, beginning with what's on
the main screens and printed estimates. With that in mind, it wouldn't make
sense to create a "My Language" file for any of the six languages that are

already built in.

My World

by 't arld

by Clountry

by &EComparny
by &Preferences
by Cobntacts
by &bl emos
Address Format

Portugués

b eu mundo

Meu pais

Minha companhia
binhaz preferénciaz
Pezzoas de contato
Meus memorandos
Formato de endereco

]
Y
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Step One

File Log-in  Quake Price  ‘Write Estimate  Enter Order Inv-:m:e W Prigt—#findow  Help

OFE @07 SR O

o !_f 4 From the main menu, click the Flight Engineer button.

e From the Flight Engineer menu, select File > Update My Country.

Morning Fligsht Engineer

Inventory  Operations Tools  Window  Help

Show indow I n
pdate My Country 2

Translate . . . 3

ﬁpnrﬁus@ers,._.J—# U R R R

Place the highlight bar over your country, then click the Update
button. If your country isn't listed, place the highlight bar over a country with an
address format similar to yours, then click the Add button to add your country.

¢ Click the Language button, then select "My Language" and click OK. Close the
rest of the open windows with OK as well.

Step Two

e From the Flight Engineer menu, select File > Translate > Morning Flight.

¢ Translate the English word or phrase displayed in the left column and enter it in
the right column. Make sure the length, including blank spaces, doesn't exceed
40 characters. If the text you're translating is for a window, check the results.
There may not always be space for 40 characters on the screen.

© 2018 Helmut Heindel



International 411

. When you're done with the page you're working on, click the Check button. If
there is a red bullet next to the Rolodex button, it means the page hasn't been
translated yet. Clicking the check button will mark the page as either done or
incomplete.

e Click the up or down arrow (or press PgUp or PgDn) to turn the page. Turning
the page automatically saves the changes.

Bt
=l TO select a new page, click the Rolodex button. In the selection window that

opens, the red bullet tells you which pages are done and which still need work.

%R rote:

Note the window number 2003B in the blue frame below. The display of window
numbers is triggered by opening the translator. That way you'll know which window
you're translating. The numbers can be switched on or off without opening the
translator by selecting File > Show Window ID.

WWW

1D M ame Type

v 2200B/2 | Paper Pricing - 2 Windon ~

v 224 | Contact M anager Window

v 220248/ | Export Contacts - 1 "Window

[l ALY | Ewport Contacts - 2 Wi

& 2028/ | Export Customers - 1 Window

& 2202872 | Ewport Customers - 2 Windon

® 300041 | Print Cluote - 1 Window

® 30002/2 | Print Quote - 2 Window

& 300043 | Prnt Quate - 3 Windaw

® 30MAA | Merchandize Cluote - 1 Window b
z<

The Results

The name of the generated translation file is RSMFile.TPS. You'll find it in the

Morning Flight application directory (C:\Program Files\PrintFire\MorningFlight by
default). To install the translated file on a different computer, find the directory into
which Morning Flight was installed, then override the original RSMFile.TPS there.
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21.2 Translating Content

This topic describes how to translate memo clips and salutations, and the names of
products, paper items, ink colors, and My Things. While Morning Flight's built-in
program translator lets you convert what you see on your monitor, here you're able to
translate what your customers will see on your quotes and estimates.

In the Pixelblitz and Gold editions, all translation functions are managed by the Flight
Engineer. What are "My Things?" User-defined prepress, postpress, and packaging.

File Log-in Quoke Price  Write Estimate  Enker Order Inw:m:e W Prige—Window  Help

QREE @R Ell'!" 2

Memo Clips

Stored sentences and paragraphs that can be pasted into estimates, invoices, and
memos.

Italhan

Grazie per la richiesta. Siama lietl di comunicarle A
| prezzi non includono le tazse sulle vendite & re

Il nostro presentivo include tasse totale per linct
L'ordinamento de bt gl articoli inzieme rigparmmie
Tempi di conzegna presvisti dopo la ricezione del

|r rizposta alla sua nichiesta, siamo ligti di presen

| prezzi non includono le tazse e restano validi p
Grazie per l'ordine. Confermiarno nei segquenti ter
Ordinando questi articoli tutti inzsieme ha risparmi.
Drata di conzegna prevista:

Grazie per l'ordine. L'ording & in corso di elabora %
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— u From the main menu, click the Flight Engineer button.

e From the Flight Engineer menu, select File > Translate > Memo Clips.

Morning Flight Engineer

Inventory Cperations  Tools

Shovs Window ID n

Translate . . . Marning Flight
Expork Cuskormers
Export Contacks

Window  Help

Ipdate My Country

pd

Memo Clips
Salutations
ik L il S e TS P

In the black panel, click to select your Language.

413

E Click the Add button to add a new memo clip, or the Update button

to edit an existing one.

%\ Fote:

Memo clips marked with an empty circle are mandatory and can't be deleted.

EST means the clip is used in estimates, INV in invoices, ORD in orders.
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Salutations

Titles, greetings, and closing statements (Dear Mr., Sincerely yours, etc.).

Spanish

S Pcia
Eztimado Eztimada

E ztimado E ztimada
Muy sefiores nuestios:

Atentamente,

Atentamente,

[ PALL

Englizh
German

French
Ital

e From the Flight Engineer menu, select File > Translate > Salutations.

¢ In the black panel, click to select your Language.

¢ Translate male and female Titles, Salutations, and Closing Statements, then

click OK.

Product Names, Paper Names, and Ink Colors

The names of standard products and paper items, and the colors of built-in inks
come translated into the six Morning Flight languages (English, French, German,
ltalian, Portuguese, Spanish). You can use the program's translators to customize
those names and colors to your liking. Naturally, in any language, an envelope should

still represent an envelope, not a post card or a letterhead.
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Products

Letterheads
Second Sheets
Letterheads

Offzet Copies

Catalog Sheets
Catalog Sheets
Real Estate Flyers
Brochures

¢ From the Flight Engineer menu, select File > Translate > Product Names.

¢ In the black panel, click to select your Language.

French

En-tétes de lette
Deurigme feuilets
En-tétes de lettre
Copies offzet

Fiches catalogue
Fiches catalogue
Brochures immobiligres
Brochures

415

¢ Translate the English Product Name displayed in the left column and enter the

translated name in the right column.

¢ Click the up or down arrow (or press PgUp or PgDn) to turn the page. Turning

the page automatically saves the changes.

¢ Do the same for paper colors.
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21.3 Money and Numbers

This topic describes how to format currency and humbers.

Morey | Humbers

Format F123.456.78

III ﬁ Symbal in front

123.466.78 [ Period ™ Comma ( Space

B+ Period ¢ Comma ¢ MoDecimals

PR

o !_., 4 From the main menu, click the Flight Engineer button.

¢ From the Flight Engineer menu, select File > Update My Country.

Morning Fligsht Engineer

Inventory Operations Tools  Window  Help

Show Windaow I r’n
Update My Counkry :

Translate . . . »

ﬁpn_rius@ersl*_.‘,q S e

© 2018 Helmut Heindel



International 417

Press the Update button.

¢ Press the Money button, then click the appropriate radio buttons to format your

currency.

e Enter your currency symbol, then click the up arrow to place it either before or
after the number, with or without a space.

¢ Click the Numbers tab, then click the appropriate radio buttons to format

numbers.

%\ bt

To enter the symbol €, hold down the Alt Key and enter "0128" on your
numbers keypad. For £, enter Alt-0163. For ¥, enter Alt-0165. It has to be the
numbers keypad, and you do need to type in the leading zero. The number
keys at the top of your keyboard won't work.

21.4 Adding a Country

Last | checked, there were 194 countries on the planet. You'll find profiles for 33 out of
those 194 in Morning Flight.

If your country isn't included, this topic will show you how to define the other 161. Or,
more accurately, some of the other 161. That's because current versions of Morning
Flight lack support for Unicode, a double-byte character set that enables computer
programs to read and write Chinese, Japanese, Korean, and Thai.

We're not ignoring that part of the world. We just need more time.
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Australia

Argentina
Auztralia

Austna

B elgiurm [Flemizh]

Belgium [French)

Brazil

Canada [Englizh]

Canada [French)

Chile

Denmark,

Finland

EE Z0

!_, ! From the main menu, click the Flight Engineer button.

Filz Log-in  Quote Price  ‘Write Estimate  Enter Order  Inwvoice ™Sigw  Prist—%findow  Help

RrEE 27T BEET O

¢ From the Flight Engineer menu, select File > Update My Country.

Morning Flight Engineer,

Inwenkory  Operations  Toals  Window  Help

Show Windaw I0 /\
|Ipdate Erye B

Translate . . . k

Wﬂfwswerqu N .

L
3

MY Place the highlight bar over a country with currency and other conventions
similar to yours, then click the Add button.
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%\ ko ote:

Whenever you add a newrecord in Morning Flight, be it a country, a product, or
paper, the new record will inherit the properties of the record under the highlight
bar. It's usually easier to modify and build on information that's already there
then to start from scratch.

8.0

MHew
Lanquage |
Englsh arme

Description | FPago Pago |

Addresz Upper Caze
Jaohn Palmer
ABC Publizhing Co.
A0 State Street
Suite 28
7 » 8 CHICAGO, IL BOE0Z

S

Fantane

RS Z=0

¢ Enter the Name of your country, along with a Description. The name becomes
part of the address, the description is used for identification. You could have
(and, in fact, do have) two countries named Canada, one described as Canada
(English), the other as Canada (French). In the address, both will say Canada.

¢ Click the buttons for Language, Date Format, Paper System, and Color System.
Select from the pick lists.

¢ Click the Money button and define how currency and numbers are displayed in
your country, then configure your address format. The first, third, and fifth boxes
hold numbers (6 for city, 7 for state, and so on). Those numbers determine the
structure - the what goes where. The second and fourth boxes add blank
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spaces and punctuation marks (> for a single space, >> for a double space,
etc.).

Name

Dezcription | Fago Pago |
Addrezs Upper Caze

2 John Palrmer [
3 ABC Publishing Co. [
4 B0 State Street [
5 Suite 28 [
B 7 » 8 CHICAGOD, L 6OBO2 [w
~

e -‘-*"'._.-"."‘-"._ -‘\n.._‘." o e it J"-\v‘
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22 Our Store

Where can | get Morning Flight?

At the Morning Flight Shop, where the FreeRide Edition and demo programs can be
downloaded at no cost. All transactions at the store are secured using SSL
technology (Secure Socket Layer) that begins even before you give us any personal
information, and remains secure throughout your visit. SSL encrypts the
transmissions from our e-commerce servers as well as your computer. The store
accepts PayPal and most major credit cards.

When purchasing using your credit card, all your information is entered into an SSL
secure web page. Your information is then encrypted and sent directly to our credit
card provider's network, where your card and transaction are authorized and
approved. Your credit card information is not stored on our servers. If you prefer not to
transmit your credit card details over the Internet, please call us at 585-384-1023. We
would be glad to accept your order over the phone.

Morning Flight Shop

A OFFSET AND DIGITAL JUST DIGITAL FREE DOWNLOADS / SALE ITEMS HOW TO DOWNLOAD PRINTFIRE SHOWROOM

SKYPRICER DEMO
$0.00

SKU:

DEMO-SKY

Maximum Purchase:

1 unit(s)

oo

aoa

= PRODUCT DESCRIPTION
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23  Our Flagship Products

23.1 Morning Flight Gold and Pixelblitz

The Gold Edition and a digital-only Pixelblitz version represent our top-tier products.
Both add order entry, order tracking, and invoicing to the Silver Edition. And both
include a QuickBooks link for transferring customers into Morning Flight, and invoices
into QuickBooks. For expert estimators there's My Way Pricing, a powerful manual-
mode option found only in the Gold, Pixelblitz, and Skypricer.

The Gold Edition is priced at $595.00 and can be downloaded at the Morning Flight
Shop. The price of the digital-only Pixelblitz, identical to the Gold but without offset, is
$495.00. Both come with a perpetual use license, free support, and no annual fees. In
line with our standard policy, upgrades from lower editions are always available for
the difference in price, regardless of when the lower edition was purchased. All
Morning Flight programs use the same data files, so upgrading will be seamless.

File Log-in  Quokte Price  Write Estimate  Enter Order  Inwoice  Wiew  Print  Window  Help
: nE g
- 1 | ] i o L. ] ] i |
= - 2 . * : L i : : —xalf 2
L

A e e P Py T _-*"'""“*4]
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8-1/2 x 11 Bleed 240

12970 P

JIPH

Flate
CTP

Eilrn

Mone

My Way Pricing

Morning Flight's innovative automatic mode is by design product-centric. You begin
each guote by selecting a product that then controls makeready, press speed, and
other parameters. Using a digital SLR metaphor, when the camera is set on auto you
can be sure to get a usable picture, often a very good picture, but you may have to
jump through hoops to capture an image that's out of the ordinary. Set on manual, the
sky is the limit but the responsibility is now all yours. The end result could be anything
from two Dobermans in a coal cellar at midnight to a cover shot for National
Geographic.

The Gold and Pixelblitz editions let you switch between 'Safe for Cousin Mel'
estimating and a less safe but more flexible alternative: The option of full manual
control. My Way pricing starts with selecting the press, then manually entering job-
specific amounts for imposition and RIP, makeready and press speed, either with
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sliders or via custom entry fields. You can even create quotes the automatic way,
then edit them manually in My Way.

Order Entry

The Order Entry window looks and acts just like the window you're familiar with when
making quotes - no learning curve. The only difference is the blue panel on the right
that can be flipped through like a book by either clicking the radio buttons or pressing
the PgUp/PgDn keys. And, of course, just a single quantity, down from the three for
quotes.

ACME Pacific

Product Letterheads
Bl/zn ]l [rz]le ] + 1 ACME Pacific
[ 2 Provident / Centra
Paper 20 Ib Copy Bond 5
3 a1/7 % 11'?{\..%“3 E " 3 Precision Automotive
" 4 Empire Builders
Prirting Black ink or front
Prepress 4 = |
f" -
Postpress -q;;,- -

Keyword

— oy 83.40 g3.40 G CCC
il B

Converting a Quote

In Morning Flight, that's as easy as highlighting the quote in a selection window and
choosing the quantity ordered.
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Conwvert Print Quote

ACME Supplies Ryobi 1,200 H

Product Mewsletters
8-1/2x11 [2-up)
104 1/2009
FPaper 60 Ib Eumr_nudity Offzet ‘
JLLLC e Friday, 10/ 942009

Frinting
Ink Colars e
Prepress i« 4
Postpress -
L !.A/‘"“F s Mr‘ e

Repeating an Order

Need to repeat a previous
order? Same window,
different heading, nearly

the same process.
Make Qrder From Quote [!

Edit Order
Acknowledge Qrder
Browse Orders

Enkter Print Order
Enter Book Order B

Enter Merchandise Crder

Track Orders
v Show Due Dates on Stark-up
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Job Ticket
ACME Supplies 100900001
823 Main Streat
Pittsburgh, PA 34523
wivian.robersi@acme.com Quoted: 107 42008 ( !
Ordered by: “ivian Roberts Receiwved: 10/ 1/2009 Ship wia: Maotify when ready
Fhone: 555-354G By e ail Date Oue: Friday, 104 92009
Fa: FO #: AC-54972 12:00 F i

1.200 Newsletters. 8-1/2 x 11

Front: Black + 2 Colars
Blach: Black ink
2-up on 11 = AT, WET
Fress Sheets: [=u]u] Fyabi 43 Minutes !
Faper G0 1b Commuodity Offset On hand:
White (from our stodd)
ity used:
e need: ER =] 11 =17
Crraws: ] 1w AF
Ink Fhi5 109 Chrome “ellow
Fh3 185 Fireball Red
Frepress Composition 2:30 Hours
3 BEW Scans
FPostpress Cutting
Faolding: Letterfold
Fackaging Lettarbox
Ok owerlunder | + % ||- %% ‘ | OK to print: |
Save | File Samples | | Final Count: |
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Tracking Orders
1D LCustomer Due Station Letterheads
1
1106-00001 | ACME Pacific Awaiting OK ) Bond
05306-00001 | ACME Pacific Auwaiting OK
0106-00007 | ACME Pacific Auwaiting 0K
1106-0005M | Pravident / Centra Frepress
0705-0001M | ACME Pacific 2 12/18/200E | Prepress
30500002 | ACME Pacific Fostpress
v 0106-00002 | Provident / Centra Invoiced
» 1
» 1
» 01
» 1
& (3
——— 12:00 PM En December 2006
Due Date iz Jobis S M TWTF
o Approximate | Designed 1
Firrn [ Approved 3 4 5 B 7 8
Critc:a| v 10 11 12 13 14 15
v Prep Done
V. v Piirted 171819 20 21 22
n [~ Post Done 24 25 2B 2 28 29
EndoiDay | Delivered a
RO Z:0
Order Due Dates
Saturday, 104102009
Jaob Ordered Station Date due Time due
1,000 Erveelope 101002009 Fress Tuesday 5:00 FPhd
Empire Builders Ship wia: 104132009
A009-00003 Call when ready
1,000 MHewsletters 101002009 Cresign Friday 1200 Phd
Frecizion Automative Ship wia: 1001652009
1009-00004 Call when ready **Firm*t
1,000 Fall Catalog 10,1002009 Cresign Wednesday 5:00 Fhd
ACME Supplies Ship wia: 100242009
1009-00018 Call when ready
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Invoicing

meé:&

Custamer

The Pretzel Sh

Johs Bemarks

The Pretzel Shop

Optians Higtary

i’ 1009-000010 | Letterheads

v 1003-00002 | Envelopes

op

58 Bayside Blvd.

Invoice

1001

San Francisco, CA 94121 October 10, 2003
“our Order: BA-SSG65S Shipped: 100102009 Terms: Het 30 Days
Quantity Crascription Job Mumber Amauni
1500 Letterheads, 8-172 « 11 A009- 00001 245,10
Black + 1 Caler an front. Ink Colars: PMS 109, Paper 24 1b
Classic Laid, Matural White.
1,000 Enwelopes, Size 10, 4-1/8 = 9-1/2 1009-00002 26220
Black + 1 Calar an front. Ink Colars: PMS 109, Paper 24 |b
Classic Laid, Matural White.
Credit for duplicate ink colors 20.00-
Subtatal F477.30
Shipping 0.a0
Tax 29.38
Total $516.68
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Exporting Invoices into QuickBooks

. Morning Flight Engineer N ==
Inventory Tools Window Help

Export Invoices to QuickBooks
My Export Preferences

View Export Log

Import Customers from QuickBooks
View Import Log

Ihvoice e IE Arnaunt

<| 10412014 El
Empire Builders Inc. | 10/13/2014 s 10 22m4 @
‘ista Flight Charters 107342014

& ACME Automotive 1041242014
& Empie BuildersInc. | 107 8/2014 Today
& The Pretzel Shop 104 642014 Thiz Week-to-Date

Thiz Manth-to-D ate
Last Month-to-Date

All
Exported
Mot exparted

HOE & Z0

The Gold and Pixelblitz editions generate invoices but don't accept payments or track
receivables. For that you need a full-blown accounting system. In much of the world
that's likely to be QuickBooks. With Version 14.1 and the Transaction Pro 5 Importer
from Baystate you can eliminate the nuisance of having to key in a stack of invoices
into QuickBooks every night.
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The Transaction Pro 5 Importer is available directly from Baystate and sells for

$199.95 US with a perpetual use license. A trial version can be downloaded from the
Baystate website.

Importing Customers from QuickBooks

-

?'WMW

Fayrment m

Met 30 Days

a it ' '
MgHiEe @ QuickBooks
o " QuickBooks 2014
File Mame .
aecust | ImportCortomers rom

File: Folder I File name: Folders:

C:MkAFlight 1'11 BCUST.CSV c\milight —

Imported

INVOICES.CSV & [=r e | —
QBCUST.CSV = MFLIGHT

You don't need the Baystate Transaction Importer to transfer QuickBooks customers
into Morning Flight, just the new Morning Flight Skypricer, Gold or Pixelblitz where
everything's built in. Exporting lists out of QuickBooks has always been easier and
more reliable than transactions, primarily because the exchange of lists is riding on
tried-and-true CSV files. With version 14.1, we've automated the second step,

importing and merging your QuickBooks customers with those already stored in your
Morning Flight file.
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Index

-B -
Backing up your Data 22
Booklets

adding postpress 153

adding prepress 147

pricing bookbinding 296

quoting booklets 120

quoting custom booklets 128
Browsing and Updating 68
Buttons and Navigation 64

-C-
Carbonless
changing colors 368
guoting custom forms 134
quoting precollated forms 132, 310
Changing Invoices 223
Contacts
updating a contact 390
writing a memo 398
Conwerting
quotes to orders 196
standard to My Way 308
Copies
quoting copies 90
quoting custom copies 106
setting up for copies 333
updating copy products 345
Cursors 77
Custom Booklets 128
Customers
adding contacts 390
adding customers 376
changing the salutation 393
changing the tax district 380
customer notes 383
customer stationery 383
importing from QuickBooks 259, 376
payment terms 380
shipping methods 388
tax rates and districts 386
updating customers 378, 383
updating for order entry 383

-D -

Detail, how to view 71

Digital
quoting custom digital 102
quoting digital 83
selecting digital as primary 337
setting up for digital 319
setting up for RISO 322, 326
setting up for Xante 329
updating digital products 342
updating wide format products 348

Digital Prices, how to match 267

-E -
e-Mailing
an acknowledgment 185
an estimate 185
Estimates
adjusting prices 178
changing the language 187
creating an estimate 171
e-mailing an estimate 185
renewing old quotes 191
terms and conditions 175
using memo clips 175
Exchange Rate 30
Exporting
inwices from Morning Flight =~ 252

-F -
Flash Drive
installing Morning Flight on 27
Flight Engineer
adding a country 417
money formats 416
number formats 416
translating content 412
translating memo clips 412
translating the program 409
Formatting Text 78

- -

Identifying Quotes 169

Importing
customers from QuickBooks 259
invoices into QuickBooks 252

431
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Ink
adding ink colors 142
pricing ink 280
updating inks 373
Installing
on a network or flash drive 27
Installing Morning Flight 12
International
adding a country 417
exchange rate 30
money formats 416
number formats 416
salutations 413
translating content 412
translating the program 409
Invoices
cancelling an inwice 223
changing an inwoice 223
changing the inwice number
creating inwices 219

importing into QuickBooks 252

-J -
Job Ticket
printing 210
Job Tracker
showing dues dates 217
tracking orders 215

-K -
Keyword 157, 207

Log-in 32

Markups 48
general markups 276
job-specific markups 276
setting paper markups 276
Memo Clips
creating memo clips 407
translating memo clips 412
using inamemo 398
using in an estimate 175
Memos
adding your logo 404

creating memo clips 407

e-mailing a memo 405

writing a memo 398
Merchandise

pricing 301

guoting merchandise 96

updating merchandise products

Money
exchange rate 30
format 416

Morning Flight Gold 422
Morning Flight Pixelblitz 422
Multiple Computers

using Morning Flight on 27
Multiples x-Up 137

My Shop 46
My Store 47
My Way

conwerting a quote 308
entering orders 311
quoting 305

My Way pricing
carbonless 310

My World 43

-N -
Network
using Morning Flight on 27
Notes
adding to contacts 394
adding to orders 207
adding to quotes 157
Number Formats 416

-0 -
Offset
disengage 335
quoting custom offset 99
quoting offset 82
setting up for offset 314
updating offset products 338
Offset Prices, how to match 265
Orders
acknowledging 200
adding a keyword 207
adding notes 207
changing 204
entering 193, 198

351
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Orders
entering My Way 311
making orders from quotes 196
printing a job sheets 210
printing a job ticket 210
repeating 195
tracking 215, 217
wide format 198

-P -
Packaging
creating custom packaging 299
pricing packaging 298
Paper
buy-it paper 362, 365
categories 354
entering sizes 80

in-Stock 370
in-stock paper 358
inventory 370
markups 48

pricing 273, 370
quoting custom paper 115
setting markups 276
special paper 367

Password 32

Pixelblitz 422

Postpress
adding custom postpress 156
adding postpress 150
adding postpress to booklets 153
creating custom postpress 293
pricing postpress 289

Preferences 44

Pre-Launch Inteniew 30

Prepress
adding custom prepress 149
adding prepress 145
adding prepress to booklets 147
pricing custom prepress 285
pricing prepress 282

Presses
adding more presses 56
designating as primary 314
press-based pricing 53
setting up for copies 333
setting up for digital 319
setting up for offset 314

setting up for RISO 322, 326
setting up for Xante 329
virtual presses 60

Pricing
adjusting estimate prices 178
matching your prices 265, 267
merchandise 301
out-of-the-box pricing 49
price levels 50
setting bookbinding prices 296
setting custom packaging prices 299
setting custom postpress prices 293
setting custom prepress prices 285
setting custom proofs prices 287
setting ink prices 280
setting packaging prices 298
setting paper prices 273, 370
setting postpress prices 289
setting prepress prices 282
setting product prices 269

Primary
presses 314

Primary Product 337

Printfire Store 421

Printing
job sheets 210
job tickets 210

quotes 166
Products

categories 335

pricing 269

primary 335

selecting as primary 337

updating copy products 345

updating digital products 342

updating offset products 338

updating wide format products 348
Proofs

pricing custom proofs 287

- Q -
QuickBooks
importing customers from 259
preparing QuickBooks 238
setting up for inwices 245
transferring inwices into 252
Quotes
available for estimates 191

433
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Quoting 394 setting tax districts 380
adding a keyword 157 updating taxes 386
adding custom postpress 156 Transferring
adding custom prepress 149 customers from QuickBooks 259
adding notes 157 invoices into QuickBooks 252
adding postpress 150 Translating
adding postpress to booklets 153 content 412
adding prepress 145 the program 409
adding prepress to booklets 147 Tutorials
changing a quote 159 making your first quote 35
charging for ink 142
converting to My Way 308 -U-

finding a quote 159
making your first quote 35
printing a quote 166
quoting booklets 120
guoting copies 90 -V -
quoting custom booklets 128
quoting custom copies 106
quoting custom digital 102
guoting custom offset 99
quoting custom paper 115
quoting custom wide format 111

Upgrading
to another version 12
User Accounts 32

Validating Data 79
Virtual Presses 60
Vista

installing for 12

quoting digital 83, 86 -W-
quoting it My Way 305 Where to Buy 421
quoting merchandise 96 Wide Format
quoting multiples x-up 137 creating Custom Options 235
guoting offset 82 In a Nutshell 229
quoting wide format 92 pricing 269
quoting work and turn 139 quoting custom wide format 111
quoting Xante 86 quoting wide format 92
setting ink colors 142 updating wide format products 348
viewing quotes 162 Windows 7
installing for 12
-R- Work and Turn 139
Repeating Workspaces 41
orders 195
RISO -X-
settingup 322, 326 Xante
quoting Xante 86
-S- settingup 329
Shipping 7
updating shipping methods 388 TeT
Sizes, how to enter 80 Zooming in 71
i
Taxes
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